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Preface

The InterRAID Hardware User’s Guide provides user and technical information about the
InterRAID-6, InterRAID-8, and InterRAID-12 disk array cabinet.  It provides instructions
for installing and expanding the disk array cabinets for use with Intergraph’s servers.  This
guide provides hardware and software installation procedures, specifications, and
troubleshooting information.

About This Document  
The InterRAID Hardware User’s Guide is organized as follows:

u Chapter 1, “Getting Started,” provides unpacking instructions for the InterRAID
cabinets.  It covers identifying the operating system disk drives, selecting a location, and
common disk array features.

u Chapter 2, “Setting Up and Expanding InterRAID-6,” describes setting up and
expanding the InterRAID-6 cabinet.

u Chapter 3, “Setting Up and Expanding InterRAID-8,” describes setting up and
expanding the InterRAID-8 single-channel and dual-channel cabinets.

u Chapter 4, “Setting Up and Expanding InterRAID-12,” describes setting up and
expanding the InterRAID-12 cabinet.

u Chapter 5, “Using DAC InterRAID Utilities,” describes how to install and use the Disk
Array Controller Administrator (DACADM) and the Disk Array Controller Monitor
(DACMON) utilities.  It describes using the RAID controller’s Basic Input Output
System (BIOS) and the Disk Array Controller Configuration (DACCF) utility to manage
the disk arrays.  It also covers DACCF error conditions and common procedures.

u Chapter 6, “Using MegaRAID BIOS,” describes using the MegaRAID BIOS
Configuration utility to manage the disk arrays.

u Chapter 7, “Using Power Console,” describes using the MegaRAID Power Console
graphics user interface to manage the disk arrays.

u Chapter 8, “Servicing the Disk Array,” provides information on servicing the disk array.
This chapter includes maintenance procedures for replacing parts of the system.

u Chapter 9, “Identifying the RAID Controller Board,” illustrates the three types of RAID
controllers used:  DAC960P, DAC960PD, and MegaRAID.  It provides jumper locations
and identifies internal and external ports.
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u Chapter 10, “Configuring the Disk Array for Performance,” discusses the various RAID
hard disk drive configurations and their effects on performance.

u Appendix A, “Specifications,” includes product specifications.

u Appendix B, “Troubleshooting,” includes troubleshooting guidelines for the disk arrays.

u Appendix C, “LED Status Codes and Resource Failures,” provides error conditions that
may occur during the Power-On Self Test (POST) diagnostic.  It includes solutions to
miscellaneous hardware and software problems.

Document Conventions
Bold Commands, words, or characters that you key in literally.

Italic Variable values that you supply, or cross-references.

Monospace Output displayed on the screen.

SMALL CAPS Key names on the keyboard, such as D, ALT or  F3; names of files and
directories.  You can type filenames and directory names in the dialog boxes
or the command line in lowercase unless directed otherwise.

CTRL+D Press a key while simultaneously pressing another key; for example, press
CTRL and D simultaneously.

ALT,SHIFT,F Press keys sequentially; for example, press ALT, then press SHIFT, then
press F.

Finding Operating System Information  
For more information on using the Windows NT operating system, refer to the printed and
online Windows NT documentation from Microsoft:

u For detailed information on the Windows NT operating system, refer to the online
Windows NT System Guide, delivered on CD-ROM with the operating system, and to
Windows NT Help.  You can purchase a printed copy of the System Guide from
Intergraph.

u For detailed information on installing and updating Windows NT, refer to the Windows
NT Installation Guide.
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Getting Documentation and Training  
You can purchase additional product documentation from Intergraph.

u In the United States, contact your sales account representative, call the Intergraph Order
Desk at 1-800-543-1054, or send a fax to 1-800-548-3318 to place an order.  If you call
or fax the Order Desk, have the document numbers ready for the items you wish to
purchase.

u Outside the United States, contact the Intergraph subsidiary or distributor from which
you purchased your Intergraph product to place an order.

To find information on training for Intergraph products, or to enroll for an available class,
contact Intergraph Training Solutions at 1-800-240-3000.

Getting Telephone Support  
If you experience problems with your Intergraph product, or have questions about the
information in this document, you can contact Intergraph for help.

u In the United States, call the Customer Response Center at 1-800-633-7248 between the
hours of  7:00 a.m. and  7:00 p.m. Central Time, Monday through Friday (except
holidays).

u Outside the United States, contact the Intergraph subsidiary or distributor from which
you purchased your Intergraph product.

Have the following information readily available when you call:

u The product’s serial number or your service/CPIN number.

u The product’s name or model number.

u Your name and telephone number.

u A brief description of the question or problem.
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Using the Intergraph Bulletin Board Service
Available 24 hours a day, 7 days a week, the Intergraph Bulletin Board Service (IBBS) is an
electronic forum for Intergraph customers to exchange information with Intergraph’s
technical and marketing staff, and with other Intergraph customers.  You can use the IBBS
to get technical support information, documentation and training information, programs, and
software updates and fixes.  The IBBS is also available for you to give suggestions, make
inquiries, and report problems.

To connect to the IBBS:

1. Set your system’s communications protocol for eight (8) data bits, no parity, one (1) stop
bit, and any baud rate up to 14,400.

2. Using a modem, dial the IBBS number, 1-205-730-8786.  You can dial 1-205-730-6504
if you are using a 2,400 baud connection.

 Mirror sites are maintained for locations outside the United States.  Information on these
sites is available on Intergraph Online, Intergraph’s World Wide Web server.

3. When connected, respond to the login request by keying in your user ID.  If you have not
connected before, key in new to create a user ID.

4. Follow the menus to find what you need.  If you are new to computer bulletin boards, the
IBBS provides clear choices and plenty of online help.  A text file that explains IBBS
commands and organization is available for you to download.

If you have trouble connecting to or using the IBBS, log a support request through the
Customer Response Center (product entry IBBS), send a fax to 1-205-730-1110, or leave a
message for the System Operator (Sysop) at 1-205-730-1413.

Using the Intergraph FAXLink
You can use the Intergraph FAXLink to get technical support information by fax 24 hours a
day, 7 days a week.  From a touch-tone phone or fax machine phone:

u Call 1-800-240-4300 to get new user instructions, an index listing of available
documents, and an overview of the categories of available information.

u Call 1-205-730-9000 to order the documents (up to 5 per call).

Follow the prompts provided to locate and deliver the information you need.
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Finding Intergraph on the Internet
You can find Intergraph on the Internet in the following ways:

u If you have a World Wide Web browser, connect to Intergraph Online, Intergraph’s
World WideWeb server, at http://www.intergraph.com.  From the home page, follow
the links to Customer Services for information on available customer services and
support options.

u If you have a File Transfer Protocol (FTP) program, connect to Intergraph at
ftp.intergraph.com.

u If you have a Gopher program, connect to Intergraph at gopher.intergraph.com.

u You can get information from Intergraph’s email server at info@intergraph.com.  Put
help in the body of the message (the subject line is ignored) to get information on such
subjects as Intergraph’s online services and where to get World Wide Web browsers.

u You can participate in the Intergraph Customer Forum (ICF), a bidirectional gateway to
the USENET newsgroup comp.sys.intergraph.  Anything posted to that group or sent to
comp-sys-intergraph@ingr.com is emailed to all subscribers.  Incoming email
messages are also posted to the newsgroup.  You can subscribe to the ICF via Intergraph
Online.



1

1 Getting Started   

The InterRAID-6, InterRAID-8, and InterRAID-12 disk array cabinets are easy to set up and
connect to an Intergraph desktop or deskside system.  This document assumes the system
base unit is already set up.

NOTE To unpack and connect the rack-mount InterRAID-8 cabinet, refer to the hardware
documentation for the rack-mounted system.

Unpacking the Equipment  
Carefully unpack the equipment.  The carton contains the following items:

u InterRAID cabinet

u Disk drive box with RAID disk drives

u Key

u Diskettes containing configuration and utility software

u Accessory pack

The accessory pack, included with the cabinet, contains the following items:

u InterRAID cabinet power cord

u RAID SCSI cable

u Four plastic feet

u Eight cap head hex screws

u Hex wrench

u Disk drive labels

u Drive Labeling instruction sheet

u Power Supply Cord Selection instruction sheet

u Feet Installation instruction sheet

u Antistatic Handling instruction sheet

u Rubber pads (InterRAID-8 and InterRAID-12)

u Blanking plate (InterRAID-8)
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Retain all packaging materials.  Equipment returned for repair must be in the original
packaging to obtain warranty service, if provided under your contract agreement.

NOTE If any of the listed parts are missing or damaged, call the Intergraph Customer Response
Center at 1-800-633-7248.

Identifying the Operating System Disk Drives  
The box containing the operating system disk drives is labeled, “This box contains disk
drives loaded with operating system software...”  Each operating system drive is labeled with
the SCSI ID number.  If additional cabinets are purchased, the RAID disk drives for these
cabinets will not contain the operating system software and will not be labeled.

CAUTION Do not remove the RAID disk drives from the antistatic bags until you are ready to install
them in the InterRAID cabinet.

Selecting a Location
The InterRAID cabinets can be placed side-by-side or stacked.  Keep the following in mind
when selecting a location.

u Allow six inches of space in front of the cabinet for the door to open.

u Allow at least a three-inch clearance in back of the cabinet for air circulation.

u Place the cabinet on a hard, flat surface (not on carpet).

u Ensure the surface will support the weight of the cabinets with all RAID disk drives
installed, as follows:

− InterRAID-6 weighs approximately 38 pounds.

− InterRAID-8, rack-mount, weighs approximately 84 pounds.

− InterRAID-8, tower, weighs approximately 75 pounds.

− InterRAID-12 weighs approximately 75 pounds.

Describing Common Disk Array Features
The following features are common to the InterRAID-6, InterRAID-8, and InterRAID-12
expansion solutions.
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RAID Controller Board  

The RAID controller board incorporates a 32-bit RISC processor to control all functions
including SCSI bus transfers, RAID processing, configuration, data striping, error recovery,
and drive building.

Smart Cabinet Monitoring   

The cabinet uses an intelligent interface (microprocessor) to alert the user in the event of an
abnormal system condition.  The microprocessor resides on the SCSI bus and communicates
the level of fault-tolerance to the user through software, LEDs, and audible alarms.  The
cabinet monitors its disk drives, power supplies, cooling fans and temperature and
continually reports to the LEDs and the Information Control Panel.

NOTE The InterRAID-6 cabinet does not have an Information Control Panel.

SAF-TE Cabinet Monitoring   

SCSI Accessed Fault-Tolerant Enclosure (SAF-TE) is a new method to alert the user of
abnormal system conditions.  SAF-TE, in addition to the Smart Cabinet monitoring
functions listed above, allows reporting to the system of the cooling fan revolutions per
minute, power supply voltages and temperature in degrees, number of insertions per slot, and
number of powerup hours.

Door Lock  

The front door uses an integrated door lock to prevent unauthorized access to the internal
components.  Two keys are provided with the cabinet.  To unlock the door, insert the key and
turn it counterclockwise.  To lock the door, turn the key clockwise.

NOTE After inserting the key into the lock, the key can only be removed when the door is locked.

Describing Applicable Intergraph Systems
The dual-channel InterRAID-8 is available as a deskside (tower) unit, and the rack-mount
version is available as dual-channel and single-channel, depending on the system to which it
is attached.
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The following tables list current InterRAID cabinets, systems, controllers, and applicable
software.

InterRAID-6 Intergraph System Controller/Software Cabinet Software

Single-channel
Tower

DTP Server (TD-40)
InterServe 21
InterServe 32

TD-30, TD-40

TDZ-600, TDZ-610

DAC960xx with
DACCF, DACADM,
and DACMON utilities

Smart Cabinet

InterRAID-8 Intergraph System Controller/Software Cabinet Software

Dual-channel
Tower

Dual-channel
Rack-mount

Single-channel
Rack-mount

Dual-channel
Tower

InterServe 610, 620,
630, 640

StudioZ RAX

InterServe 650, 660

InterServe 615, 625,
635, 645

DAC960xx with
DACCF, DACADM,
and DACMON utilities

MegaRAID with
MegaRAID BIOS setup
and Power Console
utilities

MegaRAID with
MegaRAID BIOS setup
and Power Console
utilities

MegaRAID with
MegaRAID BIOS setup
and Power Console
utilities

Smart Cabinet

SAF-TE Cabinet

SAF-TE Cabinet

SAF-TE Cabinet

InterRAID-12 Intergraph System Controller/Software Cabinet Software

Dual-channel,
    Tower

InterServe 62, 64, 66
InterServe 610, 620,
630, 640

DAC960xx with
DACCF, DACADM,
and DACMON utilities

Smart Cabinet

NOTE To determine which version of cabinet software is on your disk array cabinet(s), select the
following from the LCD Panel:  Menu => Hardware => Firmware revision.  A Smart cabinet
array will display a blank.  A SAF-TE cabinet array will report SAF-TE on the top line of the
display.
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Intergraph does not recommend striping a 2-pack or logical drive across Smart cabinets and
SAF-TE cabinets.  For more information on striping, refer to the appropriate chapter in this
guide for the installed controller and the applicable software utility.  DAC960xx with
DACCF, DACADM, and DACMON utilities are found in Chapter 5.  MegaRAID with
MegaRAID BIOS setup and Power Console utilities are found in Chapter 6 and Chapter 7,
respectively.

Identifying System PCI Slots  
The following figures indicate PCI slot numbers for Intergraph’s system base units.

Using the Controller Software
Your system shipped with either a DAC960xx or a MegaRAID controller and the associated
software.  Be sure to determine which controller board is installed and use the proper
software when configuring.  Chapter 5 contains the software instructions for the DAC960P
and DAC960PD controllers, and Chapters 6 and 7 contains the software instructions for the
MegaRAID controller.

TD-xx, TD-xxx

DTP Server, InterServe 21
InterServe 6xx, TD-xx, TD-xxx,
TDZ-xx, TDZ-xxx

TD-x10, TDZ-x10

Slot 1

Slot 3

Slot 1

Slot 3

Slot 1

Slot 6
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Determining the RAID Controller  
You can determine which RAID controller is installed in your system by viewing the BIOS
banner during the boot process.  Chapters 5 and 6 provide examples of the BIOS banner for
the appropriate RAID controller.  Refer to Chapter 5 for either a DAC960P or DAC960PD
controller, or Chapter 6 for a MegaRAID controller.

Connecting the Cabinet
Use the appropriate instructions in this guide when connecting the cabinet to the system base
unit.

u For InterRAID-6 cabinets, refer to Chapter 2, “Setting Up and Expanding
InterRAID-6.”

u For InterRAID-8 cabinets, refer to Chapter 3, “Setting Up and Expanding
InterRAID-8.”

u For InterRAID-12 cabinets, refer to Chapter 4, “Setting Up and Expanding
InterRAID-12.”
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2 Setting Up and Expanding
InterRAID-6

To set up the InterRAID-6 disk array with a system base unit, you will perform the following
tasks:

u Connect the InterRAID-6 cabinet to the system base unit.

u Expand the system (if installing additional disk arrays).

u Install the RAID disk drives.

u Power on and configure the system.

Connecting InterRAID-6 to the System
To connect the InterRAID-6 cabinet:

1. Connect the RAID SCSI cable to the RAID SCSI port on the RAID controller board
installed in the system base unit.

2. Connect the other end of the RAID SCSI cable to the RAID SCSI port on the
InterRAID-6 cabinet.

RAID
Controller
Board in
Base Unit

InterRAID-6
RAID SCSI
Port
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Connecting Remaining Cabinets and Cables
To connect the remaining cabinets and cables:

1. Choose the proper power cord for the cabinet.  Refer to the Power Supply Cord Selection
instruction sheet included in the accessory pack.

2. Connect the power cord to the InterRAID-6 cabinet.  Lift the power cord retainer, insert
the power cord, and lower the retainer into place over the power cord.

3. Connect the other end of the power cord to an Uninterruptible Power Supply (UPS), if
available, or to a grounded, three-prong AC power outlet.

CAUTION If the system does not connect to a UPS, data loss can occur if there is a power failure.

4. If you have additional cabinets, connect the RAID SCSI cables and power cords in the
same manner as instructed above.

5. For Intergraph deskside systems, use the following table as a guide to install any
secondary RAID controller boards.

Number of
RAID
Controllers Primary Secondary Secondary Secondary

One PCI Slot 3 - - -

Two PCI Slot 3 PCI Slot 2 - -

Three PCI Slot 3 PCI Slot 2 PCI Slot 1 -

Four PCI Slot 3 PCI Slot 2 PCI Slot 1 PCI Slot 6

− If PCI Slot 6 is not available, use PCI Slot 5.

− For DTP Server systems, the boot drive will be in the external disk array attached to
the primary RAID controller board.

− For Intergraph desktop and deskside systems with an internal hard disk drive, the
boot drive is the internal hard disk drive and does not require connection to a
primary RAID controller board.  Any external cabinets and associated RAID
controller boards are secondary.

Expanding the System
This section provides instructions to expand the following systems with additional
InterRAID-6 disk arrays:

u InterServe 21, 22, and 32
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u DTP Server

u TD-xx (desktop and deskside)

The following describes unpacking, setting up, and connecting the InterRAID-6 Expansion
Solution to your system.

Unpacking

Carefully unpack the InterRAID-6 Expansion Solution equipment, and verify that you have
the following items:

u InterRAID-6 cabinet

u Key for cabinet door

u RAID disk drives

u Diskettes containing configuration and utility software

u Documentation

u Antistatic wrist strap

u Accessory pack containing a power cord, RAID SCSI cables, four plastic feet, eight cap
head screws, one hex wrench, disk drive labels, rubber pads, a blanking plate, a Drive
Labeling sheet, a Feet Installation sheet, a Power Supply Cord Selection sheet, and an
Antistatic Handling sheet

The Expansion Solution equipment may also include a RAID controller board.

CAUTION Do not remove the RAID disk drives from the antistatic bags until you are ready to install the
drives in the cabinet.  Do not handle the RAID disk drives unless you connect an antistatic
wrist strap to your wrist and to a bare metal surface on the cabinet.

Retain all packaging materials.  You must return the system in the original packaging to
obtain warranty service.  Refer to the instructions in the back of this guide for returning
equipment to Intergraph.

Setting Up Host

The following provides instructions for setting up the host system for use with an
InterRAID-6 Expansion Solution RAID controller board.
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To set up the host for use with InterRAID-6:

1. If your Expansion Solution came with a RAID controller board, install it into the
appropriate PCI slot in the system’s base unit.  Refer to Chapter 1, “Getting Started,” for
PCI slot designations.  Refer to your system’s documentation for instructions on opening
the base unit, taking precautions against electrostatic discharge, and installing option
boards.

− On InterServe 21, DTP Server, and TD-xx deskside systems, the primary RAID
controller is installed in PCI slot 3.  Install additional (secondary) controllers in PCI
slots 2, 1, and 6 (in that order).  If PCI slot 6 is not available, use PCI slot 5.

− On TD-xx desktop systems, the primary RAID controller may be installed in PCI
slot 1 or PCI slot 2, whichever is available.  Install a secondary controller in the
other slot.

− On InterServe 22 and 32 systems, the primary RAID controller is installed in PCI
slot 2.  Install additional (secondary) controllers in PCI slots 3, 4, and 5.

− On DTP Server systems, the boot disk drives are in the InterRAID disk array
connected to the primary RAID controller.

− For Intergraph desktop and deskside systems with an internal hard disk drive, the
internal hard disk drive is the boot disk drive and does not require connection to a
primary RAID controller.  Any external disk arrays and associated RAID
controllers are secondary.

2. Route and connect the RAID SCSI cables and power cables to the back of each cabinet.

Installing the RAID Disk Drives  
The InterRAID-6 cabinet contains up to six 1.0-inch high, 3.5-inch form factor RAID disk
drives.  Supported capacities include 1 GB, 2 GB, 4 GB, and higher as the disk drives
become available.  Contact an Intergraph sales representative for drive availability.  The left-
hand side of the disk drive label identifies the disk drive size.

NOTE Intergraph attaches a SCSI ID number to the disk drive label to identify each of the boot disk
drives.  All other disk drives are for data storage and do not specify a SCSI ID number.

CAUTION Ensure you install the boot disk drives into the InterRAID-6 cabinet that connects to the
primary RAID controller board.

To install the RAID disk drives:

1. Unlock the front panel door using the key for the InterRAID-6 cabinet.
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2. Remove the RAID disk drives from the carton labeled, “This box contains disk drives
loaded with operating system software....”  For TD-xx desktop and deskside systems, the
first three drives (ID 0, 1, 2) contain the operating system.  For the DTP Server systems,
all six disk drives contain the operating system.

The following table shows the order in which to install the boot disk drives:

Disk Drive Label InterRAID-6 Slots

ADP    CHN    ID 6 Slot 6 (Top)

ADP    CHN    ID 5 Slot 5

ADP    CHN    ID 4 Slot 4

ADP    CHN    ID 2 Slot 3

ADP    CHN    ID 1 Slot 2

ADP    CHN    ID 0 Slot 1 (Bottom)

3. Install the boot disk drives in the primary InterRAID-6 cabinet.  To insert a drive,
extend the drive latching clips and slide the drive into the slot.  Push between the
latching clips until the drive connects.  Close the drive latching clips until they snap into
place, locking the drive into the slot.  Refer to the following figure.

CAUTION Carefully insert the disk drives to avoid damaging the Single Connector Attachment (SCA)
connector.

4. Install the remaining RAID disk drives without labels into the primary cabinet.  You can
install them in any order as long as the slots are filled sequentially upward (for example,
do not install drives in slots 4 and 6, leaving slot 5 empty).

Power Switch

Slot 1

Drive
Latching
Clips
(Open)
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5. If necessary, fill in the label information for each RAID disk drive.  Refer to the Drive
Labeling instruction sheet.  The disk drive label has blank spaces for you to apply the
appropriate numbers to indicate the RAID controller board number (ADP X), channel
number (CHN Y), and SCSI ID number (ID Z).  In the following table, Intergraph
reserves SCSI ID 3 for the entire disk array.  All six RAID disk drives connect to a
single channel.

Use the following table to label the drives:

Disk Drive Label InterRAID-6 Slots

ADP X  CHN 0  ID 6 Slot 6 (Top)

ADP X  CHN 0  ID 5 Slot 5

ADP X  CHN 0  ID 4 Slot 4

ADP X  CHN 0  ID 2 Slot 3

ADP X  CHN 0  ID 1 Slot 2

ADP X  CHN 0  ID 0 Slot 1 (Bottom)

6. If you have additional cabinets, install the RAID disk drives and complete the drive
label information as appropriate.

Powering On and Configuring the System  
To prevent accidental power off or on, the power switch is recessed and not accessible with
the door closed and locked.  Before starting the system for the first time, read the following
important operating and software notices.

Important Operating Notices  

u Always power on the InterRAID-6 cabinet and wait for the audible beep before powering
on the system base unit.

u If you are installing RAID disk drives that are partially loaded with the Windows NT
Server operating system, you must complete installation of the operating system before
configuring your RAID disk array.  If you do not complete installation, or if you turn off
the power to the system base unit before completing the Windows NT Server setup
procedures, you must reload the operating system.  Once you power on the system base
unit, do not power off the system without completing Windows NT Server installation.
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u Always power off the system base unit before powering off the InterRAID-6 cabinet.  If
you power off the cabinet first, the RAID controller board will read the drives as dead
the next time you power on the system.  Refer to Chapter 5 “Using DAC InterRAID
Utilities,” or Chapter 6 “Using MegaRAID BIOS” and Chapter 7, “Using Power
Console.”

Important Software Notices  

u For DTP Server systems, Intergraph installs the Microsoft Windows NT Server
operating system software and prepares it for final configuration by users.

u For desktop and deskside systems other than the DTP Server, the disk drives are
delivered with Microsoft Windows NT Server operating system software partially
installed.  You must complete Windows NT Server installation before using the system.

u The RAID controller board has two types of write caching:  write-back and write-
through.  Write-through caching reduces the risk of data loss in the event of a power
failure.  Write-back caching improves performance, but the drawback is potential data
loss if power fails.  Intergraph recommends connection to a UPS to guard against data
loss.

u Intergraph configures the RAID controller board to RAID level 5.  RAID controllers
support RAID levels 0, 1, 5, 6 (0+1), and 7.  The MegaRAID controller, in addition to
the other levels, also supports RAID level 3.

To power on and configure the system:

1. Power on the InterRAID-6 cabinet and wait for the audible beep.

2. Power on the system base unit and the monitor.

3. Complete the Windows NT Server installation.  Refer to the system’s setup or
configuration documentation.

4. Install the proper software utilities available for the RAID controller board installed in
the system.

 For DAC960P and DAC960PD boards, install the DACADM and DACMON utilities.
Refer to Chapter 5, “Using DAC InterRAID Utilities.”

For MegaRAID boards, install the MegaRAID BIOS and Power Console utilities.  Refer
to Chapter 6, “Using MegaRAID BIOS” and Chapter 7, “Using Power Console.”

WARNING After you configure the RAID disk drives, it is very important that you backup the
configuration to a diskette.  It will be very helpful for future use in the event the
configuration should become lost.  Refer to Chapter 5 “Using DAC InterRAID Utilities,”
or Chapter 6 “Using MegaRAID BIOS” and Chapter 7, “Using Power Console.”
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5. If necessary, configure the RAID controller board to your preferences.  Refer to Chapter
5 “Using DAC InterRAID Utilities,” or Chapter 6 “Using MegaRAID BIOS” and
Chapter 7, “Using Power Console.”

6. Use Disk Administrator in Windows NT to partition and format the disk space not used
by the operating system.  When prompted to create a Signature File, select Yes.  Refer to
the Windows NT Server System Guide for information on using Disk Administrator.
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3 Setting Up and Expanding
InterRAID-8

To set up the InterRAID-8 disk array with a system base unit, you will perform the following
tasks:

u Connect the InterRAID-8 cabinet to the system base unit.

u Expand the system (if installing additional disk arrays).

u Install the RAID disk drives.

u Power on and configure the system.

Connecting InterRAID-8 to the System
When setting up the InterRAID-8 cabinet in a vertical position, install the plastic feet on the
cabinet according to the Feet Installation instruction sheet.  If setting up the cabinet
horizontally, install the rubber pads on the cabinet in the recessed area of each corner.

NOTE To connect the rack-mount InterRAID-8 cabinet, refer to the system’s hardware
documentation for the rack-mounted system.

InterRAID-8 is available in two configurations, single-channel and dual-channel.  The
single-channel cabinet has eight devices on one SCSI channel, and the dual-channel cabinet
has four devices on each of two SCSI channels.  To determine whether you have a single-
channel or a dual-channel cabinet, look at the back of the cabinet.  The single-channel
InterRAID-8 cabinet has only one SCSI port; the dual-channel cabinet has two SCSI ports.

Single-Channel

To connect the single-channel InterRAID-8 cabinet:

1. Connect one end of the RAID SCSI cable to the SCSI port on the InterRAID-8 cabinet.
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2. Connect the other end of the RAID SCSI cable to the channel 0 port on the RAID
controller board in the system base unit.

Dual-Channel

To connect the dual-channel InterRAID-8 cabinet:

1. Connect a RAID SCSI cable to the channel 0 port on the RAID controller in the base
unit, and to the channel 0 port on the InterRAID-8 cabinet.

2. Connect a RAID SCSI cable to the channel 1 port on the RAID controller board in the
base unit, and to the channel 1 port on the InterRAID-8 cabinet.

RAID
Controller
Board in Base
Unit

RAID
Controller
Board in Base
Unit

Channel 0

Channel 0

Channel 1
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Connecting Remaining Cabinets and Cables

To connect the remaining cabinets and cables:

1. Choose the proper power cord for the cabinet.  Refer to the Power Supply Cord Selection
instruction sheet included in the accessory pack.

2. Connect the power cord to the InterRAID-8 cabinet.

3. Connect the other end of the power cord to an Uninterruptible Power Supply (UPS), if
available, or to a grounded, three-prong AC power outlet.

CAUTION If the system does not connect to a UPS, data loss can occur if there is a power failure.

4. If you have additional cabinets, connect the RAID SCSI cables and power cords in the
same manner as instructed above.

5. Use the following table as a guide to install any secondary RAID controller boards.

Number of
RAID
Controllers Primary Secondary Secondary Secondary

One PCI Slot 3 - - -

Two PCI Slot 3 PCI Slot 2 - -

Three PCI Slot 3 PCI Slot 2 PCI Slot 1 -

Four PCI Slot 3 PCI Slot 2 PCI Slot 1 PCI Slot 6

− If PCI Slot 6 is not available, use PCI Slot 5.

− For Intergraph deskside systems with internal RAID, the internal RAID subsystem
already contains the boot drives.  The primary RAID controller board connects to
the internal RAID subsystem.

− For Intergraph deskside systems with an internal hard disk drive, the boot drive is
the internal hard disk drive and does not require connection to a primary RAID
controller board.  Any external cabinets and associated RAID controller boards are
secondary.
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For InterServe 650, 660 systems, use the following table as a guide to install any
secondary RAID controller boards.

Number of
RAID
Controllers Primary Secondary Secondary Secondary

One PCI Slot 7 - - -

Two PCI Slot 7 PCI Slot 6 - -

Three PCI Slot 7 PCI Slot 6 PCI Slot 5 -

Four PCI Slot 7 PCI Slot 6 PCI Slot 5 PCI Slot 4

Expanding the System
This section provides instructions to expand your InterServe 6xx system with additional
InterRAID-8 disk arrays.  The following describes unpacking, placing cabinets, installing
internal expansion cables, and installing multiple expansions.

Unpacking

Carefully unpack the InterRAID-8 Expansion Solution equipment, and verify that you have
the following items:

u InterRAID-8 cabinet

u Key for cabinet door

u RAID disk drives

u Diskettes containing configuration and utility software

u Documentation

u Antistatic wrist strap

u Accessory pack containing a power cord, RAID SCSI cables, four plastic feet, eight cap
head screws, one hex wrench, disk drive labels, rubber pads, a blanking plate, a Drive
Labeling sheet, a Feet Installation sheet, a Power Supply Cord Selection sheet, and an
Antistatic Handling sheet

The Expansion Solution equipment may also include the following items:

u RAID controller board

u Internal expansion cable

u RAID SCSI cable
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CAUTION Do not remove the RAID disk drives from the antistatic bags until you are ready to install the
drives in the cabinet.  Do not handle the RAID disk drives unless you connect an antistatic
wrist strap to your wrist and to a bare metal surface on the cabinet.

Retain all packaging materials.  You must return the system in the original packaging to
obtain warranty service.  Refer to the instructions in the back of this guide for returning
equipment to Intergraph.

Placing Cabinets

To place the cabinets side-by-side:

1. Place the feet on the bottom of the cabinet as described in the Feet Installation sheet.

2. Set the cabinet a few inches away from the existing cabinets.

To stack the cabinets:

1. If existing InterRAID cabinets are not already stacked, remove the RAID disk drives
from them and place the drives on an antistatic surface.

CAUTION Keep track of the drive locations.  You must install the drives in the same cabinets and slots
from which you remove them.

2. To rotate the Information Control Panel on the cabinet door, open the cabinet door and
remove the folded section of ribbon cable from the slit in the Mylar on the back of the
door.

3. Using a 5/16-inch nutdriver, remove the hex nuts from the corners of the Information
Control Panel.

4. Rotate the Information Control Panel one-quarter turn counterclockwise and re-attach it
to the door with the hex nuts.  Do not overtighten the nuts.

5. Close the cabinet door.

6. Place the rubber pads from the accessory pack into the recessed locations on the left side
(as viewed from the front) of the cabinet.

7. Place the bottom cabinet on its rubber pads on a flat, hard surface (not on carpet).

8. For each additional InterRAID cabinet you want to stack, repeat steps 2 through 6 and
place the additional cabinet on top of the previous cabinet.

CAUTION You may stack up to four InterRAID cabinets in a single stack.

9. If you removed RAID disk drives from existing InterRAID cabinets, replace them.
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Setting Up Host

The following provides instructions for installing the internal expansion cable in the host to
use Channel 2 of the secondary RAID controller board.

To set up host for use with InterRAID-8:

1. Connect the internal expansion cable to the Channel 2 connector of the secondary RAID
controller board as shown in the following figure (here, the secondary RAID controller
is installed in PCI slot 2).

2. Route the internal expansion cable over the option board bracket as shown in the
following figure.

3. Using a quarter-inch nutdriver, remove the screw securing the ISA I/O lock bracket as
shown in the following figure.  Remove the lock bracket.

Internal Expansion Cable

Option Board
Bracket

Channel 2

PCI Slot 2
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4. Remove the blanking plate from an available ISA I/O slot.

5. Install the RAID connector bracket of the internal expansion cable into the ISA I/O slot.

6. Replace the ISA I/O lock bracket.

7. For each additional internal expansion you want to add, refer to Chapter 1, “Getting
Started,” for PCI slot designations for your system.  Install another RAID controller
board into the appropriate PCI slot, and repeat steps 1 through 6 to install another
internal expansion cable.

8. Close the system’s base unit as described in your system’s documentation.

9. Connect the disk array to the system as described in “Connecting InterRAID-8 to the
System.”

Installing Multiple Expansions

Once you understand how to expand a configuration by installing an additional RAID
controller board and an internal expansion cable, refer to the following figure to continue
expanding.  The figure depicts two expansions supporting a total of nine single-channel,
deskside, disk arrays (including the internal RAID subsystem).

Internal Expansion Cable

ISA I/O
Slot Panel

Screw

ISA I/O Lock
Bracket

RAID Connector
Bracket
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Adding a third expansion is not shown, but is discussed later.

Notes

1. Installing the “A” expansion with a secondary RAID controller board in PCI slot 2
supports three new disk arrays.  Two arrays connect to the RAID controller and one
array connects to the RAID connector in the ISA I/O slot.

2. Installing the “B” expansion with a secondary RAID controller board in PCI slot 1
supports three new disk arrays.  Two arrays connect to the RAID controller and one
array connects to the RAID connector in the ISA I/O slot.

Adding a third expansion to this InterRAID-8 configuration provides a maximum of four
RAID controller boards supporting twelve disk arrays (including the internal RAID
subsystem).  The fourth RAID controller board will reside in either PCI slot 6 or 5,
depending on which slot is available.  The third expansion will also use an available ISA I/O
slot and the RAID SCSI cable.

Channels 0, 1, and 2 on the primary RAID
controller board in PCI slot 3 supports two
external disk arrays and one internal RAID
subsystem.

  B            B

  A

  A

  A            B

Available
ISA I/O
slot

Channel 0

Channel 1

Channel 2

Internal RAID
Subsystem and
Cabling

“B” Expansion
(See Note 2.)

“A” Expansion
(See Note 1.)
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Installing the RAID Disk Drives  
The InterRAID-8 cabinet contains up to eight 1.0-inch or 1.6-inch high, 3.5-inch form factor
RAID disk drives.  Supported capacities include 2 GB, 4 GB, 9 GB, and higher as the disk
drives become available.  Contact an Intergraph sales representative for drive availability.
The left-hand side of the disk drive label identifies the disk drive size.

NOTE Intergraph attaches a SCSI ID number to the disk drive label to identify each of the boot disk
drives.  All other disk drives are for data storage and do not specify a SCSI ID number.

CAUTION Ensure you install the boot disk drives into the InterRAID-8 cabinet that connects to the
primary RAID controller board.

To install the RAID disk drives:

1. Unlock the front panel door using the key for the InterRAID-8 cabinet.

2. Remove the RAID disk drives from the carton labeled, “This box contains disk drives
loaded with operating system software ...”  The first three drives (ID 0, 1, 2) contain the
operating system.

The following table shows the order in which to install the boot disk drives:

Disk Drive Label InterRAID-8 Slots

ADP    CHN    ID 2 Slot 3

ADP    CHN    ID 1 Slot 2

ADP    CHN    ID 0 Slot 1 (bottom, if deskside; right-hand, if rack)

3. Install the boot disk drives in the primary InterRAID-8 cabinet.  To insert a drive,
extend the drive latching clips and slide the drive into the slot.  Push between the
latching clips until the drive connects.  Close the drive latching clips until they snap into
place, locking the drive into the slot.  Refer to the following figure.

CAUTION Carefully insert the disk drives to avoid damaging the Single Connector Attachment (SCA)
connector.
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4. Install the remaining RAID disk drives without labels into the primary cabinet.  You can
install them in any order as long as the slots are filled sequentially upward (for example,
do not install drives in slots 5 and 7, leaving slot 6 empty).

5. If necessary, fill in the label information for each RAID disk drive.  Refer to the Drive
Labeling instruction sheet.  The disk drive label has blank spaces for you to apply the
appropriate numbers to indicate the RAID controller board number (ADP X), channel
number (CHN Y), and SCSI ID number (ID Z).  In the tables below, Intergraph reserves
SCSI ID 3 for the entire disk array and SCSI ID 7 for the RAID controller board.  In a
single-channel InterRAID-8 cabinet, all eight RAID disk drives connect to a single
channel.

Use the following table to label the drives:

Disk Drive Label InterRAID-8 Slots

ADP X  CHN 0  ID 9 Slot 8 (top, if deskside; left-hand, if rack-mount)

ADP X  CHN 0  ID 8 Slot 7

ADP X  CHN 0  ID 6 Slot 6

ADP X  CHN 0  ID 5 Slot 5

ADP X  CHN 0  ID 4 Slot 4

ADP X  CHN 0  ID 2 Slot 3

ADP X  CHN 0  ID 1 Slot 2

ADP X  CHN 0  ID 0 Slot 1 (bottom, if deskside; right-hand, if rack-mount)

Drive Latching Clip (Open)

Power Switch

Slot 1
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In a dual-channel InterRAID-8 cabinet, the lower four RAID disk drives connect to
channel 0; the upper four RAID disk drives connect to channel 1.

Use the following table to label the drives:

Disk Drive Label InterRAID-8 Slots

ADP X  CHN 1  ID 4 Slot 8 (top, if deskside; left-hand, if rack-mount)

ADP X  CHN 1  ID 2 Slot 7

ADP X  CHN 1  ID 1 Slot 6

ADP X  CHN 1  ID 0 Slot 5

ADP X  CHN 0  ID 4 Slot 4

ADP X  CHN 0  ID 2 Slot 3

ADP X  CHN 0  ID 1 Slot 2

ADP X  CHN 0  ID 0 Slot 1 (bottom, if deskside; right-hand, if rack-mount)

6. If you have additional cabinets, install the disk drives and complete the drive label
information as appropriate.

Powering On and Configuring the System  
To prevent accidental power off or on, the power switch is recessed and not accessible with
the door closed and locked.  Before starting the system for the first time, read the following
important operating and software notices.

Important Operating Notices  

u Always power on the InterRAID-8 cabinet and wait for the audible beep before powering
on the system base unit.

u If you turn off the power to the system base unit before completing the setup procedures,
you must reload the operating system.  Once you power on the system base unit, do not
power off the system without completing Windows NT Server installation.

u Always power off the system base unit before powering off the InterRAID-8 cabinet.  If
you power off the cabinet first, the RAID controller board will read the drives as dead
the next time you power on the system.  Refer to Chapter 5 “Using DAC InterRAID
Utilities,” or Chapter 6 “Using MegaRAID BIOS” and Chapter 7, “Using Power
Console.”

Important Software Notices  

u You must complete the Windows NT Server installation before using the system.
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u The RAID controller board has two types of write caching:  write-back and write-
through.  Write-through caching reduces the risk of data loss in the event of a power
failure.  Write-back caching improves performance, but the drawback is potential data
loss if power fails.  Intergraph recommends connection to a UPS to guard against data
loss.

u Intergraph configures the RAID controller board to RAID level 5.  RAID controllers
support RAID levels 0, 1, 5, 6 (0+1), and 7.  The MegaRAID controller, in addition to
the other levels, also supports RAID level 3.

To power on and configure the system:

1. Power on the InterRAID-8 cabinet and wait for the audible beep.

2. Power on the system base unit and the monitor.

3. Complete the Windows NT Server installation.  Refer to the system’s setup or
configuration documentation.

4. Install the proper software utilities available for the RAID controller board installed in
the system.

 For DAC960P and DAC960PD boards, install the DACADM and DACMON utilities.
Refer to Chapter 5, “Using DAC InterRAID Utilities.”

For MegaRAID boards, install the MegaRAID BIOS and Power Console utilities.  Refer
to Chapter 6, “Using MegaRAID BIOS” and Chapter 7, “Using Power Console.”

WARNING After you configure the RAID disk drives, it is very important that you backup the
configuration to a diskette.  It will be very helpful for future use in the event the
configuration should become lost.  Refer to Chapter 5 “Using DAC InterRAID Utilities,”
or Chapter 6 “Using MegaRAID BIOS” and Chapter 7, “Using Power Console.”

5. If necessary, configure the RAID controller board to your preferences.  Refer to Chapter
5 “Using DAC InterRAID Utilities,” or Chapter 6 “Using MegaRAID BIOS” and
Chapter 7, “Using Power Console.”

6. Use Disk Administrator in Windows NT to partition and format the disk space not used
by the operating system.  When prompted to create a Signature File, select Yes.  Refer to
the Windows NT Server System Guide for information on using Disk Administrator.
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4 Setting Up and Expanding 
InterRAID-12

To set up the InterRAID-12 disk array with a system base unit, you will perform the
following tasks:

u Connect the InterRAID-12 cabinet to the system base unit.

u Expand the system (if installing additional disk arrays).

u Install the RAID disk drives.

u Power on and configure the system.

Connecting InterRAID-12 to the System
When setting up the InterRAID-12 cabinet in a vertical position, first install the plastic feet
on the cabinet according to the Feet Installation instruction sheet.  If setting up the cabinet
horizontally, install the rubber pads on the cabinet in the recessed area of each corner.

To connect the InterRAID-12 cabinet:

1. Connect a RAID SCSI cable to the channel 0 port on the RAID controller in the base
unit, and to the channel 0 port on the InterRAID-12 cabinet.

Channel 1

RAID
Controller
Board in Base
Unit

Channel 0
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2. Connect a RAID SCSI cable to the channel 1 port on the RAID controller board in the
base unit, and to the channel 1 port on the InterRAID-12 cabinet.

Connecting Remaining Cabinets and Cables
To connect the remaining cabinets and cables:

1. Choose the proper power cord for the cabinet.  Refer to the Power Supply Cord Selection
instruction sheet included in the accessory pack.

2. Connect the power cord to the InterRAID-12 cabinet.

3. Connect the other end of the power cord to an Uninterruptible Power Supply (UPS), if
available, or to a grounded, three-prong AC power outlet.

CAUTION If the system does not connect to a UPS, data loss can occur if there is a power failure.

4. If you have additional cabinets, connect the RAID SCSI cables and power cords in the
same manner as instructed above.

5. Use the following table as a guide to install any secondary RAID controller boards.

Number of
RAID
Controllers Primary Secondary Secondary Secondary

One PCI Slot 3 - - -

Two PCI Slot 3 PCI Slot 2 - -

Three PCI Slot 3 PCI Slot 2 PCI Slot 1 -

Four PCI Slot 3 PCI Slot 2 PCI Slot 1 PCI Slot 6

− If PCI Slot 6 is not available, use PCI Slot 5.

− For Intergraph deskside systems with internal RAID, the internal RAID subsystem
already contains the boot drives.  The primary RAID controller board connects to
the internal RAID subsystem.

− For Intergraph deskside systems with an internal hard disk drive, the boot drive is
the internal hard disk drive and does not require connection to a primary RAID
controller board.  Any external cabinets and associated RAID controller boards are
secondary.



29

Expanding the System
This section provides instructions to expand your InterServe 6x system or InterServe 6xx
system with additional InterRAID-12 disk arrays.  The following describes unpacking,
placing cabinets, setting up, and connecting the InterRAID-12 Expansion Solution to your
system.

Unpacking

Carefully unpack the InterRAID-12 Expansion Solution equipment, and verify that you have
the following items:

u InterRAID-12 cabinet

u Key for cabinet door

u RAID disk drives

u Diskettes containing configuration and utility software

u Documentation

u Antistatic wrist strap

u Accessory pack containing a power cord, RAID SCSI cables, four plastic feet, eight cap
head screws, one hex wrench, disk drive labels, rubber pads, a blanking plate, a Drive
Labeling sheet, a Feet Installation sheet, a Power Supply Cord Selection sheet, and an
Antistatic Handling sheet

The Expansion Solution equipment may also include a RAID controller board.

CAUTION Do not remove the RAID disk drives from the antistatic bags until you are ready to install the
drives in the cabinet.  Do not handle the RAID disk drives unless you connect an antistatic
wrist strap to your wrist and to a bare metal surface on the cabinet.

Retain all packaging materials.  You must return the system in the original packaging to
obtain warranty service.  Refer to the instructions in the back of this guide for returning
equipment to Intergraph.

Placing Cabinets

To place the cabinets side-by-side:

1. Place the feet on the bottom of the cabinet as described in the Feet Installation sheet.

2. Set the cabinet a few inches away from the existing cabinets.
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To stack the cabinets:

1. If existing InterRAID cabinets are not already stacked, remove the RAID disk drives
from them and place the drives on an antistatic surface.

CAUTION Keep track of the drive locations.  You must install the drives in the same cabinets and slots
from which you remove them.

2. To rotate the Information Control Panel on the cabinet door, open the cabinet door and
remove the folded section of ribbon cable from the slit in the Mylar on the back of the
door.

3. Using a 5/16-inch nutdriver, remove the hex nuts from the corners of the Information
Control Panel.

4. Rotate the Information Control Panel one-quarter turn counterclockwise and re-attach it
to the door with the hex nuts.  Do not overtighten the nuts.

5. Close the cabinet door.

6. Place the rubber pads from the accessory pack into the recessed locations on the left side
(as viewed from the front) of the cabinet.

7. Place the bottom cabinet on its rubber pads on a flat, hard surface (not on carpet).

8. For each additional InterRAID cabinet you want to stack, repeat steps 2 through 6 and
place the additional cabinet on top of the previous cabinet.

CAUTION You may stack up to four InterRAID cabinets in a single stack.

9. If you removed RAID disk drives from existing InterRAID cabinets, replace them.

Setting Up Host

The following provides instructions for setting up the host system for use with an
InterRAID-12 Expansion Solution RAID controller board.

To setup the host for use with InterRAID-12:

1. If your Expansion Solution came with a RAID controller board, install it into the
appropriate PCI slot in the system’s base unit.  Refer to Chapter 1, “Getting Started,” for
PCI slot designations.  Refer to your system’s documentation for instructions on opening
the base unit, taking precautions against electrostatic discharge, and installing option
boards.

− On InterServe 6x systems, the primary RAID controller is installed in PCI slot 3.
Install additional (secondary) controllers in PCI slots 4, 5, and 6.
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− On InterServe 6xx systems, the primary RAID controller is installed in PCI slot 3.
Install additional (secondary) controllers in PCI slots 2, 1, and 6 (in that order).  If
PCI slot 6 is not available, use PCI slot 5.

− For Intergraph deskside systems with internal RAID, the internal RAID subsystem
already contains the boot disk drives.  The primary RAID controller connects to the
internal RAID subsystem.

− For Intergraph deskside systems with an internal hard disk drive, the internal hard
disk drive is the boot disk drive and does not require connection to a primary RAID
controller.  Any external disk arrays and associated RAID controllers are secondary.

2. For stacked cabinets, route the RAID SCSI cables and power cables through the cable
guides on the back of each cabinet.

Installing the RAID Disk Drives   
The InterRAID-12 cabinet contains up to twelve 1.0-inch high, 3.5-inch form factor RAID
disk drives.  Supported capacities include 1 GB, 2 GB, 4 GB, and higher as the disk drives
become available.  Contact an Intergraph sales representative for drive availability.  The left-
hand side of the disk drive label identifies the disk drive size.

NOTE Intergraph attaches a SCSI ID number to the disk drive label to identify each of the boot disk
drives.  All other disk drives are for data storage and do not specify a SCSI ID number.

CAUTION Ensure you install the boot disk drives into the InterRAID-12 cabinet that connects to the
primary RAID controller board.

To install the RAID disk drives:

1. Unlock the front panel door using the key for the InterRAID-12 cabinet.

2. Remove the RAID disk drives from the carton labeled, “This box contains disk drives
loaded with operating system software ...”  The first three drives (ID 0, 1, 2) contain the
operating system.

The following table shows the order in which to install the boot disk drives:

Disk Drive Label InterRAID-12 Slots

ADP    CHN    ID 2 Slot 3

ADP    CHN    ID 1 Slot 2

ADP    CHN    ID 0 Slot 1 (Bottom)
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3. Install the boot disk drives in the primary InterRAID-12 cabinet.  To insert a drive,
extend the drive latching clips and slide the drive into the slot.  Push between the
latching clips until the drive connects.  Close the drive latching clips until they snap into
place, locking the drive into the slot.  Refer to the following figure.

CAUTION Carefully insert the disk drives to avoid damaging the Single Connector Attachment (SCA)
connector.

4. Install the remaining RAID disk drives without labels into the primary cabinet.  You can
install them in any order as long as the slots are filled sequentially upward (for example,
do not install drives in slots 5 and 7, leaving slot 6 empty).

 If necessary, fill in the label information for each RAID disk drive.  Refer to the Drive
Labeling instruction sheet.  The disk drive label has blank spaces for you to apply the
appropriate numbers to indicate the RAID controller board number (ADP X), channel
number (CHN Y), and SCSI ID number (ID Z).  In the table below, Intergraph reserves
SCSI ID 3 for the entire disk array.  The lower six RAID disk drives connect to channel
0, and the upper six RAID disk drives connect to channel 1.

Power Switch

Drive Latching
Clip (Open)

Slot 12

Slot 1
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Use the following table to label the drives:

Disk Drive Label InterRAID-12 Slots

ADP X  CHN 1  ID 6 Slot 12 (Top)

ADP X  CHN 1  ID 5 Slot 11

ADP X  CHN 1  ID 4 Slot 10

ADP X  CHN 1  ID 2 Slot 9

ADP X  CHN 1  ID 1 Slot 8

ADP X  CHN 1  ID 0 Slot 7

ADP X  CHN 0  ID 6 Slot 6

ADP X  CHN 0  ID 5 Slot 5

ADP X  CHN 0  ID 4 Slot 4

ADP X  CHN 0  ID 2 Slot 3

ADP X  CHN 0  ID 1 Slot 2

ADP X  CHN 0  ID 0 Slot 1 (Bottom)

6. If you have additional cabinets, install the RAID disk drives and complete the drive
label information as appropriate.

Powering On and Configuring the System  
To prevent accidental power off or on, the power switch is recessed and not accessible with
the door closed and locked.  Before starting the system for the first time, read the following
important operating and software notices.

Important Operating Notices  

u Always power on the InterRAID-12 cabinet and wait for the audible beep before
powering on the system base unit.

u If you turn off the power to the system base unit before completing the setup procedures,
you must reload the operating system.  Once you power on the system base unit, do not
power off the system without completing Windows NT Server installation.

u Always power off the system base unit before powering off the InterRAID-12 cabinet.  If
you power off the cabinet first, the RAID controller board will read the drives as dead
the next time you power on the system.  Refer to Chapter 5 “Using DAC InterRAID
Utilities,” or Chapter 6 “Using MegaRAID BIOS” and Chapter 7, “Using Power
Console.”
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Important Software Notices  

u You must complete the Windows NT Server installation before using the system.

u The RAID controller board has two types of write caching:  write-back and write-
through.  Write-through caching reduces the risk of data loss in the event of a power
failure.  Write-back caching improves performance, but the drawback is potential data
loss if power is interrupted.  Intergraph recommends connection to a UPS to guard
against data loss.

u Intergraph configures the RAID controller board to RAID level 5.  RAID controllers
support RAID levels 0, 1, 5, 6 (0+1), and 7.  The MegaRAID controller, in addition to
the other levels, also supports RAID level 3.

To power on and configure the system:

1. Power on the InterRAID-12 cabinet and wait for the audible beep.

2. Power on the system base unit and the monitor.

3. Complete the Windows NT Server installation.  Refer to the system’s setup or
configuration documentation.

4. Install the proper software utilities available for the RAID controller board installed in
the system.

 For DAC960P and DAC960PD boards, install the DACADM and DACMON utilities.
Refer to Chapter 5, “Using DAC InterRAID Utilities.”

For MegaRAID boards, install the MegaRAID BIOS and Power Console utilities.  Refer
to Chapter 6, “Using MegaRAID BIOS” and Chapter 7, “Using Power Console.”

WARNING After you configure the RAID disk drives, it is very important that you backup the
configuration to a diskette.  It will be very helpful for future use in the event the
configuration should become lost.  Refer to Chapter 5 “Using DAC InterRAID Utilities,”
or Chapter 6 “Using MegaRAID BIOS” and Chapter 7, “Using Power Console.”

5. If necessary, configure the RAID controller board to your preferences.  Refer to Chapter
5 “Using DAC InterRAID Utilities,” or Chapter 6 “Using MegaRAID BIOS” and
Chapter 7, “Using Power Console.”

6. Use Disk Administrator in Windows NT to partition and format the disk space not used
by the operating system.  When prompted to create a Signature File, select Yes.  Refer to
the Windows NT Server System Guide for information on using Disk Administrator.
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5 Using DAC InterRAID Utilities

This chapter pertains only to systems containing either the DAC960P or DAC960PD
controller.  If your system contains the MegaRAID controller, refer to Chapter 6.

NOTE Chapter 1 describes how to determine which RAID controller shipped with your system.

This chapter describes how to upgrade the DAC960 driver and use the RAID Basic
Input/Output System (BIOS) and all of the DAC960 Configuration Utility (DACCF) options.
The “Common DACCF Procedures” section contains procedures such as enabling automatic
rebuild, changing the write policy, configuring additional disk arrays, and recovering
unusable (DED) disk drives.

Intergraph includes DACCF on a diskette delivered with the InterRAID cabinets.  Other
available utilities include the Disk Array Controller Administrator (DACADM) and the Disk
Array Controller Monitor (DACMON).

NOTE If you need to load the new driver, follow the applicable instructions in the following section
for Windows NT 3.51 or Windows NT 4.00.  The DAC960 driver resides on the same diskette
containing DACCF.

Updating the DAC960 Driver  
The DAC960 driver provides an interface for administering the InterRAID disk array
products.  After configuring the Windows NT operating system, you must install the updated
Intergraph DAC960 driver.

To install the updated DAC960 driver for use with Windows NT 3.51:

1. Boot the system and log in as administrator.

2. At Program Manager, open Windows NT Setup.

3. From the Options menu, select Add/Remove SCSI Adapters.

4. Select the DAC960 driver; then, select Remove.

5. Select OK at the Warning dialog; then, select OK again.

6. At the Warning dialog, select Add; then, select OK.  Windows NT Setup displays a list
of adapters.

7. Scroll to OTHER (Requires disk from a hardware manufacturer).
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8. Insert the diskette containing DAC960 NT driver into the floppy disk drive, and select
OK.  The Select OEM Option dialog displays with the DAC960 adapter highlighted.

9. Select OK.  Setup displays the Select SCSI Adapter Option dialog.

10. Select Install.  Setup displays a message that the driver is already present on the system.

11. Select New; then, select Continue at the prompt to specify the path to the adapter files.

12. At the SCSI Adapter Menu, select Close.

13. From the Options menu, select Exit.

14. Reboot the system.

To install the updated DAC960 driver for use with Windows NT 4.00:

1. Boot the system and log in as administrator.

2. Open Control Panel.

3. Select SCSI Adapters icon.

4. Click the Drivers tab.

5. Select the DAC960 driver.

6. Click Remove to remove the old driver.

7. Click the Drivers tab again.

8. Click Add.

9. Click Have Disk.

10. Follow the instruction on the screen to install the updated driver.

11. Remove the diskette containing the DAC960 driver from the disk drive.

12. Reboot the system.

DACADM and DACMON Utilities   
Two DAC960 administrative utilities are easy to install and use in the Windows NT
environment.  The DACADM utility is the main administrative utility for the RAID
controller board and its attached disk arrays.  The DACMON utility monitors the status of
the RAID controller board by recording all abnormal activities in the Event Viewer.
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The following Windows NT 3.5x and 4.00 drivers and utilities are provided in the DAC960
disk array driver and utilities:

DAC960NT.SYS Main DAC960 driver file for Windows NT

DACADM.EXE RAID controller board administration utility

DACMON.EXE Utility for monitoring the RAID controller board

To install DACADM and DACMON utilities:

1. Insert the diskette containing the DAC960 disk array driver and utilities into the floppy
disk drive.

2. Copy the DACADM and DACMON files to the SystemRoot\SYSTEM32 directory.

3. At the command prompt, key in the following (if Windows NT 4.00, use the Run
command):

a:\srvccfg dacmon DAC960Monitor c:\winnt\system32\dacmon.exe

In the above command, it is assumed that the Windows NT system files have been
copied in the directory named \WINNT.  You can modify this command as appropriate.

Starting DACADM

Before running DACADM under Windows NT 3.51, create an icon in the Administrative
Tools program group.

To create an icon, and start DACADM using Windows NT 3.51:

1. Open Administrative Tools.

2. From File menu in Program Manager, select New.  The dialog displays.

3. Select Program Item.  The dialog displays.

4. In the Description box, type dacadm.

5. In the Command Line box, type dacadm.

6. Select OK.  The dialog closes and the new icon appears in the group.

7. Double-click the DACADM icon in the Administrative Tools program group to execute
the utility.
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Before running DACADM under Windows NT 4.00, create an icon in the Program group.

To create an icon, and start DACADM using Windows NT 4.00:

1. Select Start => Settings => Taskbar

2. Click Start Menu Programs.

3. Click Add.

4. In the Command Line box, type c:\winnt40\system32\dacadm.exe.

5. Click Next; then click Finish.  The dialog closes and the new icon appears in the group.

6. To execute the utility, select Start => Programs; then, click the DACADM icon.

DACADM Options

Under the Options pull-down menu, you will find the following entries:

u Select Adapter

u Drive Information

u Change/Add Device

u Make Standby

u Rebuild Drive

u System Drive

Select Adapter and System Drive have their own unique dialogs, whereas the Device
Selection dialog is common for all of the other entries.

The Device Selection dialog shows a matrix of the drives connected to the various channels
of the selected RAID controller board.  The left-most column of the corresponds to SCSI ID
0.  The SCSI ID increments by one number for each column.  The letters STBY, DEAD, and
ONLN indicate standby, dead, and online.  During rebuild, a box with dashes indicates the
rebuild process is occurring.  A blank box indicates that a disk drive was not found for that
channel location and SCSI ID.

NOTE SCSI ID3 is blank to indicate it is reserved for the entire disk array.

Select Adapter

Use Select Adapter to select the RAID controller board for information or to perform an
action.  The available DAC960 controller boards on the system are displayed as Adapter 1,
Adapter 2, etc. in the small boxes.
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Commands are executed only on the selected board.  If a RAID controller board is not found,
the message “Not Installed” appears in the box.

Drive Information

Use this option to provide information about the disk drives connected to the selected RAID
controller board in a system.  The horizontal bar represents the SCSI channel and the box
represents a drive.  The box also indicates the drive status.  Select a drive to view
information on soft error, hard error, parity error, drive model, or select OK to exit.  

Change/Add Device

Use this option to idle a SCSI channel on the RAID controller board.  Use this function when
replacing or rebuilding a dead drive on the selected channel.  After the channel idles,
disconnect and remove the dead drive.  Install a drive that functions properly.  

NOTE Activity on the SCSI channel restarts 30 seconds after you idle a channel without informing
you with a message.  Changing a drive must be done in less than 30 seconds, or done in two
stages:  Idle the channel before removing the dead drive, then idle the channel again before
installing the new drive.

Make Standby

Use this option to create a standby drive.  Select the dead (DEAD) drive box to make the
dead drive a standby drive.  The RAID controller board will automatically try to start the
drive.  If successful, it will make the drive a standby drive.  

NOTE Only drives that are not part of any Drive Group (pack) can be made standby drives.

Rebuild Drive

Use this option to rebuild a drive indicated as dead by the RAID controller board.  Before
executing this option, replace the dead drive with a properly working drive.  Select the dead
(DEAD) drive box to start a rebuild on the drive selected, or select OK to exit.  After the
rebuild starts, the rebuild status displays every system drive that needs the rebuild process.  

System Drive

Use this option to display complete information about the system drives connected to the
RAID controller board.  The information displayed includes the system drive number, RAID
level, write policy size, and status.  The System Drive option also indicates system drives
that are Online, Offline or in a Critical state.  
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DACMON Overview

The DACMON utility monitors the activities of the RAID controller board in the system and
records the activities in the Event Viewer.  DACMON will fail to run if the RAID controller
board is not present.  DACMON displays the status of the RAID controller board, the disk
drives, and the progress of any rebuild operations.

Starting DACMON  

The DACMON icon must be included in Startup for activation under the Windows NT
operating system.

To create a DACMON icon:

1. Open Startup.

2. From File menu in Program Manager, select New.  The dialog displays.

3. Select Program Item.  The dialog displays.

4. In the Description box, type dacmon.

5. In the Command Line box, type dacmon.

6. Select OK.  The dialog closes.  The next time the system reboots, the minimized
DACMON icon appears in the lower left corner of the display.

To view output from the Event Viewer:

1. Under Administrative Tools, select Event Viewer.

2. At Log, select Application.  The messages appear concerning the activities of the RAID
controller board and the time of the event.

RAID BIOS Setup
The RAID controller board contains its own BIOS separate from the system BIOS.  Refer to
the system’s hardware documentation for information regarding the system BIOS for the
host server.

NOTE The DAC960P and DAC960PD boards use the same BIOS.
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Startup Sequence

During power up, the RAID controller board’s BIOS displays a sign-on message with its
version number and date.  The sign-on message looks similar to the following:

DAC960P(D) BIOS Version x.xx--

Thereafter, the BIOS tries to locate the RAID disk array controller.  Once located, the BIOS
determines if the controller firmware is operational.  The RAID BIOS also looks for any
initialization error message that may be posted by the controller firmware.  If it finds a
message, it displays one of the following errors on the screen and aborts the installation
process.

DAC960 fatal error--memory test failed
DAC960 fatal error--command interface test failed
DAC960 hardware error--run diagnostics to pinpoint error
DAC960 firmware checksum error--reload firmware

If any of these messages displays, call the Customer Response Center at
1-800-633-7248 for assistance.

Error Conditions While Checking the Drives

If the firmware finds a valid DAC960 configuration, but it does not match the SCSI drives
currently installed, one or more of the following messages  display:

Unidentified device found at channel x....
Device identified for chn x, tgt y found at chn x’, tgt y’
SCSI device at chn x, tgt y not responding

If any of the above messages displays, the firmware stops the initialization process, except to
find other mismatches.  Then, the BIOS displays the following:

DAC960 Configuration Checksum error-run configuration utility
Mismatch between NVRAM and Flash EEPROM configuration

At the next stage the following message may appear:

Recovery from mirror race in progress

The above message displays if the firmware detects that the system powered off abruptly,
letting some incomplete write operations occur.

The following messages may also appear:



42

Adapter cannot recover from mirror race!
Some system drives are inconsistent!

If the firmware fails to respond to the BIOS inquiry within two minutes, the following
message displays:

DAC960 not responding--no drives installed.

The BIOS then inquires for the firmware version and other information, and displays the
following message:

DAC960 firmware version x.xx

One or more of the following messages display if the firmware reports the error conditions:

Warning: X system drives are offline
Warning: X system drives are critical
Warning: The following SCSI devices are dead--chn x, tgt y...
No system drives found: None installed
X system drives installed

The BIOS repeats the same process for additional DAC960 controllers present in the system.
Then, when possible, it proceeds to boot from the first system drive on the primary RAID
controller board.

Overview of DACCF  
To use DACCF, you should be familiar with MS-DOS and understand the basic terminology
associated with RAID.  Refer to Chapter 10 and the glossary for basic information about
RAID concepts and terminology.

The non-volatile memory and flash EEPROM on the RAID controller board stores the
DACCF configuration data.  When you restart the system, the RAID controller (DAC960P
or DAC960PD) uses this information to define the RAID configuration to the operating
system.

Throughout the utility, a banner at the top of the display shows the title, version number,
date, controller name, slot number, and firmware version.  At the bottom of every display,
DACCF indicates the actions you can take for each menu option.  Additionally, information
boxes describe possible actions not allowed.  Warning boxes display when the next action
could destroy data on the drives, erase configurations, or has other serious system
consequences.
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The following table defines the terms you will see while running DACCF and configuring
drives.

RDY Disk drive ready for configuration

CDR CD-ROM drive

TAP Tape drive

UNF Unformatted drive

PAK Configured packs

DRVS Number of drives in a pack

SIZE Size of the packs (in megabytes)

ONL Drive online (part of pack)

DED Failed drive

RBD Rebuilding

WRO Rebuilding (write only)

FMT Formatting

SBY Standby drive

Starting DACCF
You must run DACCF from a diskette.  The boot sequence of the system must be A:, C:.  If it
is not, refer to the system’s hardware documentation for instructions to change the boot
sequence.

To start the DACCF utility:

1. Insert the DACCF diskette into the floppy disk drive, and then restart the system.

2. At the command prompt, execute DACCF by keying in daccf.

DACCF detects the drives connected to the RAID controller board.  A display similar to
the following appears.
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MYLEX Disk Array Controller-Configuration Utility Version X.XX X/XX/XX

            Initializing tables, please wait...

       Inquiring the devices connected to the adapter

                  Channel # X   Target ID X

The DACCF Main Menu displays if there is only one board installed, as described in the
“Main Menu” section.  If you have multiple RAID boards in the system, refer to step 3
following.  If error messages display, refer to “Error Conditions” in this chapter.

3. If the system contains more than one RAID controller board, a menu similar to the
following lists them according to the BIOS scan order.

MYLEX Disk Array Controller-Configuration Utility Version X.XX X/XX/XX

2 Channel - 7 Target DAC960P  #1                 Firmware version x.xx

Select DAC960

DAC960P (PCI) #1

DAC960P (PCI) #2

DAC960P (PCI) #3

DAC960P (PCI) #4

Select DAC960 using cursor keys, hit <Enter>, <ESC> to Exit

NOTE The primary RAID controller board connects to the disk array that contain s the boot disk
drives.  The primary RAID controller board always precedes any secondary RAID controller
board(s) according to the scan order.
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For DTP Server and TD-xx deskside systems, the following table identifies the scan
order of the PCI slots containing the primary and secondary RAID controller boards
(DAC960).

DACCF DAC960
Selection Menu

RAID Controller
Board System PCI Slot Scan Order

- - Slot 4 1

DAC960 #1 Primary Slot 3 2

DAC960 #2 Secondary Slot 2 3

DAC960 #3 Secondary Slot 1 4

DAC960 #4 Secondary Slot 6 6

- - Slot 5 7

NOTE The BIOS scans the secondary SCSI bus fifth, and the primary SCSI bus eighth in the above
scan order.

4. Use the up and down arrow keys to highlight the RAID controller board to be
configured, and then press ENTER.  You can configure only one RAID controller board at
a time.

NOTE If you use the default configurations outlined in this chapter, the RAID controller board
displayed as controller #1 should always connect to the disk array containing the boot disk
drives.

Main Menu
After successful drive initialization, the DACCF Main Menu displays.
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MYLEX Disk Array Controller-Configuration Utility Version X.XX X/XX/XX

2 Channel - 7 Target DAC960P  #1                 Firmware version x.xx

Main Menu

 01.  Automatic Configuration
 02.  New Configuration
 03.  View/Update Configuration
 04.  Rebuild
 05.  Initialize System Drive
 06.  Consistency Check
 07.  Tools
 08.  Select DAC960
 09.  Advanced Functions
 10.  Diagnostics

 If more than 3 Physical Drives are present, choose this
 option to create one RAID 5 System Drive automatically.

Use cursor keys for selection, hit <ENTER> to select, <ESC> to Quit

The help window (box below the Main Menu) briefly describes the operations you can
perform with the highlighted option.

Use the cursor keys to select the options in the Main Menu.  Press ENTER to select the
highlighted option.  The following sections describe each option in detail.

01. Automatic Configuration

Use the Automatic Configuration option in the DACCF Main Menu only when three to eight
disk drives of the same capacity are attached to the RAID controller; the drives can be in
different disk arrays.  This function aborts after displaying an error message if the drive
capacities are different.

Automatic Configuration creates a single pack using all of the drives, and then creates a
single RAID Level 5 system drive when you select the write policy for the system drive.  The
system disk drive number is 0.  You can define a maximum of eight (8) system drives per
DAC960 RAID controller.

To perform automatic configuration:

1. From the DACCF Main Menu, select Automatic Configuration.  If a valid configuration
exists, a warning message displays:

 A valid configuration exists.  Proceeding further will destroy
this configuration.
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2. Select YES in the confirmation window to proceed.  Select NO to return to the Main
Menu.

After selecting YES, the RAID controller examines the total capacity of each drive
connected to the controller.  If all the drives are the same, this message displays:

Do you want to have Write Caching enabled?

3. Selecting YES sets the write policy to Write-back.  Selecting NO sets the write policy to
Write-through.  Write-through caching is required when re-installing the operating
system (the installation will fail if set to Write-back).  After an installation, you can reset
it to Write-back.

CAUTION Write-through caching reduces the risk of data loss in the event of a power failure.  Write-
back caching improves performance, but the drawback is potential data loss during a power
failure.  Without a UPS, a power failure can corrupt a disk drive resulting in lost data.

After the system saves the configuration, a display similar to the following appears.  The
display describes the configuration created.

MYLEX Disk Array Controller-Configuration Utility Version X.XX X/XX/XX

2 Channel - 7 Target DAC960P  #1                 Firmware version x.xx

Automatic Configuration successfully done.

Make sure to INITIALIZE System drive#0 before exiting this utility!

Number of System Drives = 1

RAID Level = 5

Write Cache = Disabled

Number of Physical Drives = 3

Available Capacity = 2026 MB

Automatic Configuration

Press any key to return to Main Menu

4. Press any key to return to the DACCF Main Menu.

5. From the DACCF Main Menu, select Tools.  Back up and print the configuration file
using the Backup/Restore Conf and the Print Configuration options of the Tools menu.
Refer to “07. Tools” in this chapter for details.

6. From the DACCF Main Menu, select Initialize System Drive to initialize the system
disk drive that does not contain the operating system.  Refer to "05. Initialize System
Drive" in this chapter for details.
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7. To partition the disk drive space, reboot the system into Windows NT and run Disk
Administrator.

02. New Configuration

Use the New Configuration option in the DACCF Main Menu to configure the drives in the
disk array for the first time, or to establish a new configuration.  This option overwrites the
existing configuration with the new configuration.  When you select New Configuration, the
following menu displays.

MYLEX Disk Array Controller-Configuration Utility Version X.XX X/XX/XX

2 Channel - 7 Target DAC960P  #1                 Firmware version x.xx

 Choose this option to create, arrange, or cancel one or
 more packs and also to view information on the physical
 drives connected to the adapter.

New Configuration

 1. Define Pack

 2. Define System Drive

Use Cursor keys for selection, hit <ENTER> to select, <ESC> to Exit

NOTE Use New Configuration with caution, or you will lose an existing configuration.

Define Pack

Use Define Pack in the New Configuration menu to set up physical drives into packs, cancel
and arrange existing packs.  When you select Define Pack, a display similar to the following
appears.  
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MYLEX Disk Array Controller-Configuration Utility Version X.XX X/XX/XX

2 Channel - 7 Target DAC960P  #1                 Firmware version x.xx

 Pack Definition

1.  Create Pack

2.  Cancel Pack

3.  Arrange Pack

4.  Device Information

 PAK     DRVS     SIZE (MB)

Tgt Channel Number
 ID    0        1

0 RDY

1 RDY

2 RDY

3

5 RDY

4 RDY

6 RDY

CDR

The disk drive list to the left of the display contains the details of existing configured drives.
RDY indicates the disk drive is ready for configuration.  CDR represents the CD-ROM
drive, and TAP represents a tape drive, if installed.

NOTE An unformatted (UNF) drive must be low-level formatted before configuration.  Refer to “07.
Tools” in this chapter and use the Tools option of the DACCF Main Menu to low-level format
the drive.

On the lower right side of the display, columns list the configured packs (PAK), number of
drives in the packs (DRVS), and the size of the packs (SIZE) in megabytes.

Pack Definition contains four options you can select.  The following instructions describe
how to use each option.

Create Pack allows you to create multiple packs containing multiple drives.

To create a pack:

1. From the Pack Definition menu, select Create Pack.  The first drive in the disk array
highlights.

2. Use the up and down arrow keys to select a drive, and press ENTER to include the drive
in the new pack.

3. Select additional drives to include in the pack.

NOTE All the drives in a pack must be the same capacity, or the pack capacity will be a multiple of
the smallest drive.  To determine the capacity of a drive, refer to the instructions in this
section for displaying device information.
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4. When you have included all of the desired disk drives for this pack, press ESC to return
to the Pack Definition menu.  The drives in the pack are labeled online (ONL), and
identified by the pack label and stripe order.  For example, A-0 stands for pack A, drive
0; B-3 stands for pack B, drive 3.

 If you do not want to create another pack, then the new pack must be arranged before
defining a system drive.  Refer to the instructions in this section for arranging packs.

5. Repeat steps 1 through 4 to create another pack.  When you have defined all drives on a
channel in a pack, the Arrange Pack option in the Pack Definition menu automatically
highlights.  Refer to the instructions in this section for arranging packs.

Cancel Pack in the Pack Definition menu allows you to cancel a pack.

To cancel a pack:

1. From the Pack Definition menu, select Cancel Pack.  The first drive in the first pack
highlights.

NOTE You have to cancel the packs in reverse order from the way in which you created them.

2. Press ENTER to cancel the highlighted pack, or move the cursor to another pack, and
then press ENTER.  The pack is canceled and the Cancel Pack option highlights in the
Pack Definition menu.

3. Select another pack to cancel, or choose another option in the Pack Definition menu.

Arrange Pack in the Pack Definition menu allows you to identify packs to be defined as
system drives.  You cannot define a pack as a system drive until it has been arranged.

To arrange a pack:

NOTE Drives in an arranged pack that have not been configured as a system drive will be
automatically configured as standby (SBY) drives.

1. From the Pack Definition menu, select Arrange Pack.  The first drive in the first pack
highlights.

2. Press ENTER to arrange the pack.  The pack information columns list the configured
packs (PAK), number of drives in the packs (DRVS), and the size of the packs (SIZE).

3. Select another pack to arrange and press ENTER.  The pack information columns update
each time you arrange a pack.  The following example is for two arranged packs.
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MYLEX Disk Array Controller-Configuration Utility Version X.XX X/XX/XX

2 Channel - 7 Target DAC960P  #1                 Firmware version x.xx

 Pack Definition

1.  Create Pack

2.  Cancel Pack

3.  Arrange Pack

4.  Device Information

 PAK     DRVS     SIZE (MB)

  A       4       4052
  B       2       2026

Tgt Channel Number
 ID    0        1

0
A-0
ONL

1
A-1
ONL

2
A-2
ONL

3

5
B-0
ONL

4
A-3
ONL

6
B-1
ONL

CDR

4. After arranging all of the packs, press ESC to return to the New Configuration menu.
Then, select the Define System Drive option to proceed.

NOTE After arranging all of the packs, the Define System Drive option in the New Configuration
menu highlights.  Refer to "Define System Drive" later in this section for more details.

Device Information in the Pack Definition menu displays information about a drive
connected to the RAID controller.  The RAID controller can also display information for
other devices such as CD-ROM drives and tape drives.

To display device information:

1. From the Pack Definition menu, select Device Information.  The first disk drive in the
disk drive list highlights.

2. Press ENTER to display the information, or select another drive.  The device information
displays as follows.

Device Information

 Vendor :  Conner
 Model number :  CFP1060ELK
 Revision :  2035
 Size :  1013 MB
 Channel :  0
 Target :  0

3. Press any key to return to the disk drive list, and select another drive.  Press ESC to
return to Pack Definition menu.
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Define System Drive

Define System Drive of the New Configuration menu allows you to create one or more
system drives, and change the write policy for the selected system drive.  You can define a
maximum of eight (8) system drives per DAC960 RAID controller.  When you select Define
System Drive, a display similar to the following appears.  

System Drive Definition

MYLEX Disk Array Controller-Configuration Utility Version X.XX X/XX/XX

2 Channel - 7 Target DAC960P  #1                Firmware version x.xx

Pak/Drvs Size (MB)  Pak/Drvs   Size(MB)

 A/4        4052
 B/2        2026

 Sys Drv  Size (MB)   RAID     Write Mode

System Drive Definition

1. Create System Drive

2. Toggle Write Policy

The Pak/Drvs column (top left) lists all the current arranged packs and their sizes.  The size
specified for each pack is the sum of the capacity of the drives in the pack.

NOTE If the drives in a pack are not the same size, then the size of the pack is a product of the
number of drives in the pack and the smallest drive in the pack.

The Sys Drv column (lower left) lists all the created system drives, their sizes, RAID levels,
and write policies.  If you have not defined a system drive, the Sys Drv column is empty.
The column updates as you define the system drives.

NOTE Drives in an arranged pack that have not been configured into a system drive will be
automatically configured as standby (SBY) drives.

The System Drive Definition menu has two options:  Create System Drive and Toggle Write
Policy.  The following instructions allow you to create a system drive.
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DAC960 System Drive Size Limit

If your system has InterRAID disk arrays that use a DAC960P or DAC960PD RAID
controller board with version 2.x (or previous) firmware, be aware of the following
limitations:

u You cannot create a system (logical) drive larger than 32,768 MB.

u You can create a pack larger than 32,768 MB.  However, if you do so, and then try to
create a  system drive larger than 32,768 MB, the attempt to create the system drive will
fail.

WARNING If you try to create a system drive larger than 32,768 MB, the Myle x DACCF utility
program will insert your original drive size (default) and not create a system drive.

You can work around these limitations as follows:

1. Create one or more packs, with each pack containing up to eight disk drives of any size,
as required.

2. Divide each pack into system drives, with each system drive less than or equal to 32,768
MB.

3. Initialize the system drives.

If you require the entire amount of disk space to appear as a single system drive, rather than
as multiple 32 GB (or smaller) system drives, you can combine the smaller drives into a
logical volume using the Windows NT Disk Administrator.  Combining the drives in this
way does not affect the speed or capacity of the disk subsystem.

NOTE The terms system drive and logical drive are used interchangeably.

To create a system drive:

1. You can define a maximum of eight (8) system drives per DAC960 RAID controller.
From the System Drive Definition menu, select Create System Drive.  The first arranged
pack in the Pak/Drvs column highlights, and the RAID Levels display as follows.

RAID Level

 RAID 0
 RAID 1
 RAID 5
 RAID 6
 RAID 7
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The following table briefly describes the supported RAID levels.

RAID
Level Description

0 Data is striped across several physical drives, yielding higher performance
than is possible with individual drives.  This level does not provide
redundancy.

1 Drives are paired and mirrored.  All data is 100 percent duplicated on an
equivalent drive.

5 Data is striped across several physical drives.  For data redundancy, drives
are encoded with rotated XOR redundancy.  Parity is spread across all drives.

6 (0+1) Combines RAID Level 0 and RAID Level 1

7 Drives are seen independently as with any disk controller, or spanned and
seen as a single disk.  This option does not provide redundancy.

NOTE Refer to Chapter 10 for detailed information about the various RAID levels.

Valid RAID levels are determined by the number of drives in the selected pack.  You
can choose valid RAID levels only for the highlighted pack.

2. Select a RAID level for the highlighted pack, and then press ENTER.  The Enter Size
window shows the maximum possible size for the system drive being defined.

NOTE The size you specify is the actual size of the system drive, which includes the overhead for
the RAID level and redundancy.  The size of the system drive is what the operating system
recognizes and uses.  If you do not specify the size as the total available capacity, then you
can define another system drive on the same pack.  The maximum size of a system drive is
32,768 MB.

3. Enter the size for the system drive.  Two windows display as shown.

Do you want to create
this system drive?

NO
YES

  System Drive# = 0

  RAID Level = 5

  Capacity = 3039 MB

NOTE Spanning a system drive across multiple packs is automatically done when the size of the
packs are the same.
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4. Select YES to create the system drive as defined.  The system drive information displays
in the Sys Drv column.

 Write-through caching reduces the risk of data loss in the event of a power failure.
Write-back caching improves performance, but the drawback is potential data loss if
power fails.  If you want to change the policy to write-back for systems with a UPS
attached, refer to the instructions for changing the write policy in this section.

5. To create another system drive on a different pack, or on the unused space of the same
pack, repeat steps 1 through 4 above.  If the space is insufficient on a partially defined
pack, a message explaining this condition displays when you try to define a system
drive.

6. After creating all the system drives, press ESC twice.  When the Save Configuration
window displays, select YES to save the configuration to flash EEPROM.

CAUTION If you select NO in the Save Configuration window, the currently defined configuration is
entirely discarded, and the program returns to the DACCF Main Menu.

NOTE If you press ESC in the Save Configuration window, the defined configuration remains intact
and the program returns to the New Configuration menu.  You can continue later with the
configuration process.

7. Initialize all of the new system drives.  Refer to "05. Initialize System Drive" in this
chapter.

8. Ensure the Array Encl MGMT I/F option is set to Enabled to allow automatic disk drive
rebuild.  Refer to “09. Advanced Functions,” in this chapter for more information about
the Array Encl MGMT I/F option and other hardware parameters.

The following instructions allow you to change the write policy for the system drives.

To change the write policy of a system drive:

1. From the System Drive Definition menu, select Toggle Write Policy.   The write policy
of the first system drive highlights in the Write Mode column.

2. Press ENTER to toggle the policy.  For each system drive policy you need to change,
select the policy and press ENTER.

3. Once you change the write policy on all the desired system drives, press ESC to return to
the System Drive Definition menu.

4. Press ESC again to save the configuration.
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03. View/Update Configuration  

Use the View/Update Configuration option in the DACCF Main Menu to view, edit, or
update an existing configuration, add more disk drives, or use existing standby drives as
normal drives.  You can change the write policy of any system disk drive at any time by
selecting this option.

When you select View/Update Configuration, the following menu displays.

MYLEX Disk Array Controller-Configuration Utility Version X.XX X/XX/XX

2 Channel - 7 Target DAC960P  #1                 Firmware version x.xx

Choose this option to view existing pack(s) OR create,

arrange, cancel one or more additional packs

Use Cursor keys for selection, hit <ENTER> to select, <ESC> to Exit

View/Update Configuration

 1. Define Pack

 2. Define System Drive

Define Pack

The existing packs can be canceled, deleted or changed.  The newly added drives (RDY) and
the existing standby (SBY) drives can be created into packs.  You can define a maximum of
eight (8) physical drives per pack.  If you wish to cancel a pack, and more than one pack is
defined, be sure to cancel all packs in reverse order.  For example, if you define three packs
(A, B, C), be sure to cancel pack C before canceling packs B and A, otherwise a “wrong
order” error message appears.  

NOTE For creating and arranging packs, refer to “02. New Configuration” in this chapter.

When you select Define Pack, a display similar to the following appears.
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MYLEX Disk Array Controller-Configuration Utility Version X.XX X/XX/XX

2 Channel - 7 Target DAC960P  #1                 Firmware version x.xx

 Pack Definition

1.  Create Pack

2.  Cancel Pack

3.  Arrange Pack

4.  Device Information

 PAK     DRVS     SIZE (MB)

  A       3        3039

Tgt Channel Number
 ID    0        1

0
A-0
ONL

1
A-1
ONL

2
A-2
ONL

3

5
B-0
ONL

4
A-3
ONL

6
B-1
ONL

CDR

The disk drive list to the left of the display contains the details of existing configured drives.
ONL indicates the disk drive is online (usable) and CDR represents an installed CD-ROM
drive.

On the lower right side of the display, columns lists the configured packs (PAK), number of
drives in the packs (DRVS), and the size of the packs (SIZE) in megabytes.

Define System Drive

Define System Drive of the View/Update Configuration menu (after additional packs have
been created and arranged) allows you to create additional system drives.  You can define a
maximum of eight (8) system drives per DAC960 RAID controller.  You can also change the
write policy for the selected system drive.  When you select Define System Drive, a display
similar to the following appears.  
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 Pak/Drvs   Size (MB)  Pak/Drvs  Size(MB)

   A/3       3039

 Sys Drv   Size (MB)    RAID    Write Mode

    0        2026        1      WRITE THRU

 Use Cursor keys for selection, hit <Enter> to select, <ESC> to Previous Menu

System Drive Definition

1. Create System Drive

2. Toggle Write Policy

MYLEX Disk Array Controller-Configuration Utility Version X.XX X/XX/XX

2 Channel - 7 Target DAC960P  #1                 Firmware version x.xx

Refer to “02. New Configuration” in this chapter for details of defining system drives.

04. Rebuild

Use the Rebuild option in the DACCF Main Menu to manually rebuild a replacement disk
drive for one that has failed.  You can also rebuild a replacement disk drive automatically if
the Array Encl MGMT I/F option is set to Enabled.  Refer to “09. Advanced Functions,” in
this chapter for more information about the Array Encl MGMT I/F option and other
hardware parameters.

Intergraph recommends that you use the automatic rebuild feature, rather than rebuild the
replacement disks manually.  Systems using a redundant RAID level without standby drives
in place pose a risk should one of the online drives suddenly fail.  The disk array will
continue to function without interruption, but the RAID system cannot tolerate further
physical drive failures, since data on the drives is no longer redundant.  In order to make the
system redundant, you must replace and rebuild the failed disk drive.

NOTE The Rebuild option only works in systems with redundant system drives.  If you attempt to
rebuild a drive in a non-redundant system, errors will occur.

To manually rebuild a new disk drive:

1. From the DACCF Main Menu, select Rebuild.  A menu similar to the following
displays.  The drive marked dead (DED) indicates a replacement disk drive.
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MYLEX Disk Array Controller-Configuration Utility Version X.XX X/XX/XX

2 Channel - 7 Target DAC960P  #1                 Firmware version x.xx

Tgt Channel Number
 ID    0        1

Select a drive using cursor keys, hit <Enter> to Rebuild, <ESC> to Quit

REBUILD

0
A-0
ONL

1
A-1
ONL

2
A-2
ONL

3

4
A-3
DED

5
B-0
ONL

6
B-1
ONL

CDR

2. Select the drive marked DED, and press ENTER.  Once the rebuild starts, a progress bar
displays.

When the rebuild completes, a message displays stating that the rebuild was a success, or
that errors occurred.  If errors occur, open the Bad Block Table as described in “07. Tools”
in this chapter.

05. Initialize System Drive

Once a system drive is created (refer to “02. New Configuration” for details), it must be
initialized before the system can use it.  The process fills the drives with initialized data and
synchronizes redundancy (mirror or parity).  Errors can result if you fail to initialize a
system drive.  For example, the drive may not function properly, fail to boot, fail to install
the operating system, or fail the consistency check.  Also, a change in the size of the system
drives or packs requires that you initialize a system drive.

NOTE The initialization process is much faster with write-back cache enabled.  You can enable
write-back cache for this process, and then disable it after initialization, if desired.  Refer to
“03. View/Update Configuration” and select Define System Drive to change the write policy.

Once the system drive initialization starts, it cannot be aborted.

To initialize a system drive:

1. From the DACCF Main Menu, select Initialize System Drive.  A list of system drives
displays with the first system drive highlighted.  The following message also displays:
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 Simultaneous initialization of two or more drives can be done.
Using cursor keys, move the required System drive box and hit
<Enter> to select.  After selecting the required System drive(s),
move to the ‘START’ box and hit <Enter> to proceed with the
Initialization.

 !!Warning:  Initialization of the System drives will destroy data
on drives.

2. Press ENTER to select the system drive.  If multiple system drives exist, press ENTER on
each for simultaneous initialization.  A check mark indicates the selected system drives.

3. After selecting all the system drives to be initialized, select the Start box and then press
ENTER.  The following message displays:

 Do you want to proceed with initialization?

4. Select YES to initialize all of the selected system drives.  A progress bar indicates each
system drive initialized.

5. When the initialization of all system drives completes, press any key to save the
configuration and return to the DACCF Main Menu.

6. Ensure the Array Encl MGMT I/F option is set to Enabled.  Refer to “09. Advanced
Functions,” in this chapter for more information about the Array Encl MGMT I/F option
and other hardware parameters.

06. Consistency Check

Use the Consistency Check option in the DACCF Main Menu to verify data consistency on
redundant system drives.  You should always execute a Consistency Check after a system
crash or power interruption.

To perform a consistency check:

1. From the DACCF Main Menu, select Consistency Check.  A list of current system
drives displays.

2. Use the cursor keys to select a system drive, and press ENTER.  If the system drive you
select is not a redundant drive, the following message displays:

 Cannot Check consistency of a non-redundant System drive

If the selected drive is redundant, the consistency check starts.  When the consistency
check completes, a message displays the results.  If inconsistent blocks were found, the
following message displays.

Do you want to restore consistency?

3. Select YES to restore consistency to the system drive.
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NOTE Restoring consistency could mean loss of data in the blocks that were found inconsistent.

4. After restoring consistency, select another drive to check, or exit to the DACCF Main
Menu.

07. Tools  

Use the Tools option in the DACCF Main Menu to perform many useful operations on the
RAID system.  When you select the Tools option, a menu similar to the following displays.

MYLEX Disk Array Controller-Configuration Utility Version X.XX X/XX/XX

2 Channel - 7 Target DAC960P  #1                 Firmware version x.xx

 Tools

1.  Bad Block Table

2.  Error Counts

3.  Format Drive

4.  Make Online

5.  Kill Drive

6.  Backup/Restore Conf

7.  Clear Configuration

8.  Print Configuration

Press any key to continue

Tgt Channel Number
 ID    0        1

0
A-0
ONL

1
A-1
ONL

2
A-2
ONL

3

5
B-0
ONL

4
A-3
DED

6
B-1
ONL

CDR

Bad Block Table

From the Tools menu, if you select Bad Block Table (BBT), the View Bad Block Table menu
displays and allows you to view the rebuild BBT and the write back BBT as follows.  

View Bad Block
Table

     View Rebuild BBT

     View Write Back BBT

Select View Rebuild BBT to view information about the bad blocks detected on the system
drive during a rebuild.   This information includes the location on the system drive where the
disk error occurred, its block number, and the number of consecutive blocks where disk
errors occurred.  Press any key to return to the View Bad Block Table menu.  The
information clears the rebuild BBT after you return to the View Bad Block Table menu.
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Select View Write Back BBT for information about the bad blocks detected during write
back operations.  This information includes the location on the system drive where the disk
error occurred, its block number, and the number of consecutive blocks where the disk errors
occurred.  Press any key to return to the View Bad Block Table menu.  The information
clears the write back BBT after you return to the View Bad Block Table menu.

Error Counts

Use Error Counts in the Tools menu to view the error counts of the disk drives.  The RAID
firmware maintains error counts for all physical drives.  

To view the error counts:

1. From the Tools menu, select Error Counts.  The first disk drive in the disk drive list
highlights.

2. Press the cursor keys to select a disk drive, and then press ENTER.  A display similar to
the following appears.

 Channel # :  0
 Target ID :  1
 Parity Errors :  0
 Soft Errors :  0
 Hard Errors :  0
 Misc. Errors :  0

3. Press ESC to return to the Tools menu.  The error counts will clear the next time you
return to the View Bad Block Table menu.

Format Drive

Use Format Drive in the Tools menu to low-level format the physical drives.  You can select
multiple drives for simultaneous formatting.  

NOTE Only disk drives that are not configured into packs are available for low-level formatting.

To format drives:

1. From the Tools menu, select Format Drive.  The first drive available for formatting
highlights.

2. Press ENTER to select the drive, or move to another drive.  The label for the selected disk
drives changes to format (FMT).

3. After selecting all the drives to format, press ESC.  The following message displays:

 All data will be LOST.
Proceed with Format?
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4. Select YES.  The following message displays:

 Do you really want to Format selected drives?

5. Select YES to start formatting.  The following message displays:

Formatting all the selected drives.  Please wait...

Once complete, the disk drives return to their original states, except for the drives labeled
UNF (unformatted), which will be changed to RDY (ready).

Make Online

Use the Make Online option in the Tools menu to change a disk drive from the unusable
(DED) state to the online (ONL) state.  Disk drives that are labeled DED and not configured
into a pack cannot be made online.  

To make drives online:

1. From the Tools menu, select Make Online.  A warning message displays stating the
consequences of making a drive online.

2. Press a key to dismiss the warning message.  The first drive available to the Make
Online function highlights.

3. Press the cursor keys to highlight a drive, and then press ENTER.  A confirmation
message displays:

 Do you really want to make drive Online?

4. Select YES.  The drive state changes to ONL.

5. After selecting all the drives to be made online, press ESC.

NOTE You can quickly make all DED drives online by restoring the RAID configuration file, as
described later in “Backup/Restore Conf.”

Kill Drive

Use the Kill Drive option in the Tools menu to change an ONL disk drive to DED.  Only
physical drives included in a configured pack can be killed.  

To kill a drive:

1. From the Tools menu, select Kill Drive.  A warning message displays stating the
consequences of killing a drive.

2. Press a key to dismiss the warning message.  The first drive available for killing
highlights.
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3. Press the cursor keys to highlight a drive, and then press ENTER.  A confirmation
message displays:

 Do you really want to KILL the drive?

4. Select YES.  The drive state changes to DED.

5. After selecting all the drives to be killed, press ESC.

Backup/Restore Conf

Use the Backup/Restore Conf option in the Tools menu to save a new configuration to a
diskette (back up), or to restore a configuration file that has become corrupted or lost.  For
every InterRAID cabinet connected to the system, always back up a configuration file.  

To back up a configuration to floppy:

1. Insert a diskette into the floppy disk drive.

2. From the Tools menu, select Backup/Restore Conf.

3. Select Backup.

4. Press ENTER to confirm the warning message.

5. Type a filename for the configuration file.  Do not include directory paths.  Use a .CFG
extension as part of the filename to identify it as a configuration file.  The following
message displays:

 Existing File, if any will be overwritten!

6. Select YES and press ENTER.

7. Remove the diskette from the floppy disk drive.

To restore a configuration:

1. From the Tools menu, select Backup/Restore Conf.

2. Select Restore.

3. Press ENTER to confirm the warning message.

4. Key in the filename for the configuration file.  Do not include directory paths.  If you
used a .CFG extension as part of the filename, include the extension.

WARNING Do not key in the filename used for the ASCII version of the RAID configuration file.
The ASCII version will overwrite the binary code for setting the registers, causing
damage to the RAID controller board.  The board must be replaced.

The following message displays:

Do you really want to Restore Configuration?
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CAUTION The restored configuration file must match the hardware configuration.  DACCF assumes the
number of physical drives installed in the InterRAID cabinet is the same as the number of
drives configured in the configuration file.

5. Select YES and then press ENTER.  The following message displays:

 Are you sure you want to Restore Configuration?

6. Select YES and then press ENTER.  The configuration is read from the file and saved on
the RAID controller board.

7. Exit DACCF and restart the system for the restored configuration to take effect.

Clear Configuration

Use the Clear Configuration option in the Tools menu to erase the existing configuration of
the RAID controller board.  

To clear the existing configuration:

1. From the Tools menu, select Clear Configuration.  The following message displays:

 The existing config will be destroyed!

2. Select YES to clear the configuration.

The disk drives in the disk array will not be accessible until you define a new configuration.

Print Configuration

Use the Print Configuration option in the Tools menu to save a copy of the configuration in
ASCII format to a floppy diskette or hard disk drive.  

To save an ASCII version of the configuration file:

1. Insert a diskette into the floppy disk drive.

2. From the Tools menu, select Print Configuration.

3. Type the filename for the ASCII version of the configuration file.  Do not include
directory paths.  Include the .TXT extension as part of the filename.

NOTE Do not key in the filename of the binary version of the configuration file.

4. Select YES to confirm the filename.

5. To view the file, exit DACCF.  At the command prompt, type the following and press
ENTER, where filename is the name of the ASCII file you just made:

 edit  filename
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6. To print a hardcopy, use the editor’s print command.

7. Remove the diskette from the floppy disk drive.

08. Select DAC960

When you have multiple RAID controller boards in the system, the Select DAC960 option in
the DACCF Main Menu allows you to select the RAID controller that needs to be
configured.  You can configure only one RAID controller board at a time.

To select a RAID controller board:

1. From the DACCF Main Menu, select Select DAC960.  A list of all installed RAID
controller boards displays.  Refer to “Starting DACCF” earlier in this chapter for
information about determining the difference between primary and secondary RAID
controller boards.

2. Select the RAID controller board to configure, and then press ENTER.  Note that the
banner at the top of the display shows the RAID controller board currently selected.

3. DACCF scans the disk array to detect the drives connected to the controller and returns
to the DACCF Main Menu.

NOTE If there are errors associated with the selected controller, refer to “Error Conditions” later in
this chapter.

09. Advanced Functions

When you select the Advanced Functions option from the DACCF Main Menu, the
following menu displays.
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MYLEX Disk Array Controller-Configuration Utility Version X.XX X/XX/XX

2 Channel - 7 Target DAC960P  #1                 Firmware version x.xx

Choose this option to view or edit the controllers

Hardware features like battery backup.

Use Cursor keys for selection, hit <ENTER> to select, <ESC> to Exit

Edit/View Parameters

 Hardware Parameters

 Physical Parameters

 SCSI Xfer Parameters

 Startup Parameters

Hardware Parameters

When you select Hardware Parameters, a menu similar to the following displays.  Use the
arrow keys to select a parameter, and press ENTER to toggle the settings.  

Hardware Parameters

 Battery Backup Disabaled

 Array Enclosure Management Enabled

 StorageWorks Fault MGMT. (TM) Disabled

NOTE The default hardware parameters are:  Battery Backup = Disabled, Array Enclosure
Management. I/F (AEMI) = Enabled, StorageWorks Fault MGMTI/F = Disabled.  

The InterRAID-6, InterRAID-8, and InterRAID-12 disk arrays do not support the Battery
Backup option.  Intergraph recommends connection to a UPS to guard against data loss.

The Array Enclosure Management I/F option should be set to Enabled each time you create a
new configuration.  This option allows the Windows NT Server operating system to
recognize a failed drive and to begin the automatic on-line rebuild of the drive.  Intergraph
recommends the automatic rebuild capability for every InterRAID configuration.  

The StorageWorks Fault Management option is not used by the InterRAID-6, InterRAID-8,
and InterRAID-12 disk arrays.  The default is Disabled.
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Physical Parameters

When you select Physical Parameters, a menu similar to the following displays.  The three
physical parameters that can be set are Default rebuild rate, the Stripe size (K bytes), and
Controller read ahead.  Use the arrow keys to select a parameter, and press ENTER to toggle
the settings.  

Physical Parameters

 Default Rebuild Rate 50

 Stripe Size (K bytes) 8

 Controller read ahead Enabled

NOTE The default physical parameters are:  Default rebuild rate = 50, Stripe size (K bytes) = 8,
Controller read ahead = Enabled.   

Use the Default rebuild rate option to change the rebuild rate from 0 to 50.  A rebuild rate of
50 is the maximum.  A higher value assigns a higher priority to the rebuild activity rather
than the other activities, resulting in a faster drive rebuild, but slower disk performance.  If
the rebuild needs the least priority, set the rebuild rate to 0 to increase performance for other
activities.  

The Stripe size (K bytes) option changes the way of accessing the information on the drives.
Stripe sizes of 8K, 16K, 32K and 64K are supported.  A higher stripe size results in a higher
sequential throughput and a slightly reduced random throughput.  

WARNING When you select a different stripe size, all existing data on the drives will be lost.
Back up the drives before changing the stripe size.

The Controller read ahead option, when set to Enabled, directs the controller to read the data
from the block requested and from one block ahead.  This method of reading data assumes
that the subsequent block of data will soon be requested.  The Controller read ahead option is
Enabled by default and will increase the performance of read operations.  

SCSI Xfr Parameters

The SCSI Xfr Parameters menu allows you to change Data transfer rate and Command
tagging parameters for each channel on the current RAID controller board.  When you select
the SCSI Xfr Parameters from the Edit/View Parameters menu, you are prompted to select a
channel.  After selecting the channel, the following menu displays.  
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SCSI Xfr Parameters

 Data transfer rate 10 MHz

 Command tagging Enabled

 SCSI data bus width 16 Bit

NOTE The default SCSI Xfr parameters are:  Data transfer rate = 10 MHz, Command tagging =
Enabled, SCSI data bus width = 16 Bit.   

The Data transfer rate option sets the default SCSI negotiation rate for the selected SCSI
channel.  The options are 10 MHz, 8 MHz, 5 MHz, and Asynchronous.  The default is 10
MHz for the disk drives.

The Command tagging option enables or disables command tagging support for the selected
SCSI channel.  The default is set to Enabled.

The SCSI data bus width option allows you to select either 8 Bit or 16 Bit parameters.
Verify that 16 Bit is enabled.

Startup Parameters

The options for the Startup Parameters (Spin up option, Number of devices per spin, and
Delay) can be used to set up the way the disk drives spin initially.  However, by default, the
InterRAID cabinet power supplies manage how the drives spin up, so these options do not
need changing.  The disk drives spin up one at a time, with a four-second delay between spin
up.  If you change the Spin up parameter to Automatic, then the Devices per spin and Delay
parameters can also be changed.  The following menu shows the startup parameters.

NOTE This parameter only applies to the disk drives in the disk array, not to other SCSI devices.

Startup Parameters

 Spin up option On power

 Number of devices per spin 0

 Delay (seconds) 0

NOTE The default startup parameters are:  Spin up option = On power, Number of devices per spin
= 0, Delay (seconds) = 0.   
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10. Diagnostics

The last option in the DACCF Main Menu is for performing system level diagnostics on the
selected RAID controller.  Diagnostics are reserved for Intergraph field engineer use only.
An engineer can access the diagnostics with an uppercase Y as supported under DACCF
version 3.10.

NOTE Before running the diagnostics, refer to the README file on the DACCF diskette for
limitations and warnings about the diagnostics.

Error Conditions
During startup, DACCF may report the following types of messages:

u Installation aborted errors

u NVRAM/Flash configuration mismatch errors

u Controller checksum errors

The following sections describe the errors.

Installation Aborted Errors  

If reporting an installation abort condition, the following message displays:

Installation aborted

The cause of this error includes a faulty SCSI cabling, SCSI channel, controller, or improper
power to the disk drives.  This error also occurs if you power off the InterRAID cabinet
before the system.

To recover from an aborted installation:

1. Press any key.  A list of all the disk drives displays.  The state of all the drives whose
state changed since the last time the InterRAID cabinet was powered off also displays.

2. Press the S key to save the displayed configuration.  This process does not affect the
system drive and other associated information already stored.

3. Power off the system and power off the InterRAID cabinet.  Then, restart the InterRAID
cabinet and the system.
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NVRAM/Flash Configuration Mismatch Errors   

If detecting a mismatch between the configurations saved in the NVRAM and flash
EEPROM, the following message displays:

The NVRAM and FLASH configurations do not match. Proceeding further
will allow selection between NVRAM and FLASH configurations.

The cause of this error is probably due to a corrupted NVRAM.

To recover from the mismatch:

1. Press a key to display the Load Configuration Menu.

Load Configuration

 Load FLASH Configuration

 Load NVRAM Configuration

2. Normally the flash EEPROM contains the most accurate configuration.  Choose the
Load Flash configuration option.

3. Press the S key to save the configuration.

4. Power off the system and power off the InterRAID cabinet.  Then, restart the InterRAID
cabinet and the system.

Controller Checksum Errors   

If a configuration checksum error is present, DACCF displays the following message,
advising the user to reset the RAID to a default configuration.

The controller configuration table has a checksum error.  This may
be due to corruption in the configuration tables stored in the
controller’s FLASH memory.  To overcome this problem the
configuration table has to be restored to the default values.  Then
rerun the utility and restore the required configuration from a
previously backed up file using menu options under “Tools.”  If
there is no backup then the controller parameters have to be set to
the required values using “Advanced Functions” option from the “Main
Menu.”  Setting wrong values may cause data loss!

To recover from the controller checksum error:

1. Press the S key to save the current configuration.

2. Exit DACCF, power off the system and power off the InterRAID cabinet.
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3. Wait at least 30 seconds; then, restart the InterRAID cabinet and restart the system with
the DACCF diskette in the floppy disk drive.

4. At the command prompt, key in daccf.

5. When the DACCF Main Menu displays, select the Tools option.

6. Select the Backup/Restore Conf option, then select Restore Configuration.

7. Key in the filename for the configuration file.  Do not include directory paths.  If you
used a .CFG extension as part of the filename, include the extension.

WARNING Do not key in the filename used for the ASCII version of the RAID configuration file.
The ASCII version will overwrite the binary code for setting the registers, causing
damage to the RAID controller board.  The board must be replaced.

8. After restoring the configuration, exit DACCF and restart the system.

Common DACCF Procedures  
This section provides a set of common procedures used to configure the disk arrays.

Enabling Automatic Rebuild

The Array Encl MGMT I/F option allows you to hot swap disk drives and automatically
rebuild the replacement disk drive.  If Array Encl MGMT I/F is enabled, the RAID
controller detects the replacement drive and automatically begins the rebuild process.

Array Encl MGMT I/F is enabled by default, and must be enabled each time you change the
RAID configuration.  RAID configurations for additional disk arrays do not have Array Encl
MGMT I/F enabled by default.

To enable automatic rebuild:

1. Ensure the boot sequence for the system is A:, C:.

2. Insert the DACCF diskette into the floppy disk drive.

3. Restart the system.

4. At the command prompt, key in daccf.

5. If you have multiple RAID controller boards installed in the system, select the controller
to be configured.

6. When the DACCF Main Menu displays, select the Advanced Functions option.

7. Select the Hardware Parameters option.
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8. Toggle the Array Encl MGMT I/F option to Enable.

9. Press ESC twice to save the automatic rebuild setting.

10. Select Yes to save the configuration.

11. Exit DACCF, remove the diskette, and then restart the system.

Changing the Write Policy

Follow these steps to change the write policy of system drives.  

To change the write policy:

1. Ensure the boot sequence for the system is A:, C:.

2. Insert the DACCF diskette into the floppy disk drive.

3. Restart the system.

4. At the command prompt, key in daccf.

5. If you have multiple RAID controller boards installed in the system, select the controller
to be configured.

6. When the DACCF Main Menu displays, select the View/Update Configuration option.

7. Select the Define System Drive option; then, select the Toggle Write Policy option.

8. Use the cursor keys to select a system drive; then, toggle the write policy option to Write
Through or Write Back, as desired.

9. Press ESC twice to save the write policy setting.

10. Select Yes to save the configuration.

11. Exit DACCF, remove the diskette, and then restart the system.

Configuring Additional Disk Arrays

Additional disk arrays are not configured at the factory.  You can use the quick configuration
process outlined below to configure an additional disk array for RAID Level 5.

To configure for RAID Level 5:

1. If DACCF is already running, go to the DACCF Main Menu.  Skip to step 6.

2. Ensure the boot sequence for the system is A:, C:.

3. Insert the DACCF diskette into the floppy disk drive.

4. Restart the system.
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5. At the command prompt, key in daccf.

6. If you have multiple RAID controller boards installed in the system, select the controller
to be configured.

7. From the DACCF Main Menu, select the Automatic Configuration option (which
defaults to RAID Level 5).

8. If a WARNING window displays, you have selected a controller that has been previously
configured.  Select YES to overwrite the configuration, or select NO to discontinue.
You can use Select DAC960 of the DACCF Main Menu to select another controller, and
then re-select Automatic Configuration if desired.

9. Select YES to enable write-back cache, if desired.  The configuration displays.  Press
any key to continue.

10. Select the Initialize System Drive option of the DACCF Main Menu to initialize the
system drive.

11. When the system drive list displays, select Sys Drv 0 and press ENTER.

12. At the confirmation window, use the arrow key to select YES and press ENTER.

13. A status bar shows the progress of the initialization.  After initialization is complete,
press any key to continue.

14. From the DACCF Main Menu, select Advanced Functions, and then select Hardware
Parameters.

15. Toggle the Array Encl MGMT I/F option to Enabled.

16. Press ESC twice to save the setting.

17. Select Yes to save the configuration.

18. Exit DACCF, remove the diskette, and then restart the system.

19. Under Windows NT, run Disk Administrator.  Select YES to create a signature file.

20. Partition and format the disk space.  Use the Help command for specific instructions to
partition and format the drive.

Recovering Unusable (DED) Disk Drives  

If the InterRAID cabinet is powered down before the system, or if a power outage occurs, all
of the system drives may show up as unusable (DED) the next time you power on the system.
Should this occur, use the following procedures to make the drives online (ONL).

CAUTION Perform the following procedures only if all disk drives are marked DED by an incorrect
power down sequence, or if a power outage occurs.  If a particular drive is truly unusable,
replace it as described in Appendix B, “Troubleshooting.”
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To recover a DED disk drive:

1. Ensure the boot sequence for the system is A:, C:.

2. Insert the DACCF diskette into the floppy disk drive.

3. Restart the system.

4. At the command prompt, key in daccf.

5. If you have multiple RAID controller boards installed in the system, select the controller
to be configured.

6. When the DACCF Main Menu displays, select Tools.

NOTE You can restore each drive one at a time by selecting Make Online of the Tools menu.  If you
prefer to change all of the drives at once, proceed to step 10 and use the Backup/Restore
Conf option.

7. To restore each drive individually, select Make Online and press ENTER.

8. The cursor will display in the drive matrix area.  Use the arrow keys to select the dead
drive and press ENTER.

9. Select YES in the confirmation window.

10. Repeat steps 6 through 8 for each drive marked DED.  Then, proceed to step 13.

11. To backup or restore all drives at once, select the Backup/Restore Conf option of the
Tools menu.  Press ENTER to confirm the warning message.

12. Key in the filename for the configuration file.  Do not include directory paths.  If you
used a .CFG extension as part of the filename, include the extension.

WARNING Do not key in the filename used for the ASCII version of the RAID configuration file.
The ASCII version will overwrite the binary code for setting the registers, causing
damage to the RAID controller board.  The board must be replaced.

The following message displays:

Do you really want to Restore Configuration?

CAUTION The restored configuration file must match the hardware configuration.  DACCF assumes the
number of physical drives installed in the InterRAID cabinet is the same as the number of
drives configured in the configuration file.

13. Select YES and then press ENTER.  The configuration is read from the file and saved on
the RAID controller board.
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14. Press ESC to exit the Tools menu.

15. Press ESC to exit DACCF, and then select YES at the confirmation window.

16. Remove the DACCF diskette and restart the system.
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6 Using MegaRAID BIOS  

This chapter pertains only to systems containing the MegaRAID controller.  If your system
contains either the DAC960P or DAC960PD controller, refer to Chapter 5.

NOTE Chapter 1 describes how to determine which controller was shipped with your system.

This chapter describes how to upgrade the MegaRAID driver and use the MegaRAID BIOS
Configuration Utility to configure disk arrays and logical drives.  Since the utility resides in
the MegaRAID BIOS, its operation is independent of the operating system on your system
base unit.  Intergraph includes MegaRAID BIOS on a diskette delivered with the InterRAID
cabinets.

The topics in this chapter also include the following:

u Startup Sequence

u Management Menu Options

u Exiting Setup

u Setup menu tree

u Configuring arrays and logical drives

u Rebuilding failed disk drives

u Using a pre-loaded SCSI drive “as-is”

NOTE If you need to load the new driver, follow the applicable instructions in the following section
for Windows NT 3.51 or Windows NT 4.00.  The MegaRAID driver resides on the same
diskette containing the MegaRAID Power Console Utility.

Updating the MegaRAID Driver  
The MegaRAID driver provides an interface for administering the InterRAID disk array
products.  After configuring the Windows NT operating system, you must install the updated
Intergraph MegaRAID driver.  An icon will be automatically created in the Power Console
program group.

To install the updated MegaRAID driver for use with Windows NT 3.51:

1. Boot the system and log in as administrator.

2. At Program Manager, open Windows NT Setup.
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3. From the Options menu, select Add/Remove SCSI Adapters.

4. Select the MegaRAID driver; then, select Remove.

5. Select OK at the Warning dialog; then, select OK again.

6. At the Warning dialog, select Add; then, select OK.  Windows NT Setup displays a list
of adapters.

7. Scroll to OTHER (Requires disk from a hardware manufacturer).

8. Insert the diskette containing MegaRAID NT driver into the floppy disk drive, and
select OK.  The Select OEM Option dialog displays with the MegaRAID adapter
highlighted.

9. Select OK.  Setup displays the Select SCSI Adapter Option dialog.

10. Select Install.  Setup displays a message that the driver is already present on the system.

11. Select New; then, select Continue at the prompt to specify the path to the adapter files.

12. At the SCSI Adapter Menu, select Close.

13. From the Options menu, select Exit.

14. Reboot the system.

To install the updated MegaRAID driver for use with Windows NT 4.00:

1. Boot the system and log in as administrator.

2. Open Control Panel.

3. Select SCSI Adapters icon.

4. Click the Drivers tab.

5. Select the MegaRAID driver.

6. Click Remove to remove the old driver.

7. Click the Drivers tab again.

8. Click Add.

9. Click Have Disk.

10. Follow the instruction on the screen to install the updated driver.  This will create a
MegaRAID Program Group and a MegaRAID Power Console Program item.

11. Remove the diskette containing the MegaRAID driver from the disk drive.

12. Reboot the system.
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Startup Sequence
When the system boots, press CTRL+M when the following appears:

MEGARAID CONTROLLER  BIOS Version x.xx Aug 1, 1996
Host Adapter-1 Firmware Version x.xx DRAM Size 8 MB
0 Logical Drives found on the Host Adapter
0 Logical Drives handled by BIOS
Press <Ctrl><M> to run MegaRAID BIOS Configuration Utility

NOTE If you do not press CTRL+M within a few seconds of the prompt, the system continues the
normal boot procedure.

For each MegaRAID controller in the system, the firmware version, DRAM size, and the
status of logical drives on that controller displays.  When you press CTRL+M, the following
Management Menu displays:

--------------  Management Menu  ----------------
Configure
Initialize
Objects
Format
Rebuild
Check Consistency
Select Adapter
Disable BIOS

Management Menu Options
The Management main menu options are as follows:

Option Description

Configure Configures physical arrays and logical drives

Initialize Initializes one or more logical drives

Objects Individually accesses controllers, logical drives, and physical drives

Format Low-level formats a hard disk drive

Rebuild Rebuilds a failed disk drive

Check
Consistency

Verifies that the redundancy data is correct in logical drives using
RAID level 1, 3, or 5

Select Adapter Selects a MegaRAID host adapter (controller)

Disable BIOS Disables the BIOS
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Exiting MegaRAID BIOS Configuration Utility
To exit the MegaRAID BIOS configuration utility, press ESC while the Management menu is
displayed.  Choose Yes at the prompt.  You must then reboot the system.  The MegaRAID
BIOS message displays again.  Press ESC when the BIOS Configuration Utility prompt
displays.

Management Menu Tree
The following is an expansion of the Management menu options.  The menu items are
explained on the following pages.

CONFIGURE -- Easy Configuration
New Configuration
View/Add Configuration
Clear Configuration

INITIALIZE --
OBJECTS -- Adapter -- Clear Configuration

FlexRAID PowerFail
Flexible (Dynamic) Sizing
Disk Spin-up Timings
Chip Set Type
Cache Flush Timings
Rebuild Rate
Alarm Control
Ultra SCSI
Auto Rebuild

Logical Drive -- Initialize
Check Consistency
View/Update Parameters

Physical Drive -- Rebuild
Format
Make Online
Fail Drive
Make Hotspare
View Drive Information
Synchronous Negotiation
SCSI-2 Command Tagging

SCSI Channel -- Terminate High 8 Bits
Terminate Wide Channel
Disable Termination
Set PowerOn Defaults

FORMAT --
REBUILD --
CHECK CONSISTENCY --
SELECT ADAPTER --
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Configure Menu  

Choose the Configure option from the ManagementSetup main menu to select a method for
configuring arrays and logical drives.

Option Description

Easy
Configuration

Select this option to perform a basic logical drive configuration where
every physical array you define is automatically associated with exactly
one logical drive.

New
Configuration

Select this option to discard the existing configuration information and to
configure new arrays and logical drives.  In addition to providing the
basic logical drive configuration functions, New Configuration allows you
to associate logical drives with multiple or partial arrays.

View/Add
Configuration

Select this option to examine the existing configuration and/or to specify
additional arrays and logical drives. View/Add Configuration provides the
same functions available in New Configuration.

Clear
Configuration

Select this option to erase the current configuration information from the
MegaRAID controller non-volatile memory.

Initialize Menu  

Choose Initialize from the Management menu to initialize one or more logical drives.
Initializing typically follows configuring a new logical drive.

WARNING Initializing a logical drive destroys all data on the logical drive.

Objects Menu  

Choose Objects from the Management menu to access the controllers (adapters), logical
drives, physical drives, and SCSI channels individually.  You can also change certain
settings for each object.  The Objects menu options are described below.

Adapter
Logical Drive
Physical Drive
SCSI Channel

Objects

Ensure the following important default settings of the Objects menu:
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u Under Objects/Adapter/Chip Set Type, ensure Others is selected.

u Under Objects/Adapter/Alarm Control, ensure Disable is selected.

u Under Objects/Adapter/Spinup Timings/Spinup Parameters, set to two drives every six
seconds.

u Under Objects/Adapter/Ultra SCSI, set to Disabled.

Adapter

If your system has more than one MegaRAID controller, choose the Adapter option from the
Objects menu to select a MegaRAID controller and to modify the parameters.

The following displays:

--------------  Adapter x  ----------------
Clear Configuration
FlexRAID PowerFail = DISABLED
Flexible Dynamic Sizing
Disk Spin-up Timings
Chip Set Type
Cache Flush Timings
Rebuild Rate
Alarm Control
Ultra SCSI = DISABLED
Auto Rebuild = ENABLED

The following table describes the Adapter menu options.

Option Description

Clear
Configuration

Choose this option to erase the current configuration from the controller
non-volatile memory.

FlexRAID
PowerFail

Choose this option if you have battery backup installed.

Flexible
Dynamic
Sizing

Choose this option if you plan on adding disk drives to the array and want
to use the extra space without rebooting.  Default is disabled.

Disk Spin-up
Timings

Choose this option to set the method and timing for spinning up the hard
disk drives in the system.  Default is 2 every 6 seconds.

Chip Set Type Choose this option to program the MegaRAID controller for a specific
motherboard chip set type, such as Intel Neptune, Intel Saturn, or other
chip set.  Default is other.

Cache Flush
Timings

Choose this option to set the cache flush interval to once every 2, 4, 6, 8,
or 10 seconds.  Default is 2.
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Option Description

Rebuild Rate Choose this option to change the rebuild rate for the controller.  You can
also display the firmware version number.

Alarm Control Choose this option to enable, disable, or silence the onboard alarm tone
generator.  Default is disable.

Ultra SCSI Choose this option to enable or disable Ultra SCSI.  Default is disabled.

Auto Rebuild  Choose this option to enable automatic rebuild.  Default is enabled.

Logical Drive

Choose the Logical Drive option from the Objects menu to select a logical drive and to
perform the listed actions.

The following table describes the Logical Drives options.

Option Description

Initialize Choose this option to initialize the selected logical drive. This should be
done for every logical drive you configure.

Check
Consistency

Choose this option to verify the correctness of the redundancy data in the
selected logical drive.  This option is only available if RAID level 1, 3, or
5 is used.

View/Update
Parameters

Choose this option to display the properties of the selected logical drive;
you can modify the cache write policy, the read policy, and the I/O policy
from this menu.
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The following table defines some terms you will see while configuring drives and running
the MegaRAID BIOS configuration utility.

READY Disk drive ready for configuration

ONLINE Disk drive ready for use

REBUILD Disk drive to be replaced

OFFLINE Unformatted drive

PACK Configured pack

DRIVES Number of drives in a pack

SIZE Size of the packs (in megabytes)

HOTSP Disk drive configured as hot spare (standby) drive

Physical Drive

Choose the Physical Drive option from the Objects menu to select a physical device and to
perform the operations listed in the table below.  The physical hard disk drives in the system
are listed.  Move the cursor to the desired device and press ENTER to display the following:

The following table describes the Physical Drive options.

Option Description

Rebuild Choose this option to rebuild the selected disk drive.

Format Choose this option to low-level format the selected disk drive.

Make Online Choose this option to change the state of the selected disk drive to Online.

Fail Drive Choose this option to change the state of the selected disk drive to Fail.

Make HotSpare Choose this option to designate the selected disk drive as a hot spare.

View Drive
Information

Choose this option to display the manufacturer data for the selected
physical device.
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Option Description

Synchronous
Negotiation

Choose this option to enable or disable synchronous negotiation for the
selected physical device.  The default is Enabled.

SCSI-2
Command
Tagging

Choose this option to set the number of queue tags per command to 2, 3,
or 4, or to disable command tagging. The default setting is 4 queue tags.

SCSI Channel

Choose the SCSI Channel option from the Objects menu to select a SCSI channel on the
currently selected controller.

The following table describes the SCSI Channel options.

Option Description

Terminate
High 8 Bits

Choose this option to enable termination on the selected channel for the
upper eight bits and disable termination on the controller for the lower
eight bits. This setting is required if the selected SCSI channel is
terminated with 8-bit devices at both ends.

Terminate
Wide Channel

Choose this option to enable wide channel termination for the selected
channel.  This is required if the MegaRAID controller is at one end of the
SCSI bus for the selected channel.

Disable
Termination

Choose this option to disable termination on the MegaRAID controller for
the selected channel.  This option should be used if the selected SCSI
channel is terminated with Wide devices at both ends.

Set PowerOn
Defaults

Choose this option to have the MegaRAID controller examine its SCSI
channels and to set its termination automatically.

Format Menu  

Choose Format from the Management menu to low-level format one or more physical drives.

WARNING Formatting a hard drive destroys all data on the drive.
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Since most SCSI disk drives are low-level formatted at the factory, this step is usually not
necessary.  You must format a disk only if one of the following applies:

u The disk drive was not low-level formatted at the factory

u There are an excessive number of media errors detected on the disk drive

You do not need to use the Format option to erase existing information on your SCSI disks,
such as a DOS partition.  That information is erased when you initialize the logical drive(s).

Rebuild Menu  

Choose Rebuild from the Management menu to rebuild one or more failed disk drives.

Check Consistency Menu  

Choose this option from the Management menu to verify the redundancy data in logical
drives using RAID levels 1, 3, or 5.

When you choose Check Consistency, the parameters of the existing logical drives on the
current controller and a selection menu listing the logical drives by number appear.

Press the arrow keys to highlight the desired logical drives.  Press the spacebar to select or
deselect a drive for consistency checking.  Press F2 to select or deselect all the logical drives.

Press F10 to begin the consistency check.  A progress indicator for each selected logical drive
displays.
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When the consistency check is finished, press any key to clear the progress display and press
ESC to return to the main menu.

Select Adapter Menu  

This menu item displays only if more than one MegaRAID controller is installed in the
system.  The following displays when you choose the Select Adapter option from the
Management menu:

Select the MegaRAID adapter that you want to configure from the above menu.

Disable BIOS Menu  

Choose Diable BIOS from the Management menu.  This menu item allows you to enable or
disable BIOS.  If you select yes to disable BIOS, the menu item changes to Enable.

Configuring Arrays and Logical Drives
You can configure physical arrays and logical drives with Setup using the following options:

u Easy Configuration

u New Configuration

u View/Add Configuration

Each configuration method requires a different level of user input.  The general flow of
operations for array and logical drive configuration is as follows:

1. Choose a configuration method.

2. Designate hot spares (optional).

3. Create arrays using the available physical drives.

4. Define logical drives using the space in the arrays.

5. Save the configuration information.
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6. Initialize the new logical drives.

Choosing the Configuration Method

Easy Configuration

In Easy Configuration, each physical array you create is associated with exactly one logical
drive, and you can modify the following parameters:

u RAID level

u Stripe size

u Cache write policy

u Read policy

u I/O policy

If there are already logical drives configured when you select Easy Configuration, their
configuration information is not disturbed.  You can define a maximum of eight (8) logical
drives per MegaRAID controller.

New Configuration

In New Configuration, you can modify the following logical drive parameters:

u RAID level

u Cache write policy

u Read policy

u I/O policy

u Logical drive size

u Spanning of arrays

u Flexible Dynamic Sizing

If you select New Configuration, the existing configuration information on the selected
controller is destroyed when the new configuration is saved.

View/Add Configuration

View/Add Configuration allows you to control the same logical drive parameters as New
Configuration without disturbing the existing configuration information.
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Designating Drives as Hot Spares

Hot spares are physical drives that are powered up with the RAID drives, and usually stay in
a standby state.  If a disk drive used in a RAID logical drive fails, a hot spare will
automatically take its place and the data on the failed drive is reconstructed on the hot spare.
Hot spares can be used for level 1, 3 and 5 RAID.  Each MegaRAID controller supports up to
eight hot spares.  There are two methods for designating physical drives as hot spares:

u Press F4 while creating arrays in Easy, New or View/Add Configuration mode.

u From the Objects/Physical Drive menu, select a physical drive and press ENTER.  Then,
select Make HotSpare.

When you choose any configuration option, a list of all physical devices connected to the
current controller displays, as shown below:

Press the arrow keys to highlight a disk drive that has a READY indicator and press F4 to
designate the drive as a hot spare.  The indicator changes to HOTSP.  The second method for
designating physical drives as hot spares is to select Objects from the Management menu,
and then select Physical Drive.  A physical drive selection screen will appear.  Select a disk
drive and press ENTER to display the action menu for the drive.
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Press the arrow keys to select Make HotSpare and press ENTER.  The indicator for the
selected drive changes to HOTSP.

Using Easy Configuration

In Easy Configuration, each array is associated with exactly one logical drive.  Follow the
steps below to create arrays using Easy Configuration.  You can define a maximum of eight
(8) logical drives per MegaRAID controller.

To use Easy Configuration:

1. Choose Configure from the Management menu.

2. Choose Easy Configuration from the Configure menu.  The array selection menu
displays:

 

Hot key information displays at the bottom of the screen.  The hot key functions are as
follows:

F2 Display the manufacturer data and error count for the highlighted drive.

F3 Display the logical drives that have been configured so far.

F4 Designate the highlighted drive as a hot spare.

3. Press the arrow keys to highlight specific physical drives.  Press the spacebar to
associate the highlighted physical drive with the current array.  The indicator for the
selected drive changes from READY to ONLIN A[array number]-[drive number].  For
example, ONLIN A2-3 means disk array 2, drive 3.

 Add physical drives to the current array as desired.  Try to use drives of the same
capacity in a specific array.  If you use drives with different capacities in an array, all
drives in the array are treated as if they have the capacity of the smallest drive in the
array.
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 The number of physical drives in a specific array determines the RAID levels that can be
implemented with the array.

 RAID 0 requires one or more physical drives per array.

 RAID 1 requires two to eight physical drives per array.

 RAID 3 requires at least three physical drives per array.

 RAID 5 requires at least three physical drives per array.

4. Press ENTER when you are finished creating the current array.  The logical drive
configuration screen displays.

The window at the top of the screen shows the logical drive that is currently being
configured as well as any existing logical drives.  The column headings are as follows:

LD The logical drive number

RAID The RAID level

Size The logical drive size

#Stripes The number of stripes (physical drives) in the
associated physical array

StrpSz The stripe size

Drive-State The state of the logical drive

5. Set the RAID level for the logical drive.  Highlight RAID and press ENTER.  The
available RAID levels for the current logical drive are displayed.  Select a RAID level
and press ENTER to confirm.

 Do not use RAID 3 for any logical drive that is to be used as a DOS volume.

6. Set the stripe size when this feature becomes available.  Set cache write policy, read
policy, and I/O (cache) policy from the Advanced Menu from the bottom window of the
logical drive configuration screen.
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The Advanced menu options are as follows:

Option Description

Stripe Size This option sets the stripe size from 2 KB to 128 KB.

Write Policy This option sets the caching method to write-back or write-through.  In
Write-back caching, the controller sends a data transfer completion
signal to the host when the controller cache has received all the data in
a transaction.

In Write-through caching , the controller sends a data transfer
completion signal to the host when the disk subsystem has received all
the data in a transaction.  This is the default setting.

Write-through caching has a data security advantage over write-back
caching.  Write-back caching has a performance advantage over write-
through caching.

Read Policy This option enables the SCSI read-ahead feature for the logical drive.
You can set this parameter to Normal, Read-ahead, or Adaptive.

Normal specifies that the controller does not use read-ahead for the
current logical drive.

Read-ahead specifies that the controller uses read-ahead for the current
logical drive.  This is the default setting.

Adaptive specifies that the controller begins using read-ahead if the
two most recent disk accesses occurred in sequential sectors.

Cache Policy This parameter enables the controller cache during data transfers
involving the selected logical drive.

Cached I/O specifies that the controller cache is used.  This is the
default setting.

Direct I/O specifies that the controller cache is not used.

7. After setting the options, press ESC to exit the Advanced Menu.

8. When you finish defining the current logical drive, highlight Accept from the bottom
window of the logical drive configuration screen, and press ENTER.  The array selection
screen displays if there are any unconfigured disk drives left.
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9. Repeat steps 3 through 8 to configure another array and logical drive.  MegaRAID
supports up to eight logical drives per controller.  If you are finished configuring logical
drives, press ESC to exit Easy Configuration.  A list of the currently configured logical
drives displays:

After you respond to the Save prompt, you will return to the Configure menu.

10. Initialize the logical drives you have just configured as discussed later in this chapter.

Using New Configuration

The New Configuration option allows you to associate logical drives with partial and/or
multiple physical arrays (the latter is called spanning of arrays).

Choosing the New Configuration option erases the existing configuration information on the
selected controller.

To use the spanning feature and keep the existing configuration, use View/Add
Configuration.

To use New Configuration:

1. Choose Configure from the Management menu.

2. Choose New Configuration from the Configure menu.  An array selection window
shows the devices connected to the current controller.
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Hot key information appears at the bottom of the screen.  The hot key functions are as
follows:

F2 Display the manufacturer data and MegaRAID error count for the highlighted
drive.

F3 Display the logical drives that have been configured.

F4 Designate the highlighted drive as a hot spare .

F10 Display the logical drive configuration screen.

3. Press the arrow keys to highlight specific physical drives.  Press the spacebar to
associate the highlighted physical drive with the current array.  The indicator for the
selected drive changes from READY to ONLIN A[array number]-[drive number].  For
example, ONLIN A2-3 means disk array 2, drive 3.

 Add physical drives to the current array as desired.  Try to use drives of the same
capacity in a specific array.  If you use drives with different capacities in an array, all the
drives in the array is treated as if they have the capacity of the smallest drive in the
array.

 The number of physical drives in a specific array determines the RAID levels that can be
implemented with the array.

 RAID 0 requires one or more physical drives per array.

 RAID 1 requires two to eight physical drives per array.

 RAID 3 requires at least three physical drives per array.

 RAID 5 requires at least three physical drives per array.

4. Press ENTER when you finish creating the current array.  To continue defining arrays,
repeat step 3.  To begin logical drive configuration, go to step 5.

5. Press F10 to configure logical drives.  The logical drive configuration screen displays as
shown below:
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The window at the top of the screen shows the logical drive that is currently being
configured as well as any existing logical drives.  The column headings are as follows:

LD The logical drive number

RAID The RAID level

Size The logical drive size

#Stripes The number of stripes (physical drives) in the associated physical array

StrpSz The stripe size

Drive-State The state of the logical drive

6. Set the RAID level for the logical drive.  Highlight RAID and press ENTER.  A list of the
available RAID levels for the current logical drive displays.  Select a RAID level and
press ENTER to confirm.

 Do not use RAID 3 for any logical drive to be used as a DOS volume.

7. Set the spanning mode for the current logical drive.  Highlight Span from the bottom
window of the logical drive configuration screen, and press ENTER.  The choices are as
follows:

CanSpan  Array spanning is enabled for the current logical drive.  The logical drive can
occupy space in more than one array.

NoSpan  Array spanning is disabled for the current logical drive.  The logical drive can
occupy space in only one array.

For two arrays to be spannable, they must have the same stripe width (they must contain
the same number of physical drives) and must be consecutively numbered.  If Array 2
contains four disk drives, it can be spanned only with Array 1 and/or Array 3, and only
if Arrays 1 and 3 also contain four disk drives.  If the two criteria for spanning are met,
MegaRAID automatically allows spanning.  If the criteria are not met, the Span setting
makes no difference for the current logical drive.  Highlight a spanning option and press
ENTER.
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The spanning options are:

Configuring RAID 10, RAID 30, or RAID 50 Logical Drives.

Configure RAID 10 by spanning two to eight contiguous RAID 1 logical drives.  The
RAID 1 logical drives must have the same stripe size.  For example, you can use the
span option to configure up to four pairs of RAID 1 drives.  Up to eight drives will
appear as one large RAID 1 logical drive.

Configure RAID 30 by spanning two contiguous RAID 3 logical drives.  The RAID 3
logical drives must have the same stripe size.

Configure RAID 50 by spanning two contiguous RAID 5 logical drives.  The RAID 5
logical drives must have the same stripe size.

8. Set the logical drive size.  Move the cursor to Size from the bottom of the logical drive
configuration screen, and press ENTER.

 By default, the logical drive size is set to all available space in the array(s) being
associated with the current logical drive, thus accounting for the Span setting and for
partially used array space.  For example, if the previous logical drive used only a part of
the space in an array, the current logical drive size is set to the remaining space by
default.

9. Select Advanced from the bottom window of the logical drive configuration screen to set
the remaining options.

NOTE For a description of the options, refer to the table in “Using Easy Configuration.”

10. After setting the options, press ESC to exit the Advanced Menu.

11. When you finish defining the current logical drive, highlight Accept and press ENTER.
If there is space remaining in the arrays, the next logical drive to be configured displays.

12. To configure another logical drive, repeat steps 6 through 9.  If the array space has been
used up, a list of the existing logical drives displays.  Press any key to continue and
respond to the Save prompt.

13. Initialize the logical drives you have just configured as discussed later in this chapter.
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Using View/Add Configuration

View/Add Configuration allows you to associate logical drives with partial and/or multiple
physical arrays (this is called spanning of arrays).

The existing configuration is left intact, so you can also use View/Add Configuration simply
to look at the current configuration.

To use view/add configuration:

1. Choose Configure from the Management menu.

2. Choose View/Add Configuration from the Configure menu.  An array selection window
displays showing the devices connected to the current controller.

Hot key information appears at the bottom of the screen.  The hot key functions are as
follows:

F2 Display the manufacturer data and MegaRAID error count for the highlighted
drive.

F3 Display the logical drives that have been configured

F4 Designate the highlighted dri ve as a hot spare.

F10 Display the logical drive configuration screen.

3. Press the arrow keys to highlight specific physical drives.  Press the spacebar to
associate the highlighted physical drive with the current array.  The indicator for the
selected drive changes from READY to ONLIN A[array number]-[drive number].  For
example, ONLIN A2-3 means disk array 2, drive 3.

 Add physical drives to the current array as desired.  Try to use drives of the same
capacity in a specific array.  If you use drives with different capacities in an array, all the
drives in the array is treated as if they have the capacity of the smallest drive in the
array.
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 The number of physical drives in a specific array determines the RAID levels that can be
implemented with the array.

 RAID 0 requires one or more physical drives per array.

 RAID 1 requires two to eight physical drives per array.

 RAID 3 requires at least three physical drives per array.

 RAID 5 requires at least three physical drives per array.

4. Press ENTER when you finish creating the current array.  To continue defining arrays,
repeat step 3.  To begin logical drive configuration, go to step 5.

5. Press F10 to configure logical drives.  The logical drive configuration screen displays, as
shown below:

The window at the top of the screen shows the logical drive that is currently being
configured as well as any existing logical drives.  The column headings are as follows:

LD The logical drive number

RAID The RAID level

Size The logical drive size

#Stripes The number of stripes (physical drives) in the associated physical array

StrpSz The stripe size

Drive-State The state of the logical drive

6. Set the RAID level for the logical drive.  Highlight RAID and press ENTER.  A list of the
available RAID levels for the current logical drive displays.  Select a RAID level and
press ENTER to confirm.

 Do not use RAID 3 for any logical drive to be used as a DOS volume.
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7. Set the spanning mode for the current logical drive.  Highlight Span from the bottom
window of the logica drive configuration screen and press ENTER.  The choices are:

 CanSpan  Array spanning is enabled for the current logical drive.  The logical drive can
occupy space in more than one array.

 NoSpan  Array spanning is disabled for the current logical drive.  The logical drive can
occupy space in only one array.

 For two arrays to be spannable, they must have the same stripe width (they must contain
the same number of physical drives) and they must be consecutively numbered.  If Array
2 contains four disk drives, it can be spanned only with Array 1 and/or Array 3, and
only if Arrays 1 and 3 also contain four disk drives.  If the two criteria for spanning are
met, MegaRAID automatically allows spanning.

 If the criteria are not met, the Span setting makes no difference for the current logical
drive.  Highlight a spanning option and press ENTER.

 The spanning options are:

 Configuring RAID 10, RAID 30, or RAID 50 Logical Drives.

 Configure RAID 10 by spanning two to eight contiguous RAID 1 logical drives.  The
RAID 1 logical drives must have the same stripe size.

 Configure RAID 30 by spanning two contiguous RAID 3 logical drives.  The RAID 3
logical drives must have the same stripe size.

 Configure RAID 50 by spanning two contiguous RAID 5 logical drives.  The RAID 5
logical drives must have the same stripe size.

8. Set the logical drive size.  Move the cursor to Size from the bottom window of the
logical drive configuration screen and press ENTER.  By default, the logical drive size is
set to all available space in the array(s) being associated with the current logical drive,
thus accounting for the Span setting and for partially used array space.  For example, if
the previous logical drive used only a part of the space in an array, the current logical
drive size is set to the remaining space by default.

9. Select Advanced from the bottom window of the logical drive configuration screen to set
the remaining options.

NOTE For a description of the options, refer to the table in “Using Easy Configuration.”

10. After setting the options, press ESC to exit the Advanced Menu.
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11. When you finish defining the current logical drive, highlight Accept from the bottom
window of the logical drive configuration screen, and press ENTER.  If there is space
remaining in the arrays, the next logical drive ready to be configured displays.

12. To configure another logical drive, repeat steps 6 through 9.  If the array space has been
used up, a list of the existing logical drives displays.  Press any key to continue and
respond to the Save prompt.

13. Initialize the logical drives you have just configured as discussed later in this chapter.

Initializing Logical Drives

You should initialize each new logical drive you configure.  You can initialize the logical
drives in two ways:

u Batch Initialization

u Individual Initialization

To use batch initialization:

1. Choose Initialize from the Management menu.  A list of the current logical drives
displays, as shown below:

 

2. Press the arrow keys to highlight all drives.  Press the spacebar to select the highlighted
logical drive for initialization.  Press F2 to select or deselect all logical drives.

3. When you finish selecting logical drives, press F10 and choose Yes at the confirmation
prompt.  The progress of the initialization for each drive is shown in bar graph format.

 

4. When initialization is complete, press any key to continue.  Press ESC to return to the
main menu.
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To use individual initialization:

1. Choose the Objects option from the Management menu.  Choose the Logical Drive
option from the Objects menu.  The following displays.

 

2. Select the logical drive to be initialized.  The following menu displays:

 

3. Choose the Initialize option from the action menu.  The progress of the initialization
displays as a bar graph on the screen.

4. When initialization completes, press any key to return to the previous menu.

Formatting Physical Drives

Choose the Format option from the Management menu to low-level format one or more
physical drives.  A physical drive can be formatted if it is not part of a configuration and is
in a Ready state.  Since most SCSI drives are factory formatted, do this step only if the drive
has an excessive number of media errors.

You can format the physical drives in two ways:

u Batch Formatting

u Individual Formatting
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To use batch formatting:

1. Choose Format from the Management menu.  A device selection window displays as
shown below, showing the devices connected to the current controller:

 

2. Press the arrow keys to highlight all drives.  Press the spacebar to select the highlighted
physical drive for formatting.  The indicators for selected drives flashes.

3. When you are finished selecting physical drives, press F10 and choose Yes at the
confirmation prompt.  The indicators for the selected drives changes to FRMT[number],
where [number] reflects the order of drive selection.  Formatting may take some time,
depending on the number of drives you have selected and the drive capacities.

4. When formatting is complete, press any key to continue.  Press ESC to return to the main
menu.

To use individual formatting:

1. Choose Objects from the Management menu.  Choose the Physical Drive option from
the Objects menu.  A device selection window displays showing the devices connected to
the current controller:
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2. Press the arrow keys to highlight the physical drive to be formatted and press ENTER.
The following action menu displays:

 

3. Choose the Format option from the action menu and respond to the confirmation
prompt.  Formatting can take some time, depending on the drive capacity.

4. When formatting completes, press any key to return to the previous menu.

Rebuilding Failed Disk Drives  
If a disk drive fails in an array that is configured as a RAID 1, 3, or 5 logical drive, you can
reconstruct the data on the failed drive by rebuilding the drive.

The rebuild types are as follows:

Type Description

Automatic
Rebuild

MegaRAID automatically tries to use hot spares to rebuild failed disk
drives.  Display the Objects menu, Physical Drive option screen while a
rebuild is in progress.  The drive indicator for the hot spare disk drive
changes to REBLD A[array number]-[drive number], indicating the disk
drive to be replaced.

Manual
Rebuild

Manual rebuild is necessary if there are no hot spares with enough
capacity to rebuild the failed drives.  Select the Management menu
Rebuild option or the Rebuild option from Objects menu, Physical Drive.

To rebuild an individual drive using manual rebuild:

1. Choose Objects from the Management menu.  Choose Physical Drive from the Objects
menu.  A device selection window displays showing the devices connected to the current
controller:
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2. Press the arrow keys to highlight the physical drive to be rebuilt and press ENTER.  The
following action menu displays:

 

3. Choose the Rebuild option from the action menu and respond to the confirmation
prompt.  Rebuilding can take some time, depending on the drive capacity.

4. When rebuild completes, press any key to return to the previous menu.

To use batch mode for manual rebuild:

1. Choose Rebuild from the Management menu.  A device selection window is displayed
showing the devices connected to the current controller.  The failed drives have FAIL
indicators.

2. Press the arrow keys to highlight all drives to be rebuilt.  Press the spacebar to select the
highlighted physical drive for rebuild.

3. After selecting the physical drives, press F10 and select Yes at the confirmation prompt.
The indicators for the selected drives changes to REBLD.  Rebuilding can take some
time, depending on the number of drives you have selected and the drive capacities.

4. When rebuild is complete, press any key to continue.  Press ESC to return to the main
menu.
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Using a Pre-loaded SCSI Drive “As-is”
CAUTION To use a pre-loaded drive in the manner described here, you must make it the first logical

drive defined (for example:  LD1) on the controller to which it is connected.

You may have a SCSI disk drive that is already loaded with software.  The drive may be a
boot disk containing an operating system.  You can use the MegaRAID controller as a SCSI
adapter for such a drive by performing the following steps.

To use a pre-loaded SCSI drive:

1. Connect the SCSI drive to one of the channels on the MegaRAID controller, with proper
termination and target ID settings.

2. Boot the system and start Setup by pressing CTRL+M.

3. Choose Easy Configuration from the Configure menu.

4. Press the cursor keys to highlight the pre-loaded drive.

5. Press the spacebar.  The pre-loaded drive should now become an array element.

6. Press ENTER.  You have now declared the pre-loaded drive as a one-disk array.  Display
the logical drive configuration screen.

7. Set the read policy and cache option on the Advanced menu.

8. Exit the Advanced menu.  Highlight Accept and press ENTER.

9. Press ESC and choose Yes at the Save prompt.

10. Exit Setup and reboot.

Set the host system to boot from SCSI, if such a setting is available.
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7 Using Power Console

This chapter pertains only to systems containing the MegaRAID controller.  If your system
contains the DAC960P or DAC960PD controller, refer to Chapter 5.

NOTE Chapter 1 describes how to determine which controller was shipped with your system.

This chapter describes how to install and use the MegaRAID Power Console.  Power Console
is an object-oriented graphics user’s interface (GUI) utility that configures and monitors
RAID systems locally or over a network with several servers.

NOTE If you need to reload Power Console, follow the applicable instructions in Chapter 6.

Installing the MegaRAID Power Console Utility  
Intergraph installs the MegaRAID Power Console utility on your system before shipment.
However, if you need to re-install it, the MegaRAID Power Console utility is easy to install
and use in the Windows NT environment.  An icon will be automatically created in the
Power Console program group.

To install the Power Console utility for use with Windows NT 3.51 or 4.00:

1. Boot the system and log in as administrator.

2. Insert the diskette containing the MegaRAID Power Console utility into the floppy disk
drive.

3. For Windows NT 3.51, at the A: command prompt, key in the following:

setup

For Windows NT 4.00, select Start.  Then, select Run.

4. Respond yes or no appropriately to the questions about Windows NT.  At the Welcome
dialog, select Next.  The destination path dialog displays.

NOTE The files are copied into the displayed default directory or a specified directory you designate
after selecting Browse.

5. To copy the files to the displayed destination directory, select Next.  Otherwise, select
Browse and type a new directory path.  Setup also displays a message that the driver is
already present on the system.
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6. Remove the diskette containing the MegaRAID Power Console utility from the disk
drive.

7. Reboot the system.

8. To run Power Console, select the Power Console icon.

Overview
Power Console allows you to control and monitor the status of hard disk drives and RAID
enclosure and to store information in the Windows NT Event Viewer.  Power Console
executes from any workstation and runs under Microsoft Windows NT.  The topics discussed
in this chapter include:

u Power Console icons

u Logical and Channel icons

u Defining Power Console menu options

u Adapter menu

u Physical Drv menu

u Logical Drv menu

u Logical Drive menu

u Removing a drive

u Designating drives as hot spares

u Securing Power Console

u Saving configuration to floppy

You can set up the logical drives as discussed in Chapter 6 using the MegaRAID BIOS
Configuration utility.  If you have more than one MegaRAID controller in a host system, be
sure to configure at least one logical drive on every MegaRAID controller in the host system
before you access the controllers from Power Console.

The number assigned to the controller changes according to the number of installed
controllers.  Power Console lists the controllers starting at the controller in the lowest PCI
slot to the controller in PCI slot 7, counting them incrementally from 0 to 3.  More details on
this is provided under “Defining Power Console Menu Options” in this chapter.

Double-click on the Power Console icon from the MegaRAID program group on the
Windows screen.  The following dialog displays:
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Power Console Icons
Power Console includes several toolbox buttons at the right side of the main dialog.  These
buttons provide easy access to Power Console features.  You can remove the toolbox from the
dialog by clicking on Hide Toolbox in the Adapter menu.  The buttons are described below.

Configuration Icons

Display configuration; click on this icon to display the current RAID
system configuration.  For example:
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Print; click on this icon to make a hardcopy of the current
configuration.

Auto configuration; click on this icon to allow MegaRAID to
configure the RAID subsystem.

Custom configuration; click on this icon to allow you to configure the
RAID subsystem.

Reset; click on this icon to clear the RAID configuration on the
currently selected controller.  A confirmation dialog will appear:

Click on OK in the confirmation dialog when it appears to reset the configuration.

Display log; click here to display a list of MegaRAID activities.

Rebuild rate; click on this icon to set the RAID rebuild drive rate.
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Rescan; when you click on this icon, the currently selected
MegaRAID controller rescans its SCSI channels to make sure that all drive configuration
information is current.

Enclosure management; click on this icon to display the enclosure
management dialog.  Enclosure management displays the drive temperature, drive fan status,
and other information.

Drag and Drop Icons

Rebuild disk; drag the drive icon that represents the drive to be rebuilt
to this icon to rebuild the selected drive.

Initialize logical drive; drag the logical drive icon that represents the
drive to be initialized to this icon.

CAUTION If you reset your configuration by mistake, you can recover it by re-configuring the physical
drives into the same array and logical drive structure they were in, and by saving the
configuration without initializing.

Logical drive parity check; drag the logical drive icon to this icon.

Trash; drag the drive icon that represents the drive to be deleted to
this icon, and drop it.  Any configured physical drive can be deleted based on the following:
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-  Failed physical drive:  drive degraded to Optimal logical drive

-  Online physical drive:  removing a physical drive from logical drive.

In the above cases, reconstruction of the logical drive starts after the drop operation is
finished.  For more details, refer to Help => Adapter Menu => Toolbox, and click on the
Trash icon.

Logical Drive and Channel Icons
The following are the logical drive icons:

You can select one or more logical drive icons to group drives into RAID arrays.  The button
on the logical drive icon indicates its status:

u Green indicates normal operation.

u Yellow indicates that the drive performance is degraded.

u Red indicates a failed drive.

With the cursor over a configured logical drive, right-click the mouse for a pull-down menu
of action options for that logical drive.  The channel icon consists of a stack of drive icons.
Each drive on the SCSI channel is represented by a disk, CD-ROM, or tape icon.  With the
cursor over one of the channel bars, click the right mouse button to display a list of actions
that can be applied to that channel, as shown:
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The channel indicator light on each channel icon indicates the status of that channel.  The
Deactivate option lasts for 60 seconds when invoked.

Defining Power Console Menu Options
The Power Console menu options are as follows:

Option Description

Adapter Choose this option for the MegaRAID controller-related functions.
You can configure logical drives, enable the speaker, toggle object
identification, invoke the performance monitor, and display the
toolbar by selecting an item from this menu.

Physical Drv Choose this option to rebuild, format, and display the properties of
the physical drives.  You can also run diagnostics and select tools
from this option.

Logical Drv Choose this option to create, delete, initialize, check parity, and
display the properties of logical drives.

Window Choose this option to view the progress of a disk rebuild, diagnostic,
initialization, parity check, reconstruction or to view the performance
monitor.

Help Choose this option to display information on Power Console.

The MegaRAID BIOS Configuration utility and the Power Console utility detect the
presence of RAID controllers, and assign controller numbers, in two different ways.  In
InterServe 650, 660 systems, the BIOS and Power Console assign controller numbers as
follows:

u BIOS lists the controllers starting from PCI slot 7 to PCI slot 4, and counts them
incrementally from 0 to 3.

u Power Console counts the controllers incrementally from 0 to 3, but lists the controllers
starting from the lowest numbered PCI slot to PCI slot 7.  The number assigned to the
controller shifts according to the number of installed controllers.

The following table shows how both utilities list up to four installed RAID controllers:

PCI Slot BIOS Power Console

7 0 0 1 2 3

6 1 0 1 2

5 2 0 1

4 3 0
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In InterServe 615, 625, 635, 645 systems, the BIOS and Power Console assign controller
numbers as follows:

u BIOS lists the controllers starting from PCI slot 3 to PCI slot 1, and then PCI slot 6 (or
5), and counts them incrementally from 0 to 3.

u Power Console counts the controllers incrementally from 0 to 3, but lists the controllers
starting from PCI slot 6 (or 5), and then from PCI slot 1 to PCI slot 3.  The number
assigned to the controller shifts according to the number of installed controllers.

The following table shows how both utilities list up to four installed RAID controllers:

PCI Slot BIOS Power Console

3 0 0 1 2 3

2 1 0 1 2

1 2 0 1

6 (or 5) 3 0

Adapter Menu
The following figure shows the Adapter menu.
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The following table defines some terms you will see while configuring drives and running
Power Console.

READY Disk drive ready for configuration

OPTIMAL Disk drive ready for use

ONLINE Disk drive ready for use

REBUILD Disk drive to be replaced

OFFLINE Unformatted drive

PACK Configured pack

DRIVES Number of drives in a pack

SIZE Size of the packs (in megabytes)

HOTSP Disk drive configured as hot spare (standby) drive

EMPTY No disk drive installed

DEGRADED A logical drive has encountered a problem

The Adapter menu options are as follows.

Option Description

Configuration Select this option to configure or reconfigure RAID arrays and drives.

Flush Cache Select this option to force the MegaRAID controller to send the
contents of cache memory to the logical drives.

View Log Select this option to display an event log.  The events are stored in the
file, RAID.log.

Diagnostics This option starts diagnostics on a physical drive that is in a Ready or
Failed state.  Two types are available, internal diagnostics and
external diagnostics.

Enclosure
Management

Select this option to manage the drives in each physical RAID drive
cabinet.  A picture of a RAID enclosure is displayed.  The actual real-
time state of each RAID channel is displayed.  You can monitor the
addition and removal of devices in the enclosure online.

Properties Select this option to display the adapter properties, including the
firmware and BIOS versions, the rebuild rate, and cache memory
size.

Hide/Show
Toolbox

Select this option to display the toolbox if it is not displayed on the
Power Console dialog, or to remove the toolbox from the dialog if it is
already displayed.

Performance
Monitor
On/Off

Select this option to display a graphical representation of the
performance of a logical drive.  You can select a bar graph or a line
graph.
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Option Description

Object
Identification
On/Off

Select this option to turn the Object Identification feature on if it is
not already on.  Select this option to turn it off if it is on.  Object
identification is a Power Console feature that identifies all objects
displayed on the dialog.

Enable/Disable
Sound

Select this option to enable or disable the onboard speaker.  To
silence the speaker when it is activated, you must choose Disable
Sound and Disable Alarm Control.

Enable/Disable
Alarm Control

Select this option to enable or disable the system alarm when a drive
failure occurs.

Exit Select this option to quit Power Console.  You cannot exit if disk
operations are ongoing.  New configurations are not saved unless the
Save Configuration option was selected.

Configuration

The following configuration options are available from the Adapter Menu.

Option Description

Auto
Configuration

Select this option to automatically configure RAID arrays and logical
drives.  This option generates the simplest RAID configuration possible
with the current physical drives attached to the selected adapter.  Auto
configuration:

1.  Attempts to gather physical drives of the same size into groups of five.

2.  Attempts to gather the remaining drives into groups with up to three
drives per group.

3.  Groups the remaining drives into groups of two drives each and single
drives.

4.  Combines each group of three or more drives into a RAID 5 logical
drive.

5.  Combines each group of two or four drives into a RAID 1 logical
drive.

6.  Designates single physical drives as RAID 0 logical drives.

The drive configuration that results from auto configuration is displayed.
Select OK to program this configuration in the MegaRAID firmware.  All
new configurations are added to existing configurations.  Any existing
logical drive configuration is not changed.
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Option Description

Custom
Configuration

Select this option to delete existing configuration information and
configure new arrays and logical drives into different groups.  You can
perform logical drive configuration functions and associate logical drives
with multiple or partial arrays.  You must first create an array.  Arrays
are groups of physical drives that define the stripe width common to one
RAID type.  Arrays are combined into logical drives.  Logical drives can
be created out of part of an array or can be a combination of several
arrays if the arrays have the same properties.

Save
Configuration

Select this option to save the new RAID drive configuration.

Easy
Configuration

With this option, each array you create is automatically treated as exactly
one logical drive.  The Logical Drive Property dialog (see below) appears
when you select this option.  Select the physical drives that will make up
the logical drive.  Select the RAID type, stripe size, and write policy.

Reset
Configuration

Select this option to erase the current configuration information from the
MegaRAID controller non-volatile memory.  The current RAID
configuration becomes invalid after you select this option.  Use this
option carefully and only when configuring a new system.

Display
Configuration

Select this method to display the configuration.  You can also display
other arrays and logical drives.

Print
Configuration

Select this option to print the current RAID drive configuration.

The following shows an example Logical Drive Property dialog for configuring RAID 10,
RAID 30, or RAID 50 Logical Drives:
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Configure RAID 10 by spanning two to four pairs of contiguous RAID 1 logical drives.  The
RAID 1 logical drives must have the same stripe size.

Configure RAID 30 by spanning two contiguous RAID 3 logical drives.  The RAID 3 logical
drives must have the same stripe size.

Configure RAID 50 by spanning two contiguous RAID 5 logical drives.  The RAID 5 logical
drives must have the same stripe size

Flush Cache

If the MegaRAID system must be powered down rapidly, you must flush the contents of the
cache memory to preserve data integrity.

View Log

Select this option to display the MegaRAID event log.  The events are stored in the file,
RAID.log.

Diagnostics

Select this option to run either internal or external diagnostics on a physical drive that is in a
Ready or Failed state.  The external diagnostics divide into two catagories:  sequential and
random.

Enclosure Management

Select this option to manage the physical drives in the RAID drive cabinets.  Each enclosure
displays the status of a SCSI channel.  You can remove and insert hard drives.  A red light
on a drive indicates a failed channel or drive.  Green indicates optimal conditions.
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NOTE Click on any device displayed on the enclosure management dialog to display device
information, as shown:

Properties

Select this option to display the adapter properties.  A dialog similar to the following
appears:
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Hide/Show Toolbox

The RAID Configuration toobox can be removed from the dialog by clicking on Hide
Toolbox in the Adapter menu.  The option will then change to Display toolbox.

Performance Monitor

Click the left mouse button on a logical drive icon and select Performance Monitor to display
a graphic representation of drive performance.  A sample Performance Monitor dialog
follows.  You can choose different logical drives, the type of graph, and the dialog
arrangement from the Performance Monitor menus.

Object Identification

Select this item to turn the object identification feature (“bubble help”) on or off.  This
feature identifies icons in the Power Console dialogs.
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Enable/Disable Sound

Choose this option to enable or disable the onboard tone generator.  To silence a sounding
alarm, choose Disable Sound and Disable Alarm Control.

Enable/Disable Alarm Control

Choose this option to enable or disable the audible alarms and warnings.

Exit

Choose this item to leave Power Console.

Physical Drv Menu
The Power Console Physical Drv menu is as follows:

Rebuild

Choose the Rebuild option from the Physical Drv menu to rebuild one or more failed disk
drives.
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A RAID 1, 3, or 5 configuration has built-in redundancy.  If a drive in a RAID group fails,
the RAID subsystem continues to work but no additional redundancy is provided.  Another
drive failure will bring the system down.  The failed drive can be replaced and added into the
RAID system by rebuilding the drive.  Select Rebuild to perform this function.  The rebuild
process can take place while the RAID system is still running, although performance may be
slightly affected.

Abort Rebuild

Select Abort Rebuild to stop the rebuild process at any time.  The drive will revert to its
original status before the rebuild began.

Format

Formatting is not supported in Power Console.  It is recommended that you format drives
using the MegaRAID BIOS Configuration Utility.

Diagnostics

Select this option to run either internal or external diagnostics on a physical drive that is in a
Ready or Failed state.  The external diagnostics divide into two catagories:  sequential and
random.

Tools

Choose this option to fail a drive, make a hot spare, enable narrow SCSI, enable wide SCSI,
and perform other actions.

Properties

Choose this option to display drive properties.
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Logical Drv Menu
The Power Console Logical Drv (Drive) menu is as follows:

Create

Choose the Create option to create arrays.  A dialog such as the following appears.  You can
select the RAID type, stripe size, write policy, read policy, and cache policy.
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Select the array to be created by clicking on ARR1 - ARR8 at the top of the dialog.  Select
the drives to be included in the array by clicking on the device icons displayed in the middle
of the dialog.  You can include SCSI devices from more than one channel in the new array.
You can define a maximum of eight (8) logical drives per MegaRAID controller.

Click on Apply to configure the new array.  Verify that the appropriate drives are included in
the array and click on OK.  You must also initialize these drives.

For channel information, position the cursor on one of the SCSI channels and click on the
right mouse button.  The following sample dialog displays.

Initialize

Choose this option from the Logical Drv menu to initialize logical drives.  A dialog such as
the following appears.  Choose the logical drives to be initialized and click on the Go button.

WARNING Power Console allows you to initialize a drive at any time.  Make sure that the drive
being initialized does not hold live data.  All data will be lost.
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You can also initialize a drive by dragging the drive icon to the Format icon and dropping it.

Check Parity

Choose Check Parity from the Logical Drv menu to make sure that parity is correct for the
selected drives.  A dialog such as the following appears.  Click on the drive to be checked
(D1 - D8) and click on the Go button.

RAID levels 1, 3, and 5 use an extra drive to store parity data blocks.  Parity is checked
between these parity data blocks and the selected drives when you select this option.
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Properties

Choose Properties from the Logical Drv menu to display the logical drive properties of the
selected logical drive.  A dialog such as the following appears.  Each logical drive can be
displayed by selecting the Previous or Next buttons.

Logical Drive Menu

When you click the right mouse button on a logical drive in the Power Console menu, you
can change or expand any logical drive without halting system operations.  You can perform
sophisticated RAID operations on preconfigured RAID logical drives.

u Change Policy

u Advanced Menu

To access the Logical Drive menu from the MegaRAID Power Console, you must first click
the right mouse button on a logical drive you want to change.  Then you can select any
bolded option from the Logical Drive menu as shown in the following dialog:
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NOTE The trash can icon in the lower right corner of the MegaRAID Power Console dialog is
available for you to use.  To delete a physical drive from a RAID logical drive, just drag and
drop a physical drive over it.

Other options also appear in the Advanced Menu pulldown after you select a logical drive
and click the right mouse button.
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Change Policy

You can select Change Policy from the Logical Drive pulldown menu to change the write,
read, and cache policies of a selected array.

To change a RAID policy:

1. From MegaRAID Power Console, place the cursor on the logical drive for which you
want to change the RAID policy, and click the right mouse button.

2. Select Change Policy from the Logical Drive menu.  The following dialog displays:

3. Select the down arrow button under each policy (Write, Read, or Cache) to display a list
of the available policies for this array.  Click on a new policy to select it.

4. Select OK when you have completed all policy changes.

Advanced Menu

The Advanced Menu from the Logical Drive pulldown menu allows you to change a
configuration and to add a drive to an existing configuation.  You can define a maximum of
eight (8) logical drives per MegaRAID controller.

Change RAID Level

Change Config allows you to change the RAID level, and convert a logical drive from
degraded to optimal.
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You can change RAID levels without degrading the RAID subsystem.  For example, you can
convert a degraded RAID 1, RAID 3, or RAID 5 logical drive to an Optimal RAID 0 logical
drive.  After you select the degraded logical drive to be optimized, the software reconstructs
the RAID subsystem without halting the system.

NOTE You can also convert a RAID 3 logical drive to a RAID 5 logical drive or vice versa.

The following table lists the RAID level change paths.

If RAID system is... You can change to... When You...

RAID 3 or RAID 5 Optimal RAID 3 or RAID 5 Optimal Add drives.
RAID 3 or RAID 5 Optimal RAID 0 Stop parity.
RAID 3 or RAID 5 Optimal RAID 0 Delete a drive, or add drives.
RAID 3 or RAID 5 RAID 0 Optimal If a drive fails, you can

configure an Optimal RAID
0 system.

RAID 1 Optimal RAID 3 or RAID 5 Optimal Add drives.
RAID 1 Optimal RAID 0 Add drives or delete a drive.
RAID 1 Degraded RAID 0 If a drive fails, you can

configure an Optimal RAID
0 system.

RAID 0 RAID 3 or RAID 5 Optimal Add drives.
RAID 0 RAID 1 Optimal Add a drive.
RAID 0 RAID 0 Add drives.

CAUTION Once you start an operation, no other operation can be started until the present operation
completes.

To change a RAID level:

1. From MegaRAID Power Console, place the cursor on the logical drive for which you
want to change the RAID level, and click the right mouse button.

2. Select Advanced Menu from the Logical Drive menu.

3. Select Change Config.  The following dialog displays:
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4. Select Apply.  The Reconstructing dialog displays as follows:

 
5. Click on the Info button of the Reconstructing dialog to display detailed information

about the reconstruction operation being performed, as shown:
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6. Review the changes that have been made and select OK when finished.

Adding a Drive

Add Drive from the Advanced Menu of the Logical Drive pulldown menu allows you to add
a physical drive to a configured logical drive.

u The logical drive state must be Optimal.  The physical drive state must be Ready.

u An Optimal RAID 0 logical drive can be converted to an Optimal RAID 1, RAID 3, or
RAID 5 logical drive by adding one or more physical drives.

u An Optimal RAID 1 logical drive can be converted to an Optimal RAID 0, RAID 3, or
RAID 5 logical drive.

NOTE You can also convert between RAID 3 and RAID 5 by adding additional physical drives to the
logical drive.

CAUTION The state of the physical drive to be added must be Ready.  The state of the RAID subsystem
being modified must be Optimal.

To add a drive:

1. From MegaRAID Power Console, place the cursor on the logical drive where the
physical drive is to be added, and click the right mouse button.

2. Select Advanced Menu from the Logical Drive Menu.

 Select Add Drive.  The following dialog displays:
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3. Select the physical drive(s) to be added using the left button (a check appears on the
drive).  Select Apply.  The Reconstructing dialog displays as follows:

 
4. Click on the Info button of the Reconstructing dialog to display detailed information, as

shown below, about the reconstruction operation being performed:



133

 

5. Review the changes that have been made and select OK when finished.

6. Reboot the system to use the added capacity unless Flexible (Dynamic) Sizing is
enabled.

Removing a Drive
You can change the configuration of any logical drive by removing a physical drive from the
configured logical drive.

To remove a physical drive from a logical drive:

1. Drag the physical drive icon from the MegaRAID Power Console to the trash can.  The
Change RAID Level dialog displays.
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2. Select the RAID level that will allow the new RAID configuration to become Optimal.
Select Apply and the Reconstructing dialog display.

Designating Drives as Hot Spares
Hot spares are physical drives that are powered up along with the RAID drives and usually
are placed in a standby state.

Hot spares can be used for RAID levels 0, 1, 3 and 5.  To make a drive a hot spare, more
than one logical drive must be configured.  From the Power Console main menu, click on the
drive icon of the drive to be made the hot spare.  Select Tools from the menu.  Select Make
Hotspare from the Tools submenu as shown.

The drive to be made a hot spare must have a the same or a greater capacity than the other
drives in the RAID array.

When you select the icon for a SCSI device from the SCSI channels display in the middle of
the above dialog, the drive type and the capacity of the selected drive is displayed at the
bottom of the dialog.

Securing Power Console
When you complete the following instructions, only the personnel who are part of the
selected groups can delete, copy, move, or execute a power console file.
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To secure the Power Console utility:

1. Log in as Administrator.

2. Run File Manager.

3. Select the path containing the Power Console executable.

4. Pull down the Security menu in File Manager and choose Permissions.

5. When the permission dialog box appears, assign the List permission to all Groups
except Administrator, Backup Operators, System, and Creator Owner.

6. In the Permission dialog box, select Replace Permissions on Subdirectories to apply the
permissions that you are setting here to the subdirectories as well.

7. After you have set Permissions, choose OK and exit File Manager.  Log in as a guest
and make sure the permission changes are saved.

Saving Configuration to Floppy
The Save-restore utility allows you to save a new configuration to a diskette (back up), or to
restore a configuration that is lost.  Always back up the configuration file for every
InterRAID cabinet connected to the system.

To back up a configuration to floppy:

1. Ensure the boot sequence for the system is A:, C:.

2. Insert the bootable MegaRAID diskette containing confmgr.exe into the floppy disk
drive.

3. Restart the system.  Key in confmgr at the command prompt.  The following appears:

 

MegaRAID PCI Adapter Configuration Manager Ver x.xx [July 8 1996].

Adapter 1 found at Base port = 0xec10  Irq= 0xb

Save Config to File 1 Restore Config from File 2
Display Adapter Config 3 Display File Config 4
Exit 5

Enter Option -

4. To save the RAID configuration, key in 1 at the command prompt and follow the
instructions on the screen.  Use a file name with fewer than twenty characters including
a .MEG extension.  The follow appears:

Saving configuration...
Press Any Key to Continue.
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5. Choose another option, or press 5 to exit.

To restore a configuration:

1. At the MegaRAID PCI Adapter Configuration Manager menu, key in 2 to restore a
configuration from a file.

2. Key in the filename for the configuration file.  Do not include directory paths.  If you
used a .MEG extension as part of the filename, include the extension.

WARNING Key in only a MegaRAID configuration file.  Restoring any other file will overwrite the
binary code for setting the registers, causing damage to the RAID controller board.
The board must be replaced.

CAUTION The restored configuration file must match the hardware configuration.  MegaRAID assumes
the number of physical drives installed in the InterRAID cabinet is the same as the number of
drives configured in the configuration file.

The configuration is read from the file and saved on the RAID controller board.

3. Press 5 to exit the configuration manager.

4. Remove the MegaRAID diskette and restart the system.
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8 Servicing the Disk Array  

This chapter provides instructions for replacing the following parts:

u RAID controllers

u Disk drives

u Power supplies

u Cooling fans

u Cabinets

NOTE Always purchase replacement parts from Intergraph to maintain proper specifications.  If
replacing the RAID controller board in your system, refer to the system documentation.

Precautions
Static electricity can damage the components inside the system base unit.  To minimize the
possibility, observe the following precautions when working with the internal components of
the system.

u Touch the bare metal of the base unit or cabinet to discharge any accumulated static
charge.

u Avoid servicing the system in areas known to have electrostatic problems such as on
rugs and carpets.

u Handle all printed circuit boards as little as possible and by the edges only.  Leave the
boards in their protective packaging until you install them.

u Do not drop, jar, or bump the disk drives.  Handle all disk drives by the edges and avoid
touching connector pins or printed circuit board components.

u Always power off the system base unit before powering off the cabinet, and leave the
power cord connected to maintain ground.

Replacing RAID Controllers
NOTE To replace a RAID controller board in a rack-mount base unit, refer to the system’s hardware

documentation for the rack-mounted system.  The system documentation specifies the slots
for the RAID controller.
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If replacing a RAID controller board in a desktop system, be sure to install the board in the
same slot that was used for the old board.  Refer to your system documentation to open the
base unit and replace an option board.

Use this section to replace a failed RAID controller board (DAC960P, DAC960PD, or
MegaRAID) located in the the server base unit.  After replacing the board, you must
configure it so that the internal RAID SCSI channel is set to the proper operation.

CAUTION Before powering off the server, back up the current RAID configuration to diskette.  For
DAC960P and DAC960PD boards, refer to Chapter 5, “Using DAC InterRAID Utilities.”  For
MegaRAID boards, refer to Chapter 6, “Using MegaRAID BIOS” and Chapter 7, “Using Power
Console.”

Before opening the base unit and servicing any parts, carefully read the “Precautions” section
of this chapter.  If you do not heed these initial precautions carefully, your system or
replacement parts could be damaged and your warranty voided.

To replace or add a RAID controller board:

1. Open the system’s base unit and remove the RAID controller board.  Refer to your
system’s documentation for instructions on opening the base unit, taking precautions
against electrostatic discharge, and installing option boards.

2. If adding a controller board, use a quarter-inch nutdriver to remove the blanking plate
from the appropriate PCI slot in the system’s base unit.

3. Install the RAID controller board(s) into the appropriate PCI slot in the system’s base
unit.  The primary RAID controller resides in PCI slot 3.  Install secondary controllers
in PCI slots 2, 1, and 6, in that order.  If PCI slot 6 is not available, use PCI slot 5 .

PCI Blanking
Plate (Slot 2)

Secondary
RAID
Controller
Board
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NOTE The existing primary RAID controller board supports two external disk arrays using Channel 0
and Channel 1.  Channel 2 supports the internal RAID subsystem through internal
connection.

4. Secure the RAID controller board(s) with the screw removed previously.

5. Close the system’s base unit as described in your system’s documentation.

Replacing Disk Drives
Use this section to replace the disk drives of the InterRAID-6, InterRAID-8, and InterRAID-
12 disk arrays.  After replacing a disk drive, you can rebuild it using the applicable utility for
the installed controller under MS-DOS or under Windows NT.

CAUTION Establish a ground by first touching the metal chassis of the cabinet before handling or
installing computer components.

To replace a disk drive:

1. Remove the new disk drive from the shipping carton and antistatic bag.  Save the
packaging material.

2. Note the drive label on the failed disk drive.  Remove the matching numbers from the
label sheet and affix them to the front of the new disk drive.

3. Extend the drive latching clips to disengage the failed drive from the disk array.  Then,
slide the disk drive out of the cabinet.

4. Install the new disk drive by extending the drive latching clips and sliding the disk drive
into the drive slot.  Place your thumb on the drive label and push until the drive
connects.  Close the drive latching clips until they snap into place, locking the drive into
the slot.

NOTE If DAC960P or DAC960PD is installed, rebuild the drive using DACCF or DACADM.  If
MegaRAID is installed, rebuild the drive using the MegaRAID utility.  Refer to the applicable
chapter in this guide for your RAID controller.

Replacing Power Supplies  
Only the InterRAID-8 and InterRAID-12 have hot-swap power supplies.  Do not attempt to
replace a power supply in an InterRAID-6.  If a power supply fails in the InterRAID-6,
return the unit to Intergraph.  You do not need to power off the InterRAID-8 or InterRAID-
12 cabinet to replace a power supply.
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To replace an InterRAID-8 or InterRAID-12 power supply:

1. Locate the failed power supply at the back of the cabinet.  The LED for the power supply
will be off.

2. Grasp the handle of the power supply and pull the supply out of the cabinet.

3. Slide the new power supply into the cabinet until it lock s.

NOTE For an InterRAID-8 or an InterRAID-12, you should use two power supplies if your disk array
contains up to three disk drives.

For an InterRAID-8, if it becomes necessary to remove the middle power supply from the
cabinet, do so as described above and store the power supply in a static protective package.
Remove the power supply blanking plate from the accessories package and install it into the
middle position on the cabinet using a Phillips screwdriver.

Replacing Cooling Fans  
Only the InterRAID-8 and InterRAID-12 have hot-swap cooling fans.  Do not attempt to
replace the cooling fans in an InterRAID-6.  If a cooling fan fails in the InterRAID-6, return
the unit to Intergraph.  You do not have to power off the InterRAID-8 or InterRAID-12 to
replace the cooling fans

To replace an InterRAID-8 or InterRAID-12 cooling fan:

1. Locate the failed cooling fan at the back of the cabinet.  The cooling fan will be stopped.

2. Using a slotted screwdriver, loosen the two screws on the cooling fan plate.

3. Lower the cooling fan plate to access the fans.

4. Disconnect the in-line connector for the failed fan.

5. Using a No. 2 Phillips screwdriver, remove the four screws that secure the fan to the
plate.  Remove the failed cooling fan

6. Remove the new cooling fan from the shipping carton.  Save the packaging material.

7. Align the fan mounting holes with those on the plate and secure the new cooling fan to
the plate using the four screws.

8. Reconnect the in-line connector; then, raise the fan panel and tighten the two screws on
the fan plate.
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Replacing Cabinets
Follow these instructions to replace the InterRAID-6, InterRAID-8, or InterRAID-12
cabinet.

To replace a cabinet:

1. Remove the new cabinet from the shipping carton and inspect the shipment.  Save the
packaging material.

2. Open the door of the old cabinet.  Note the position of each disk drive in the old cabinet.
The drives are labeled with an ID number.

3. Place the new cabinet adjacent to the old cabinet.

4. Shutdown and power off the system base unit; then, power off the cabinet to be replaced.

5. Disconnect the AC power cord and RAID SCSI cable(s) from the old disk array.

6. Connect the AC power cord and RAID SCSI cable(s) to the new cabinet.

7. Remove the disk drives from the old cabinet and install them into the new cabinet in
exactly the same order as they were in the old cabinet.

8. Power on the new cabinet.

9. Power on the system base unit.
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9 Identifying the RAID Controller
Board

The RAID controller board is a high-performance PCI SCSI controller that manages the disk
array of the host server.  Three versions of the RAID controller board are used in conjunction
with Intergraph’s host servers:  DAC960P, DAC960PD, and MegaRAID.

DAC960P Controller
DAC960P has two independent RAID SCSI bus channels (0 and 1), each using a separate
53C720 SCSI controller.  This allows the system to read or write data on several disk drives
simultaneously.  The DAC960P RAID controller board is shown in the following figure.
Channel 1 is the default internal RAID SCSI connector.

CAUTION Ensure jumpers are installed as shown or erratic operation will occur.
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DAC960PD Controller
DAC960PD has three independent RAID SCSI bus channels (0, 1, and 2), each using a
separate 53C720 SCSI controller.  This allows the system to read or write data on several
disk drives simultaneously.  The DAC960PD RAID controller board is shown in the
following figure.  Channel 2 is the default internal RAID SCSI connector.

CAUTION Ensure jumpers are installed as shown or erratic operation will occur.
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MegaRAID Controller
MegaRAID has three independent RAID SCSI bus channels (0, 1, and 2), each using a
separate 53C770 SCSI controller.  This allows the system to read or write data on several
disk drives simultaneously.  The MegaRAID RAID controller board is shown in the
following figure.  Channel 2 is the default internal RAID SCSI connector.

CAUTION Ensure jumpers are installed as shown or erratic operation will occur.

Features
The RAID controller has the following features:

u PCI Bus Interface

u AT Compatible BIOS

u RAID Controller Firmware

u RAID SCSI Bus
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PCI Bus Interface

The RAID controller interfaces to its host system through the PCI bus.  The PCI bus allows
32-bit high speed transfers and supports a burst data rate of over 130 MB per second.

AT Compatible BIOS

The RAID controller has an Advanced Technology (AT) compatible BIOS containing a set
of special programs which receive control of the system when it is first powered on.  The
RAID controller then intercepts all INT13 BIOS calls and translates them into the
appropriate RAID control codes.

RAID Controller Firmware

The RAID controller firmware programs, stored on the flash EEPROM, are executed by the
i960 RISC processor.  The flash EEPROM allows the system firmware to be upgraded
without replacing any hardware.

NOTE If the firmware becomes lost, contact the Customer Response Center for assistance.  Only
qualified service personnel should update the firmware.

RAID SCSI Bus

The RAID SCSI bus connects the disk drives and internal devices to the RAID controller.
The DAC960P and the DAC960PD are Fast Wide SCSI-2.  The MegaRAID controller is
Ultra-wide SCSI.

Components
The RAID controller uses the following components:

i960 RISC Processor

The processor is a 32-bit Intel i960C RISC microprocessor.  The processor controls all
functions of the RAID controller including SCSI bus transfers, PCI bus transfers, RAID
processing, configuration, data striping, error recovery, and drive rebuilding.
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Cache Memory

The cache memory subsystem on the RAID controller board has a total of
8 MB of DRAM.

PCI Connector

The PCI connector inserts into the PCI slot of the server system board.  This connector
carries all the PCI bus signals between the RAID controller board and the system board.

Flash EEPROM (MegaRAID Only)

Flash EEPROM stores the RAID firmware programs and the RAID configuration data.
Since it is re-writeable, it allows the firmware to be upgraded without replacing any
hardware.  As the disk configurations change (for example, when a drive fails) the flash
EEPROM records the changes.   The flash EEPROM retains the firmware and configuration
data after the system is powered off.

SCSI Controller

To manage the data flow on the RAID SCSI bus either two or three SCSI controller are used:
Two 53C720 controllers for DAC960P, three 53C720 controllers for DAC960PD, or three
53C770 controllers for MegaRAID.  One SCSI RAID controller is assigned to each bus
channel.

External RAID SCSI Connector (DAC960PD and MegaRAID)

The external RAID SCSI connectors for DAC960PD and MegaRAID are 68-pin ultra high
density connectors.

Onboard Speaker (MegaRAID Only)

The MegaRAID controller has an onboard tone generator for audible warnings when system
failures occur.
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10 Configuring the Disk Array for
Performance

This chapter discusses RAID performance and configuration methods of the hard disk
drives.  Included are examples for striped, mirrored, and other performance options and a
brief discussion of database applications.  Also included are the differences in RAID mode
performance and data integrity.

RAID Technology
Redundant Arrays of Independent Disks (RAID) increases system performance and gives an
extra level of data protection.  The basic idea of RAID technology is to use multiple hard
disk drives as a single logical drive.  Several hard disk drives are arranged into a pack and
then defined as a logical system drive.  Data may then be striped or mirrored across the
physical drives.  Striping spreads data across three or more drives, which allows more disk
drive heads to access data, and thereby improves data throughput.  Mirroring places a copy
of the data on two mirrored drives to offer data protection in the event a hard disk drive
should fail.

Striped RAID Performance
You can achieve performance improvement on a multi-channel RAID controller for striped
data (such as RAID 0 or RAID 5) when the drives in the packs span the input/output (I/O)
channels.  For example, perform the following when creating a pack containing four hard
disk drives:

u Place the first disk drive in the pack on the first I/O channel of the RAID controller.

u Place the second disk drive in the pack on the second I/O channel of the RAID
controller.

u Place the third disk drive in the pack on the first I/O channel of the RAID controller.

u Place the fourth disk drive in the pack on the second I/O channel of the RAID
controller.
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Performance will benefit because the separate channels work independently of each other.
Multiple I/O requests can occur simultaneously since they are on separate channels of the
controller.

An extension of this technique is to stripe not only across multiple SCSI channels on a single
controller but to stripe across multiple controllers.  You can accomplish this by combining
drives on individual controllers in the manner described above.  Then, create one (or more)
logical drive on each RAID controller and use the disk striping capabilities built into
Windows NT Server to stripe these logical drives together into a logical volume.

Mirrored RAID Performance
When mirroring data (such as RAID 1), the packs should not span the channels.  You should
create two packs, each on its own channel.  For example, perform the following using four
1 GB disk drives:

u Put the first disk drive into the first pack on the first I/O channel of the RAID controller.

u Put the second disk drive into the first pack on the first I/O channel of the RAID
controller.

u Put the third disk drive into the second pack on the second I/O channel of the RAID
controller.

u Put the fourth disk drive into the second pack on the second I/O channel of the RAID
controller.

Notice that mirroring increases the size to 2 GB.  By creating two packs on separate
channels and mirroring the first pack to the second pack, the mirrored data writes
simultaneously as the original data.  Simultaneous writing results in improved performance.
However, if you do not keep the packs on separate channels, performance will degrade
because one channel will possibly have to sequentially write the original data and the
mirrored data.

Other Performance Options
Other I/O options that can help performance are Tagged Command Queuing, Write Back
Caching, and Controller Read Ahead.  Careful distribution of data can also increase
performance.
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Tagged Command Queuing intelligently orders the seeks which improves performance for
random accesses.  Controller Write Back and Read Ahead Caching allow files to be read and
written most efficiently for those applications accessing large, sequential data and striping
across multiple disks and RAID controller channels.

Tagged Command Queuing

This option allows the I/O subsystem to queue requests and reorder them into the most
efficient order before retrieving them from the disk.

Write-Back Caching

Write-Back Caching allows disk writes to be cached and written when the RAID controller
or disk drive is ready to write.  The RAID controller receives data in cache and signals the
software that it has already written the data to the disk.  Write-Back Caching boosts
performance, but a danger exists that some data could be lost if the power supply is disrupted
during writing.  Always protect the data by using a battery backup on the RAID controller or
an Uninterruptible Power Supply (UPS).

Controller Read Ahead

Under normal operation, Controller Read Ahead is an option on the I/O subsystem that can
improve performance for sequentially accessed data.  Controller Read Ahead prefetches
sequential data, assuming the operating system is likely to ask for the prefetched data.
Randomly accessed data may have reduced performance with the Controller Read Ahead
option.

Database Applications
Place frequently accessed data at the beginning of the disks where the I/O rate generally will
be faster and require less seeking time.  Also, place I/O-intensive tables at the beginning of
the disk.  Use tablespaces in Oracle, or segments and devices in Microsoft SQL Server and
Sybase Systems to segregate the data for placement on the disk.

To estimate the amount of I/O for tables in the database, use the following formula where A
= table record length, B = number of rows returned in a query, and C = number of times
required to access the table:

A x B x C
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For maximum performance in a database, Log or Redo Log access is sequential I/O data; you
should separate sequential I/O data from random I/O data.

Data access is usually random for On-line Transaction Processing (OLTP) applications.  The
optimal performance strategy is to stripe the data across devices to distribute the I/O data and
minimize I/O contention.  OLTP applications perform operations on small blocks of data
randomly spread across multiple data pages.

Decision Support Systems (DSS) and Data Warehouse applications may benefit from large
block I/O if they are performing large sequential reads of adjacent data pages.  Refer to the
documentation for your database system to determine if you can modify the I/O block size.

RAID Mode Performance and Data Integrity
Differences

Three RAID modes provide improved data integrity through data redundancy:  RAID 1,
RAID 5, and RAID 3.  RAID 0 does not provide data redundancy.

RAID 1 (mirroring) has the smallest impact on performance.  It provides neither a severe
performance penalty nor a boost.  However, mirroring requires 50% of the raw disk space in
the pack for data redundancy.

RAID 5 (striped data with parity) has improved performance on reads.  Write performance is
less due to the time required to calculate parity by performing read-modify-writes on small
block transfers.  RAID 5 is more efficient than RAID 1 in terms of the disk space used for
redundancy.  A RAID 5 stripe with N disks uses N-1 disks for data, and only one disk for
parity and redundancy information.

RAID 3 is similar to RAID 5, except it stores all parity information on a single disk in the
pack rather than distribute it among the disks as in RAID 5.  RAID 3 performance and
space-efficiency characteristics are similar to RAID 5, but RAID 3 provides better
performance for large-block, sequential transfers when using the Controller Read Ahead
option.

RAID 0 (striped data without parity) provides no data redundancy, and thus, no assurance of
data integrity.  Data distributes across multiple disk drives;  consequently, a failure in any of
the disk drives could result in loss of that data.  RAID 0 provides less data integrity than a
single disk drive.  However, the performance improvements available through the use of
RAID 0 are greatest.  It allows concurrent access to multiple disks on both reads and writes
without the write performance penalty associated with RAID 5.
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A Specifications   

This appendix provides the specifications for InterRAID-6, InterRAID-8, and InterRAID-12
disk array cabinets.  The specifications are subject to change without notice.

NOTE Refer to the system’s documentation for the system base unit specifications.

InterRAID-6  
The following specifications apply to the InterRAID-6 cabinet.

Power Requirements: 100 - 240 VAC, 50 - 60 Hz, 2 Amperes

Mean Time Between Data Loss: 5,000,000 hours

Dimensions (H x W x L): 12.5 inches x 7.5 inches x 12.5 inches

Weight (disk drives not installed): 30.0 pounds

Number of Drives Supported: 6

Interface Transfer Rate: 20 MB per second

System Interface: Fast Wide SCSI-2

Drive Interface: Fast Wide SCSI-2 with SCA

Hard Disk Drive Termination: Auto-terminating

Hard Disk Drive SCSI ID: Auto-setting

Electromagnetic Interference
(EMI) Emissions Requirements: FCC, Part 15, Class A; VDE 0871, Class B

Safety Requirements: UL1950; CSA C22.2 #950;
TUV / EN60950; CE
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InterRAID-8  
The following specifications apply to the InterRAID-8 cabinet.

Power Requirements: 100 - 240 VAC, 50 - 60 Hz, 2 Amperes

Mean Time Between Data Loss: 5,000,000 hours

Dimensions (H x W x L): 18.75 inches x 7.00 inches x 23.25 inches

Weight (disk drives not installed): 65.0 pounds

Number of Drives Supported: 8

Interface Transfer Rate: 20 MB per second

System Interface: Fast Wide SCSI-2

Drive Interface: Fast Wide SCSI-2 with SCA

Hard Disk Drive Termination: Auto-terminating

Hard Disk Drive SCSI ID: Auto-setting

Electromagnetic Interference
(EMI) Emissions Requirements: FCC, Part 15, Class A; VDE 0871, Class B

Safety Requirements: UL1950; CSA C22.2 #950;
TUV / EN60950; CE
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InterRAID-12  
The following specifications apply to the InterRAID-12 cabinet.

Power Requirements: 100 - 240 VAC, 50 - 60 Hz, 2 Amperes

Mean Time Between Data Loss: 5,000,000 hours

Dimensions (H x W x L): 18.75 inches x 7.00 inches x 23.25 inches

Weight (disk drives not installed): 59.0 pounds

Number of Drives Supported: 12

Interface Transfer Rate: 20 MB per second

System Interface: Fast Wide SCSI-2

Drive Interface: Fast Wide SCSI-2 with SCA

Hard Disk Drive Termination: Auto-terminating

Hard Disk Drive SCSI ID: Auto-setting

Electromagnetic Interference
(EMI) Emissions Requirements: FCC, Part 15, Class A; VDE 0871, Class B

Safety Requirements: UL1950; CSA C22.2 #950;
TUV / EN60950; CE
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B Troubleshooting

This appendix provides the troubleshooting solutions for various problems that might occur
with the InterRAID-6, InterRAID-8, or InterRAID-12 disk arrays.  If problems persist, or are
not covered in this appendix, call the Customer Response Center at 1-800-633-7248.

General     
This section applies to the InterRAID-6, InterRAID-8, and InterRAID-12 disk arrays.

Error:  System fails to power on

Reason Solution

Power cord not connected properly. Verify that the power cord properly connects to the
power receptacle.

Power not supplied at the outlet. Verify power to the outlet has not been interrupted.
Test the outlet with a known working appliance.

Power not supplied from the UPS. Verify UPS connection and proper operation.

Power switch not in the proper
position.

Be sure that the power switch on the front of the base
unit is in the ON position.

Power cord fault. Replace power cord.

Error:  InterRAID drive keeps going dead, same physical drive each time

Reason Solution

One disk drive in the array fails
often.  Media error on drive.

Check the drive error counts using InterRAID
utilities.

Format the drive.

Rebuild the drive.

If the drive continues to fail, replace the drive with
another drive with the same capacity and rebuild.
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Error:  System hangs while loading operating system

Reason Solution

Data pattern may be causing the
operating system to hang.

Format at least one disk drive.

Clear configuration.

Re-create logical drive(s).

Initialize the logical drive(s).

Install the operating system.

Error:  System hangs when scanning devices

Reason Solution

Termination fault. Check the termination jumpers.  Refer to Chapter 9.

Cable connection fault. When connecting the RAID SCSI cable to the RAID
controller board, first seat the connector completely
and then carefully tighten the thumbscrews.  Avoid
cross-threading the thumb screws.  Check the final
connection to ensure that the cable is fully seated.

Drive cable fault. Replace the drive cable.

Error:  Installation aborted

Reason Solution

One or more drives failed to spin up
in time during the power up
sequence.

Perform the following power off and power on
sequence:  First, power off the system base unit.
Power off the cabinet.  Then, power on the cabinet
and wait for the beep and the drives to cycle.  Power
on the system base unit.

Error:  “No ROM Basic” message displays

Reason Solution

RAID controller board not correctly
identified as the boot device.

Change the operating system boot device parameter
in the system BIOS.  Refer to your system’s hardware
documentation for BIOS information.

NOTE In the following tables, HDD indicates hard disk drive LED, and CHM indicates channel mode
LED.
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Error:  HDD blinking amber, CHM blinking amber

Reason Solution

Failed disk drive.  Disk array not in
a fault-tolerant state.

Replace the disk drive, rebuild the disk array.

Error:  HDD blinking green, CHM steady green

Reason Solution

Disk drive not assigned into a pack. Assign the disk drive to a pack, if desired; otherwise,
the hot spare will be used in the event of a disk
failure.  Refer to the appropriate chapter that
corresponds to the installed RAID controller.

InterRAID-8 and InterRAID-12    
The following tables provide troubleshooting guidelines specifically for the InterRAID-8 and
InterRAID-12 disk arrays.

Error:  Information Control Panel displays, “Hardware Error”

Reason Solution

Component failure. Identify the failed component using the “Component
Status” menu of the Information Control Panel menu.
Replace the failed component according to Chapter 8.

Error:  Power-On Self Test (POST) fails

Reason Solution

Component failure. Select “POST Results” in the Information Control
Panel menu.  Locate the failed component.
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Error:  Temperature threshold exceeded

Reason Solution

Cooling fan failed. Identify the failed fan using the Information Control
Panel.   Refer to Chapter 8 for details on replacing the
fan.

Cooling fan vent blocked,
inadequate ventilation.

Remove blockage to allow air flow, or move system to
location with better ventilation.

InterRAID-8 Only   
The following table provides troubleshooting guidelines specifically for the InterRAID-8 disk
array.

Error:  All drives are dead

Reason Solution

Satellite mode set to active. In the Information Control Panel menu, select the
Options Menu.  At SCSI ID Menu, press the down
arrow to locate Reset Default IDs and press the Enter
button.

Error:  Upper bus drives appear dead and the Information Control Panel
 displays, “Starting Single...”

Reason Solution

Dual-channel configuration
intended, but on powerup single-
channel configuration displays.
The dual-channel SCSI bus
terminator board not seated
properly.

Power down the InterRAID cabinet and the system.
Open the fan bracket by loosening the two captive
screws on back of the InterRAID cabinet.  Use the
handle on the dual-channel board to apply force and
seat the board.
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C LED Status Codes and
Resource Failures  

This appendix lists status conditions for the disk array LEDs and describes failures that
might occur during the disk array’s Power-On Self Test (POST).  It also provides other
hardware and software failures and solutions.

InterRAID LEDs  
The following figures show the LED locations.

Information
Control
Panel

Fan LED
Power Supply LED
Channel Mode LED
Power On LED

Disk Drive
LEDs
(behind
door)

Channel Mode LED
Power On LED

Disk Drive
LEDs



162

Information
Control
Panel

Power On LED
Channel Mode LED
Power Supply LED
Fan LED

Power On LED
Channel Mode LED
Power Supply LED
Fan LED

Disk Drive
LEDs
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Power On LED  

When green, the Power On LED indicates the system normal operating mode.

Power Supply LED  

The Power Supply LED indicates the status of the power supplies in the cabinet.

Condition LED

Normal operation Steady green

One power supply fails Steady amber

Both power supplies fail Off

NOTE The audible alarm sounds when a power supply fails.

Fan LED  

The Fan LED indicates the status of the fans in the cabinet.

Condition LED

Normal operation Steady green

One fan fails Steady amber

Both fans fail Steady amber

NOTE The audible alarm sounds when a fan fails.

Channel Mode LED  

The Channel Mode LED indicates the status of the disk array in the InterRAID subsystem.

Condition LED

Disk array in fault
tolerant state

Steady green

Disk drive rebuild
occurring in the disk
array

Blinking or
steady amber

Failed disk drive present
in the disk array

Blinking
amber
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Disk Drive LEDs  

The LED at each disk drive slot indicates the status of the disk drive installed in the slot.

Condition LED

Disk drive ready Steady green

Disk drive not assigned
to a pack, or hot spare
present

Blinking green

Disk drive failed Blinking
amber

Disk drive rebuild
occurring

Blinking or
steady amber

Disk drive not installed Off

Power-On Self Test
Immediately upon power on, the InterRAID disk array performs the Power-On Self Test
(POST).  If POST does not detect a failure, all LEDs light steady green and the alarm sounds
one short beep.  If POST detects a failure, a message displays on the system monitor.  The
failures do not compromise the data integrity of the disk drives.

NOTE You can view the POST failures from the Information Control Panel.  If a failure occurs, the
system monitor pauses momentarily, displays the failure, and then continues with POST.  To
view the results, select Hardware Menu at the Main Menu and choose POST Results.

Microprocessor Failures  

If POST detects a microprocessor failure, one of the following messages displays on the
system monitor.

RAM Read/Write

ROM Checksum

Register Read/Write Failures

If any of these failures occurs, the channel mode LED blinks amber eight times and the
alarm sounds eight beeps.  Then, the channel mode LED changes to steady green and the
system attempts to resume normal operation.   If the failures occur consistently, return the
cabinet to Intergraph for repair.  Contact the Customer Response Center at 1-800-633-7248.
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Failure Description

RAM Read/Write One or more bytes of the microprocessor RAM failed a read and
write test.

ROM Checksum The microprocessor ROM failed to generate the proper checksum.

Register Read/Write One or more of the microprocessor’s registers are defective.

RAM Checksum Failure  

If POST detects a firmware failure, the following message displays.

RAM Checksum

The channel mode LED alternately blinks green and amber indefinitely.  This indicates
corrupted firmware stored in non-volatile RAM.  Intergraph must load n ew firmware to
correct the failure.  Call the Customer Response Center at 1-800-633-7248 for support.

SCSI Bus Access Failure  

If the POST detects a failure on the InterRAID disk array, the following message displays.

SCSI Bus Access Failure

The channel mode LED blinks amber four times and the alarm sounds four beeps.  Either the
SCSI controller failed to respond to a reset command or another device has control of the
SCSI bus.  After the alarm sounds, the microprocessor attempts to initialize the SCSI
controller.  Normal operations will be impossible while the SCSI controller remains
unresponsive.

Power cycling the cabinet (turning the cabinet off, waiting 30 seconds, then powering on
again) may resolve the failure.  Next, try reseating cables and RAID disk drives.  The cabinet
requires service if this failure persists.  Contact the Customer Response Center at 1-800-633-
7248.

NOTE The InterRAID disk array will not respond to the RAID controller firmware if a SCSI Bus
Access failure occurs.
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Hardware and Software Failures
This section contains some miscellaneous InterRAID cabinet and system related failures
encountered and solved by Intergraph.

InterRAID-8 Power Supply Failures  

The following power supply failures apply only to the InterRAID-8 disk arrays.  The
messages display on the Information Control Panel.

Failure Description

Too Many Power Supplies for
the Current Load <or> Excess
Power Supply

Not enough disk drives installed for the existing number
of power supplies.  Install more disk drives or remove a
power supply.  After removing a power supply, be sure to
install the blanking plate included in the accessory pack.

Insufficient Power for Installed
Drives

Not enough power supplies installed for the existing
number of disk drives.  Install a power supply or remove
disk drives.

Power Supplies are Non-
redundant <or> Non-redundant
Power

The power supplies cannot maintain redundancy with the
present disk drive load.  Install a power supply or remove
disk drives.  The system is operational in this condition,
but the cabinet will shut down if a power supply fails.

NOTE Power supplies lose their redundancy, or fault tolerance, when using two power supplies with
too many disk drives.  The cabinet shuts down if one of the power supplies fails.

InterRAID-8 disk arrays operate with a minimum configuration of two power supplies and
three disk drives to maintain redundancy.  If you must run the disk array with two power
supplies, do not use more than three disk drives.  If configured with more than three disk
drives, you must run the disk array with all three power supplies for redundancy.

Disk Drive Rebuild and Disk Drive Failure  

InterRAID disk arrays should indicate certain operating conditions as follows:

u A disk drive rebuild in progress -- the disk drive’s LED and the Channel Mode LED
should change to steady amber.

u A disk drive failure -- the disk drive’s LED and the Channel Mode LED should change
to blinking amber.
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Because of firmware limitations, some InterRAID disk arrays indicate a disk drive rebuild in
progress by changing the disk drive LED, the Channel Mode LED, or both to blinking
amber.  This may lead you to confuse a disk drive rebuild in progress with a disk drive
failure.  To avoid any confusion, ensure that a disk drive rebuild is not in progress before you
attempt to replace a failed disk drive.

Windows NT Server Failure  

Intergraph has encountered failures when testing systems running Windows NT Server using
multiple RAID disk arrays.  These failures appear to be caused by limitations in Windows
NT Setup, and are currently under investigation.  Use the temporary solutions provided until
a fix becomes available.

u You cannot install Windows NT Server if a system is configured with three or more
RAID controllers on which the RAID disk arrays have been initialized.  If you must re-
install Windows NT Server, remove all but the primary RAID controller (the controller
where the operating system will reside) and install Windows NT Server.  Then, replace
the remaining controllers and continue with system configuration.

u Installation of Windows NT Server may fail if you configured the RAID disk arrays on a
system to contain more than one initialized system drive.  If this happens, try the
installation again.  During the second installation, make sure to reformat the system
drive (do not select Setup’s “Leave file system intact” option).

If you encounter any other failures using multiple RAID disk arrays on an Intergraph system
running Windows NT Server, contact the Intergraph Customer Response Center at 1-800-
633-7248 for help.

Removable Media Drive Failure  

If you add a removable media drive (such as a SyQuest drive) to a system with a RAID disk
array, the Windows NT File Manager may not recognize the removable media drive after
you restart the system.  To enable File Manager to recognize the removable media drive, you
need to edit the Windows NT Registry.

WARNING Do not change values in the Registry other than as directed.  If you introduce incorrect
values into the Registry, you may cause serious operating system failures, and you
may have to reinstall Windows NT.  If you change values in the Registry that make
your system unusable, you may be able to restart the system and use the Last Known
Good Configuration option to undo the damage.  Refer to the Windows NT Server
Installation Guide for more information on the Last Known Good Configuration option.
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To enable File Manager to recognize a removable media drive:

1. Start the Registry Editor (REGEDT32.EXE) to open the Registry.

2. Open the following subkey in the Registry:

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Scsiall\

Parameters

3. From the Edit menu, select Add Value.

4. Type ExcludeDrives into the Value Name box.

5. Select REG_MULTI_SZ from the Data Type list, and then select OK.

6. In the Data box, type the SCSI address of the removable media drive, and then select
OK.

For example, if you add a removable media drive to SCSI port 1, SCSI bus 0, target ID
6, logical unit ID 0, type scsi1060.  You can find the SCSI address of the drive by
opening the following subkey in the Registry:

HKEY_LOCAL_MACHINE\HARDWARE\DEVICEMAP\Scsi

7. Exit from the Registry Editor and restart the system.
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Changing
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RAID policy, 128
write policy

DACCF utility, 55, 73
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icon, 112
mode LED, 163
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management menu, 86

Check parity, 125
Chip set type, 82
Clear configuration, 81, 82

DACCF utility, 65
Command tagging

SCSI Xfr parameter, 69
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DACCF utility, 72
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RAID controller, 146
cache memory, 147
external RAID SCSI
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MegaRAID flash

EEPROM, 147
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speaker, 147
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SCSI controller, 147
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custom, 117
display, 117
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print, 117
reset, 117
save, 117

Configuration method, 88
easy configuration, 88
new configuration, 88
view/add configuration, 88

Configure
additional disk arrays
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procedure, 73

DACCF utility, 73

arrays and logical drives, 87
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Independent Disks (RAID)
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cables

InterRAID-8, 17
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DACCF utility, 60
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MegaRAID, 145
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DAC960PD, 144

Controller checksum errors, 71
Controller read ahead, 151

physical parameter, 68
Controller software

using, 5
Cooling fans

replacing, 140
Create

pack
DACCF utility, 49

system drive
DACCF utility, 53

Create, 123
Custom

configuration, 117
icon, 110

Customer support, 2
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DAC InterRAID utilities
using, 35
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DAC960 driver
updating, 35

DACADM
icon

creating for Windows NT
3.51, 37

creating for Windows NT
4.00, 38

options, 38
starting, 37
utility

starting, 37
DACADM and DACMON

utilities, 36
installing, 37

DACADM options
change/add device, 39
drive information, 39
make standby, 39
rebuild drive, 39
select adapter, 38
system drive, 39

DACCF utility
common procedures, 72

changing write policy, 73
enabling automatic

rebuild, 72
recovering unusable

(DED) disk drives, 74
configuring additional disk

arrays, 73
error conditions, 70

controller checksum error,
71

installation aborted, 70
NVRAM/flash

configuration
mismatch, 71

main menu, 45
01. automatic

configuration, 46
02. new configuration, 48
03. view/update

configuration, 56
04. rebuild, 58

05. initialize system drive,
59

06. consistency check, 60
07. tools, 61
08. select DAC960, 66
09. advanced functions,

66
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overview, 42
starting, 43

DACMON
event viewer

output, 40
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creating, 40
utility

overview, 40
starting, 40

Data transfer rate
SCSI Xfr parameter, 69

Database Applications, 151
Default

parameters
disk array, 67, 68, 69

rebuild rate
physical parameter, 68

Define
pack

DACCF utility, 48, 56
system drive

DACCF utility, 52, 57
Degraded drives to optimal drives,

129
Designating drives as hot spares,

89, 90, 94, 97, 134
Determining

RAID controller, 6
Device information

DACCF utility, 51
Diagnostics, 115, 118, 122

DACCF utility, 70
Direct I/O, 92
Disable BIOS

management menu, 87
Disable termination, 85
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Disconnect/reconnect, 170
Disk

array
servicing, 137

spin-up timings, 82
Disk array, 170

default parameters, 67, 68, 69
features, 2

door lock, 3
RAID controller board, 3
SAF-TE cabinet

monitoring, 3
smart cabinet monitoring,
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Disk Array Controller

Administrator (DACADM), 170
Disk Array Controller
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Disk Array Controller Monitor
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Disk drive

installing
InterRAID-12, 31
InterRAID-6, 10
InterRAID-8, 23

LEDs, 164
replacing, 139

Disk drive rebuild and disk drive
failure, 166

Disk mirroring, 170
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Disk striping, 170
Display

configuration, 117
icon, 109
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DACCF utility, 51

information, 119
log icon, 110
logical drive

configuration, 97
logical drive configuration, 94
logical drive configuration

screen, 94, 97
logical drives, 90, 94

manufacturer data, 90, 94, 97
DOC compliance, iii
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about, xi
conventions, xii

Documentation and training, xiii
Door lock, 3
Double buffering, 171
Drive

removing, 133
Drive information

DACADM, 39
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designating as hot spares, 134
Drive-State, 91, 95, 98
Duplexing, 171
Dynamic Random Access Memory

(DRAM), 171
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Easy configuration, 81, 88, 90, 117
Enable/disable alarm control, 121
Enable/disable sound, 116, 121
Enabling automatic rebuild

DACCF utility, 72
Enclosure management, 115, 118

icon, 111
Equipment

unpacking, 1
Error counts

DACCF utility, 62
Errors, 70

controller checksum, 71
installation aborted, 70
InterRAID-6, -8, -12, 157
InterRAID-8, 160
InterRAID-8, -12, 159
NVRAM/flash configuration

mismatch, 71
Exit, 116, 121
Expanding the system

InterRAID-12, 29
InterRAID-6, 8
InterRAID-8, 18
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F

Fail drive, 84
Failed drive

rebuilding, 103
Failure

disk drive rebuild and disk
drive, 166

POST
microprocessor, 164
RAM checksum, 165
SCSI bus access, 165

power supply
InterRAID-8, 166

removable media drive, 167
Windows NT server, 167

Fan LED, 163
Fault-tolerant, 171
FAXLink, xiv
FCC compliance, iii
Features

RAID controller, 145
AT compatible BIOS, 146
PCI bus interface, 146
RAID controller

firmware, 146
RAID SCSI bus, 146

FlexRAID PowerFail, 82
Floppy disk, 171
Flush cache, 115, 118
Format, 84, 101, 122, 171

drive
DACCF utility, 62

management menu, 85
Formatting physical drives, 101
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Getting started, 1

H
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Hardware and software failure, 166

disk drive rebuild and disk
drive failure, 166

InterRAID-8 power supply,
166

removable media drive, 167
Windows NT server, 167

Hardware parameters
array enclosure Management,
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battery backup, 67
DACCF utility, 67
default, 67
storage works fault MGMT.,

67
Hide/show toolbox, 115, 120
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setting up
InterRAID-12, 30
InterRAID-6, 9
InterRAID-8, 20

Host computer, 171
Hot key functions, 90, 94, 97
Hot spare, 90, 94, 97, 134, 172
Hot swap, 172

I

Icons
configuration, 109
drag and drop, 111
logical drive and channel, 112

Identifying
operating system disk drives, 2
system PCI slots, 5

Identifying the Redundant Array of
Independent Disks (RAID)

controller board, 143
Individual

formatting, 101, 102
initialization, 100
rebuild, 103

Information control panel, 161
Initialize, 83

logical drive, 100, 124
batch, 100
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individual, 100

management menu, 81
system drive

DACCF utility, 59
Installation aborted errors, 70
Installing

RAiD disk drives
InterRAID-6, 10

Installing MegaRAID Power
Console utility, 107

Installing multiple expansions
InterRAID-8, 21

Installing RAID disk drives
InterRAID-12, 31
InterRAID-8, 23

Intel i960 RISC processor, 146
Intergraph bulletin board service,

xiv
Intergraph FAXLink, xiv
Intergraph on the Internet, xv
Intergraph systems

RAID-applicable, 3
InterRAID

connecting the cabinet, 6
DAC utilities, 35
door lock, 3
LEDs, 161, 162
power switch, 12, 25, 33
RAID controller board, 3
SAF-TE cabinet monitoring, 3
smart cabinet monitoring, 3
utilities

common DACCF
procedures, 72

DACADM, 36
DACCF, 42
DACMON, 36

InterRAID-12
connecting, 27

remaining cabinets and
cables, 28

system, 27
disk drives

installing, 31

errors, 157, 159
expanding the system, 29
important operating notices,

33
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placing cabinets, 29
power on and configure

system, 33
setting up and expanding, 27
setting up host, 30
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unpacking the expansion

solution, 29
InterRAID-6

connecting, 7
remaining cabinets and

cables, 8
system, 7

disk drives
installing, 10

errors, 157
expanding the system, 8
important operating notices,
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power on and configure

system, 12
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setting up host, 9
specifications, 153
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solution, 9
InterRAID-8

connecting, 15
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system, 16
connecting single-channel

system, 15
disk drives

installing, 23
errors, 157, 159, 160
expanding the system, 18
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system, 25
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setting up host, 20
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unpacking the expansion

solution, 18
InterRAID-8 power supply failures,
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Kill drive
DACCF utility, 63
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LED status

codes, 161
InterRAID LEDs, 161

channel mode, 163
disk drive, 164
fan, 163
power on, 163
power supply, 163

Light Emitting Diode (LED), 172
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selecting, 2
Logical drive, 83, 172, 175

configuring, 87
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initializing, 100
menu, 126
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parity check

icon, 111
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Logical drive configuration
screen, 94

Logical drive configuration screen,
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Main menu
DACCF utility, 45

Make
hotspare, 84
online, 84

DACCF utility, 63
standby

DACADM, 39
Management menu

check consistency, 86
configure, 81
disable BIOS, 87
format, 85
initialize, 81
objects, 81
rebuild, 86
select adapter, 87
tree, 80

Manual rebuild, 103
Manually rebuild

new disk drive
DACCF utility, 58

MegaRAID
BIOS configuration utility

exiting, 80
Power Console utility

installing, 107
MegaRAID BIOS utility

management options, 79
startup sequence, 79
using, 77

MegaRAID driver
updating, 77

Microprocessor failures, 164
Mirrored RAID performance, 150
Mirroring, 172
Multi-threaded, 172

N

New configuration, 81, 88, 93



184
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define pack, 48
define system drive, 52

NoSpan, 95, 99
NVRAM/flash configuration

mismatch errors, 71
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Object identification, 120
on/off, 116

Objects
management menu, 81

Operating
notices

InterRAID-12, 33
system

information, xii
Operating notices

InterRAID-12, 33
InterRAID-6, 12
InterRAID-8, 25

Operating system
disk drives

identifying, 2
Options

DACADM, 38
Other performance options, 150

controller read ahead, 151
tagged command queuing, 151
write back caching, 151

Overview
DACCF, 42
DACMON, 40

P

Performance monitor, 120
on/off, 115

Peripheral Component
Interconnect (PCI) bus, 172

Physical drive
objects menu, 84

Physical drives, 84
formatting, 101

batch, 101

individual, 101
Physical Drv menu, 121
Physical pack, 172
Physical parameters

controller read ahead, 68
DACCF utility, 68
default, 68
default rebuild rate, 68
stripe size, 68
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InterRAID-12, 29
InterRAID-8, 19

Policy
cache, 83, 92
I/O, 83
read, 83, 92, 117
write, 83, 92, 117

Power
cycling

InterRAID, 165
supplies
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switch

InterRAID, 12, 25, 33
Power console

adapter menu, 114
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drag and drop, 111
icons, 109

configuration, 109
logical drive menu, 126
logical drv menu, 123
menu options, 113
overview, 108
physical drv menu, 121
securing, 134
using, 107

Power on LED, 163
Power supply LED, 163
Powering on and configuring

system
InterRAID-12, 33
InterRAID-6, 12
InterRAID-8, 25

Power-On Self Test (POST), 164
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failure
microprocessor, 164
RAM checksum, 165
SCSI bus access, 165

Precautions, 137
Pre-loaded SCSI drive

using, 105
Primary RAID controller, 172
Print configuration, 117

DACCF utility, 65
Print icon, 110
Properties, 115, 119, 122, 126
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RAID
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change paths, 129
changing, 128

number of drives per RAID
level, 91, 94, 98

policy, 128
RAID 0, 173
RAID 1, 173
RAID 10

configuring, 96, 99, 118
RAID 3, 91, 173
RAID 30

configuring, 96, 99, 118
RAID 5, 173
RAID 50

configuring, 96, 99, 118
RAID controller, 173
RAID-applicable Intergraph

systems, 3
RAM

read/write
POST failure, 164

RAM checksum failure, 165
Read

policy, 83, 92, 128
Rebuild, 84, 121, 173

automatic, 83, 103
DACCF utility, 58
disk

icon, 111
disk drives, 103

DACADM, 39
management menu, 86
manual, 103
option, 121
rate, 83

icon, 110
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Recovering

controller checksum error, 71
installation aborted, 70
NVRAM/flash configuration

mismatch, 71
unusable (DED) disk drives,
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DACCF utility, 74

Reduced Instruction Set Computer
(RISC), 173

Redundant Array of Independent
Disks (RAID), 173

applicable Intergraph systems,
3

BIOS, 40
drive checking, 41
startup sequence, 41

controller
components, 146
determining, 6
features, 145
replacing, 137

controller board, 3
DAC960P, 143
DAC960PD, 144
MegaRAID, 145

data integrity
differences, 152

mode performance, 152
performance

options, 150
SCSI, 173
technology, 149

Register read/write failure
POST failure, 164



186

Removable media drive failure,
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Removing a physical drive from a
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Replacement disk, 173
Replacement table, 173
Replacement unit, 174
Replacing

cabinet, 141
cooling fans, 140
disk drives, 139
power supplies, 139
RAID controllers, 137

Rescan icon, 111
Reset

configuration, 117
icon, 110

Resource failures, 161
Restore conf

DACCF utility, 64
ROM checksum

POST failure, 164
Rotated XOR redundancy, 174
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SAF-TE, 174
SAF-TE cabinet monitoring, 3
Save configuration, 117

to floppy, 135
SCSI bus access failure, 165
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objects menu, 85
SCSI data bus width

SCSI Xfr parameter, 69
SCSI Xfr parameters

command tagging, 69
DACCF utility, 68
data transfer rate, 69
default, 69
SCSI bus width, 69

SCSI-2 command tagging, 85
Secondary RAID controller, 174
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Select
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DAC960
DACCF utility, 66
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management menu, 87

Servicing
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cabinet, 141
cooling fans, 140
disk drives, 139
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RAID controller, 137
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Set PowerOn defaults, 85
Setting up host
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InterRAID-6, 9
InterRAID-8, 20
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(SCA), 174
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(SIMM), 174

Small Computer System Interface
(SCSI), 174

bus access
POST failure, 165

Small Computer System Interface
(SCSI) drive, 174

Smart cabinet, 174
Smart cabinet monitoring, 3
Software notices

InterRAID-12, 34
InterRAID-6, 13
InterRAID-8, 25

Spanning, 95, 175
mode, 95, 99

Specifications, 153
InterRAID-12, 155
InterRAID-6, 153
InterRAID-8, 154

Standby
replacement of disks, 175

Standby drive, 175
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Starting
DACADM, 37
DACCF, 43
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DACCF utility, 69
default, 69

Startup sequence
MegaRAID BIOS utility, 79
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Storage works fault Management
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order, 175
width, 175

Stripe size, 92
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Striped RAID performance, 149
Striping, 175
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support
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FAXLink, xiv
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drive
DACADM, 39

powering on and configuring,
12, 25, 33

System drive, 172, 175
System drive ID, 176
System PCI slots

identifying, 5
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Tagged command queuing, 151
Target ID, 176
Telephone support, xiii
Terminate
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wide channel, 85

Tools, 122

backup/restore conf, 64
bad block table, 61
clear configuration, 65
DACCF utility, 61
error counts, 62
format drive, 62
kill drive, 63
make online, 63
print configuration, 65

Training, xiii
Trash icon, 111
Troubleshooting, 157

general, 157
InterRAID-8, 160
InterRAID-8, -12, 159
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Ultra SCSI, 83
Uninterruptible Power Supply

(UPS), 176
Unpacking

InterRAD-8, 18
InterRAID-12, 29
InterRAID-6, 9
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Unusable (DED) disk drives

recovering, 74
Updating DAC960 driver, 35
Updating MegaRAID driver, 77
Using

controller software, 5
DAC InterRAID utilities, 35
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MegaRAID

BIOS utility, 77
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power console, 107
pre-loaded SCSI drive, 105
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View drive information, 84
View log, 115, 118
View/add configuration, 81, 88, 97
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View/update
parameters, 83
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DACCF utility, 56

define pack, 56
define system drive, 57

W

Warnings, iii
Windows NT

information, xii
Windows NT server failure, 167
Write policy, 83, 92, 128

changing, 128
DACCF utility, 55

Write-back cache, 176
Write-back caching, 92, 151
Write-through cache, 176
Write-through caching, 92
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